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Preface

Manual Information

Purpose
This manual details the features, installation procedures, operational 
procedures, and specifications of the X75HD/X75SD Multiple Path 
Converters and Frame Synchronizers.

Audience
This manual is written for engineers, technicians, and operators 
responsible for the installation, setup, and/or operation of the X75HD/
X75SD Multiple Path Converters and Frame Synchronizers.

Revision History

Table P-1. Manual Revision History

Edition Date Details
Preliminary December 2004 Preliminary release

A January 2005 Initial release

B April 2005 Addition of SD capabilities, new packages, options, and index

C June 2005 Addition of X75OPT-HDDUOCON option, software upgrade procedures, 
and alarms list

D March 2006 Addition of streaming and video/audio timing options, improved alarms 
list, specifications and features changes



xiv X75SD/X75HD Installation and Operation Manual

 
Preface

Writing Conventions
To enhance your understanding, the authors of this manual have 
adhered to the following text conventions:

Obtaining Leitch Documents
Leitch documents can be viewed or downloaded from the Leitch 
Web site at www.leitch.com (go to Support>Documentation). 
Alternatively, contact your Leitch customer service representative to 
request a document.

Table P-2. Writing Conventions
Term or 
Convention Description

Bold Indicates dialog boxes, property sheets, fields, buttons, 
check boxes, list boxes, combo boxes, menus, submenus, 
windows, lists, and selection names

Italics Indicates email addresses, the names of books or 
publications, and the first instances of new terms and 
specialized words that need emphasis

CAPS Indicates a specific key on the keyboard, such as ENTER, 
TAB, CTRL, ALT, or DELETE

Code Indicates variables or command-line entries, such as a 
DOS entry or something you type into a field

> Indicates the direction of navigation through a hierarchy 
of menus and windows

hyperlink Indicates a jump to another location within the electronic 
document or elsewhere

Internet 
address

Indicates a jump to a Web site or URL

Note
Indicates important information that helps to avoid and 
troubleshoot problems

http://www.leitch.com
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Unpacking/Shipping Information
Leitch has carefully inspected, tested, and calibrated this product before 
shipment to ensure years of stable and troublefree service. 
1. Check equipment for any visible damage that may have occurred 

during transit. 
2. Confirm that you have received all items listed on the packing list. 
3. Contact your Leitch dealer if any item on the packing list is 

missing.
4. Contact the carrier if any item is damaged.
5. Remove all packaging material from the product and its associated 

components before you install the unit.

Keep at least one set of original Leitch packaging, in the event that you 
need to return a product for servicing. If the original packaging is not 
available, you can purchase replacement packaging from Leitch at a 
modest cost, or supply your own packaging as long as it meets the 
following criteria:
• Withstands the weight of the product
• Holds the product rigid within the packaging
• Leaves at least two inches of space between the product and the 

container
• Protects the corners of the product

Ship products back to Leitch for servicing prepaid and, if possible, in 
the original packaging material. If the product is still within the 
warranty period, Leitch will return the product prepaid after servicing.
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Safety Terms and Symbols

Terms and Symbols Used in this Manual

Terms and Symbols Found on the Product

WARNING statements and icons identify conditions or practices 
that can result in personal injury or loss of life. High voltage is 
present. Uninsulated dangerous voltage within the product’s 
enclosure may be sufficient to constitute a risk of electric shock to 
persons.

CAUTION statements and icons identify conditions or practices 
that can result in damage to the equipment or other property. 
Important operating and maintenance (servicing) instructions are 
included in the literature accompanying the product.

CAUTION statements and icons identify conditions or practices 
that can result in damage to the equipment or other property if 
proper care during use and transport is not taken.

DANGER: Indicates a hazard for high voltage, fire, or personal 
injury immediately accessible as one reads the marking

WARNING: Indicates a personal injury hazard not immediately 
accessible as one reads the marking

CAUTION: Indicates a hazard to property, including the product, 
or the need to take attention and refer to the manual

Protective ground (earth) terminal

FUSE: Replace with same type and rating of fuse

Observe precautions for handling electrostatic-sensitive devices



 

Section I—Startup
This section contains the following topics:
• “Chapter 1: Introduction” on page 3
• “Chapter 2: Applications” on page 35
• “Chapter 3: Module and Back Panel Descriptions” on page 51
• “Chapter 4: System Installation and Connections” on page 67
• “Chapter 5: Initial Configuration” on page 85
The content contained in this section will give you a general 
understanding of the X75HD/X75SD models. Features and options are 
described, along with details on how to install the system and begin 
operation.
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Chapter 1

Introduction

Overview
Leitch Technology’s X75™HD/SD models are standard and 
high-definition utility synchronizers and converters that combine video 
and audio processing capabilities with the ability to upconvert, 
downconvert, and crossconvert from most common input and output 
video formats.
X75HD/X75SD models are available in HD-SDI, SD-SDI, and 
DPS-575-compatible versions in both simultaneous or single-channel 
configurations. They are equally suited for analog, digital, or hybrid 
facilities—the ideal choice for broadcasters making the transition to 
digital and high-definition television (DTV and HDTV). Available in 
standard or high definition formats, video-only and audio/video 
configurations, the X75 provides a bridge between analog, digital and 
high-definition systems with analog, digital, and embedded audio.
This chapter describes the main features and applications of the 
X75HD/X75SD products, under the following topics:
• “General Description” on page 4
• “Main Features” on page 6
• “Front and Rear Panels” on page 9
• “Product Packages” on page 12
• “Typical Control Configurations” on page 23
• “Overview of Operating Modes” on page 25
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General Description
Offering unparalleled flexibility, the X75HD/X75SD provides up to 
nine video inputs and ten video output formats, depending upon the 
following available options:
• One HDTV optical fiber serial component digital video input and 

output
• Two HDTV serial component inputs (one can be selected as optical 

fiber) and one HDTV output (two coaxial and one fiber)
• Two SD-SDI serial component digital video inputs and outputs
• One 128 x 96 thumbnail streaming source and one 352 x 240 pixel 

(525) or 352 x 288 pixel (625) streaming-over-IP video/audio 
output

• Component analog video (BetacamTM) input and output
• S-video (S-VHS/Hi8) input and output
• NTSC/PAL-M/PAL-B/SECAM composite video input and output
• RGB-S output
• DVI-D output
See page 35 for descriptions of some typical applications using these 
options.

Inputs
Inputs are capable of auto-detection, with user-selectable SMART 
alarms. Two input modes (both of which allow for either automatic 
detection or user-selection of inputs) are available for processing 
critical program paths for ingest, and bridging between routers/tape 
transports/servers, mobile broadcast, and edit suites.

Video Processing
Processing for video includes level/color control, aspect ratio 
conversion, 3D-adaptive color decoding, noise reduction, frame 
synchronization and time base correction for non-synchronous signals, 
analog-to-digital and digital-to-analog video conversion.
Other capabilities include the following:
• Up and down conversion
• Aspect ratio control
• High-definition cross-conversion

Note
See “Product Packages” on 
page 12 for more specific 
information on what each 
X75HD/X75SD system package 
provides.
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Audio Processing
Processing for audio includes level control, analog-to-digital and 
digital-to-analog conversion, and SD-SDI and HD-SDI serial digital 
signal embedding and de-embedding.
Other capabilities include the following:
• Sample rate conversions, synchronization, and timing-to-video for 

correction of lip sync errors
• Embedding/de-embedding of signals such as Dolby-E™ and AC-3™
• Processing of multiple channel program signals for surround-sound 

applications before or after compression
• Audio-follow-video routing
• Converting, adjusting, timing, demultiplexing, and multiplexing

Signal Control and Monitoring
You can control and monitor signals passing through the 
X75HD/X75SD using a variety of methods:
• Local X75HD/X75SD control panels
• Remote X75-RCP control panels
• Web server software
• Local DPS-575 control panels
• Remote RC-575 control panels
• CCS™ software applications and QuickTime Player

Operating Modes
There are three main operational modes: Auto Detect (default mode) 
M-Path (multiple path) processing, and Simulcast processing.
• The Auto Detect default mode detects any one input and processes 

it to all outputs.
• M-Path selects or detects input signals to processed output signals. 

The Default M-Path mode is All Output Select, for which a single 
input is processed to all outputs. In Video Routing Mode, M-Path 
allows for up to 4 processed paths; you choose the output first, and 
then select which input is to be processed to that output.

• Simulcast operation makes it possible for you to switch any two 
inputs to standard and high definition outputs.

See “Overview of Operating Modes” on page 25 for more information 
on modes of operation.
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Main Features
You can access all of the features and functions of the X75HD/X75SD 
models from an X75HD/X75SD local control panel, an X75-RCP 
remote control panel, a CCS software application such as Pilot or 
Navigator, or a supported Web browser. Details of the available features 
begin in the “Available Packages” section (page 12) and the “Options” 
section (page 17). The following standard and optional features are 
described in the next pages:

General Functionality
• Upgradability from SDTV to HDTV
• Frame syncs for analog, SDTV and HDTV
• Upconversion, downconversion, crossconversion, and aspect ratio 

conversion
• Analog-to-digital conversion
• Digital-to-analog conversion
• Proc amps for analog, SDTV and HDTV
• Video test generation
• Optional video noise reduction and enhancement
• 8 or 16 channels of internal audio processing (gain, invert, swap, 

sync/delay, sum)
• Embedding and de-embedding for SD-SDI and HD-SDI
• Compressed audio capability (Dolby-E™ and AC-3™)
• Video and audio timing correction
• Streaming video capability
• SD memory card parameter settings storage
• Audio (and embedded) test generation
• Audio limiting capability
• Built-in Web server with thumbnail monitoring capability
• Redundant power supply

Note
Simultaneous up, down, and 
cross conversion requires the 
X75OPT-HDDUOCON 
software key option. Contact 
your Leitch sales representative 
to enable this option.
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Input/Outputs
• Auto-detected inputs
• Two SD-SDI and two HD-SDI inputs
• Color black, tri-level sync and DARS reference inputs
• Optional NTSC/PAL-M/PAL-B/SECAM input with CAV and 

S-video inputs
• Ability to provide many outputs, including composite, component, 

SD-SDI, HD-SDI, HDTV fiber, DVI-D, and S-video
• SC and optional FC/ST fiber interface for HDTV
• Two or five AES inputs and outputs, at 75 or 110Ω

• Four analog audio inputs and outputs
• GPI inputs and outputs

Operation, Control, and Monitoring
• Three operating modes: Auto Detect, M-Path (multiple-path) and 

Simulcast
• Clean video and quiet audio switching capability
• Local and remote control panels
• Control for up to 200+ units from a single control panel
• X75 Web server software application
• Software GUI control and monitoring using CCS Pilot and 

Navigator, or monitoring using CoPilot
• SNMP and third-party interfaces
• SMART alarms (global parameters for all inputs—allowing 

custom-definitions for how and when alarms are activated, 
including priority settings for main and backup inputs)

Hardware Features
• SD (Secure Digital) removable media for storage of parameter 

settings; 128 MB included (the maximum size supported by the 
X75HD/X75SD is 1 GB)

• Front-to-back air flow
• Single and dual redundant power supplies



8 X75HD/X75SD Installation and Operation Manual

 
Chapter 1: Introduction

Summary of Benefits
Among the many benefits provided by the X75HD/X75SD, a major 
advantage is a reduction in the amount of equipment needed to perform 
everything that the X75HD/X75SD can do in just one 1RU. In a single 
system, the X75HD/X75SD combines HDTV frame synchronization 
along with up/down and cross/down conversion. It provides analog 
inputs and outputs with SD-SDI, HD-SDI, and HDTV optical, and 
delivers analog, digital, and embedded audio. The optional 
Dolby-E™/AC-3™ decompressor is built-in, thereby saving more rack 
space. Voice-over is part of the 8/16-channel audio option. The internal 
socket below the audio submodule allows the optional Dolby-E/AC-3 
submodule to be plugged in, thereby saving more rack space.
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Front and Rear Panels

Front Panel Description
Figure 1-1 and Figure 1-2 illustrate front blank, and front control 
panels, respectively. 
X75HD/X75SD units with a blank front panel, must be configured and 
controlled remotely, using one of the following methods:
• Separate control panel such as an X75-RCP
• Local control panel on an X75HD/X75SD or DPS-575 unit
• CCS applications such as Pilot or Navigator
• Web server application using a common Web browser such as 

Internet Explorer™ or Netscape™
• SNMP (Simple Network Management Protocol) and third-party 

control software offered through Leitch CCS Protocol
Blank front panels provide LEDs for alarm and status monitoring, 
(including major and minor alarm LEDs), and status LEDs for power 
and memory access.
Local and remote control panels contain LEDs that indicate alarm, 
status, and configuration information. For more detailed information on 
LCP controls and indicators, see the Control Panels for X75 Systems 
Installation and Operation Manual.

Figure 1-1. Blank X75HD/X75SD Front Panel

Rear Panel Description
Figure 1-3 on page 11 illustrates a typical rear panel with all module 
options installed. For more information on back panel connections, see 
“Chapter 3: Module and Back Panel Descriptions” on page 51.

Note
DPS-575 units do not have the 
Ctrl button found on 
X75HD/X75SD models. Button 
shortcuts on X75HD/X75SD 
models that require the Ctrl 
button are not accessible 
remotely via a DPS-575 unit. In 
these cases, the affected 
parameters must be accessed 
through the menu structure.
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Figure 1-2. Front View of X75HD/X75SD with Local Control Panel
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Figure 1-3. Rear View of X75HD/X75SD With All Available Options
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Product Packages
X75HD/X75SD models are available in a wide range of product 
packages, and with a large number of options for modules, connectors, 
cables, software, and documentation. All of the frames described in the 
next pages are capable of single-channel up, down, and cross 
conversion. By purchasing the X75OPT-HDDUOCON software key 
(see page 21), you can enable simultaneous conversion capability on 
any of these frames.
See the following tables for more information:
• Table 1-1: "X75HD/X75SD Single-Channel Module and System 

Packages" below
• “X75HD/X75SD System Options” on page 17

Available Packages
Table 1-1 describes the various X75HD/X75SD product packages that 
you can order.

Table 1-1. X75HD/X75SD Single-Channel Module and System Packages 

Product Code Description Major Features
X75HD Modules and Systems

X75HD 1RU up/down/cross converter and 
synchronizer (video only), with 
local control panel

• 1RU frame with local control panel, single 
power supply and power cable

• Auto-sensing standard (SDTV/HDTV) serial 
digital component synchronizer

• Test signal generator
• SD-SDI and HD-SDI inputs and outputs
• Analog video outputs
• Optional analog video inputs
• 12-bit conversion
• Multiple operational modes
• SMART alarms and thumbnail streaming 

capability

X75HD-2PS 1RU up/down/cross converter and 
synchronizer (video only), with 
local control panel and redundant 
power supply

• Same features as the X75HD (including local 
control panel)

• Additional power supply and power cable for 
full redundancy
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X75HD-AV 1RU up/down/cross converter and 
synchronizer (video and audio), with 
local control panel

• Same features as the X75HD (including local 
control panel)

• Internal 16-channel digital audio 
synchronizer module, providing 
separate/embedded audio

• Coax cable set

X75HD-AV-2PS 1RU up/down/cross converter and 
synchronizer (video and audio), with 
local control panel and redundant 
power supply

• Same features as the X75HD (including local 
control panel)

• Additional power supply for full redundancy
• Internal 16-channel digital audio 

synchronizer module, providing 
separate/embedded audio

• Coax cable set 

X75HD-LC 1RU up/down/cross converter and 
synchronizer (video only), with 
blank front panel

• Same features as the X75HD, excluding the 
local control panel

• Blank front panel

X75HD-LC-2PS 1RU up/down cross converter and 
synchronizer (video only), with 
blank front panel and redundant 
power supply

• Same features as the X75HD, excluding the 
local control panel

• Additional power supply and power cable for 
full redundancy

• Blank front panel

X75HD-LCAV 1RU up/down/cross converter and 
synchronizer (video and audio), with 
blank front panel

• Same features as the X75HD, excluding the 
local control panel

• Internal 16-channel digital audio 
synchronizer module, providing separate/ 
embedded audio

• Blank front panel
• Coax cable set 

Table 1-1. X75HD/X75SD Single-Channel Module and System Packages (Continued)

Product Code Description Major Features
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X75HD-LCAV-2PS 1RU up/down/cross converter and 
synchronizer (video and audio), with 
blank front panel and redundant 
power supply

• Same features as the X75HD, excluding the 
local control panel

• Additional power supply for full redundancy
• Internal 16-channel digital audio 

synchronizer module, providing separate/ 
embedded audio

• Blank front panel
• Coax cable set

X75SD Modules and Systems

X75SD 1RU digital synchronizer (video 
only), with local control panel

• 1RU frame with local control panel, single 
power supply and power cable, and fan 
modules

• Auto-sensing standard
• Test signal generator
• SD-SDI inputs and outputs
• Analog video outputs
• 12-bit processing 
• Multiple operational modes
• SMART alarms and thumbnail streaming 

capability
• Available X75OPT-AS-8 internal 8-channel 

digital audio synchronizer

X75SD-2PS 1RU digital synchronizer (video 
only), with local control panel and 
redundant power supply

• Same features as the X75SD (including local 
control panel)

• Additional power supply and power cable for 
full redundancy

X75SD-AV 1RU digital synchronizer (video and 
audio), with local control panel

• Same features as the X75SD (including local 
control panel)

• Internal 8-channel digital audio synchronizer 
module, providing separate/embedded audio

• Coax cable set 

Table 1-1. X75HD/X75SD Single-Channel Module and System Packages (Continued)

Product Code Description Major Features
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X75SD-AV-2PS 1RU digital synchronizer, (video 
and audio), local control panel, and 
redundant power supply

• Same features as the X75SD, including local 
control panel

• Additional power supply for full redundancy
• Internal 8-channel digital audio synchronizer 

module, providing separate/embedded audio
• Coax cable set

X75SD-LC 1RU digital synchronizer (video 
only), with blank front panel

• Same features as the X75SD, excluding the 
local control panel

• Blank front panel and fan connection board

X75SD-LC-2PS 1RU digital synchronizer (video 
only) with blank front panel, and 
redundant power supply

• Same features as the X75SD, excluding the 
local control panel

• Additional power supply and power cable for 
full redundancy

• Blank front panel and fan connection board

X75SD-LCAV 1RU digital synchronizer (video and 
audio), with blank front panel

• Same features as the X75SD, excluding the 
local control panel

• Internal 8-channel digital audio synchronizer 
module, providing separate/embedded audio

• Blank front panel and fan connection board
• Coax cable set 

X75SD-LCAV-2PS 1RU digital synchronizer, (video 
and audio), with blank front panel 
and redundant power supply

• Same features as the X75SD, excluding the 
local control panel

• Additional power supply for full redundancy
• Internal 8-channel digital audio synchronizer 

module, providing separate/embedded audio
• Blank front panel and fan connection board
• Coax cable set

X75 DPS Equivalents

X75-DPS-575 1RU digital video synchronizer, 
with PQM submodule and local 
control panel

• Same features as the X75SD
• Includes X75OPT-PQM submodule, which 

supports component, composite, S-video, 
SD-SDI inputs, and SD-SDI outputs

Table 1-1. X75HD/X75SD Single-Channel Module and System Packages (Continued)

Product Code Description Major Features
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X75-DPS-575AV 1RU digital synchronizer, with 
PQM video submodule, 8-channel 
digital audio synchronization, and 
local control panel

• Same as X75-DPS-575
• Includes X75OPTPT-AS-8 internal 8-channel 

digital audio synchronizer module for 
separate/embedded audio

• Provides separate/embedded audio, 2 AES 
coax unbalanced input/outputs and coax 
unbalanced DARS input

X75-DPS-575LC 1RU digital video synchronizer, 
with PQM submodule and blank 
front panel

Same as X75-DPS-575, but excludes local 
control panel

X75-DPS-575LCAV 1RU digital synchronizer, with 
PQM video submodule, 8-channel 
digital audio synchronization, and 
blank front panel

Same as X75-DPS-575AV, but excludes local 
control panel

Table 1-1. X75HD/X75SD Single-Channel Module and System Packages (Continued)

Product Code Description Major Features
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Options
Table 1-2 describes the various options available for X75HD/X75SD 
systems. Some can be installed in the factory at the time of purchase, 
while other options and upgrades can be ordered and installed at a later 
time. The X75OPT-HDDUOCON software key option (see page 21) is 
required for simultaneous up, down, and cross conversion.
For further information on the cables described in this table, see 
“Cables and Pinouts” on page 195.

Table 1-2. X75HD/X75SD System Options

Product Code Description Major Features

System Options

X75OPT-A3D Analog video input submodule with 
3D adaptive comb filtering, 
composite, S-video, and analog 
component BetacamTM inputs

Field upgradable or factory installed

X75OPT-A3D-1 Same as the X75OPT-A3D, but with 
alternate color decoder algorithm

Field upgradable or factory installed

X75OPT-AS-8 8-channel audio synchronizer with 
4-channel analog / 2 AES / 2 groups 
of SD and HD de-embedding and 
embedding possible

Mounts inside any X75HD/X75SD system, 
and includes the following:

• Analog, AES/EBU, and embedded 
SD-SDI and HD-SDI audio I/O

• Eight-channel processing
• Audio analog-to-digital conversion
• Audio digital-to-analog conversion
• SD/HD audio embedding
• SD/HD audio de-embedding
• Audio synchronizing
• Audio delay insertion
• Audio processing amplification
• Coaxial breakout cables set

X75OPT-AS-8-L Audio synchronizer module with 
audio limiter

Same as X75OPT-AS-8, but with optional 
audio limiter soft key option
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X75OPT-AS-16 16-channel audio synchronizer with 
4-channel analog / 5 AES / 4 groups 
of SD and HD de-embedding and 
embedding possible

Mounts inside any X75HD/X75SD system, 
and includes the following:

• Analog, AES/EBU, and embedded 
SD-SDI and HD-SDI audio I/O

• 16-channel processing

• Audio analog-to-digital conversion

• Audio digital-to-analog conversion

• SD/HD audio embedding

• SD/HD audio de-embedding

• Audio synchronizing

• Audio delay insertion

• Audio processing amplification

• Coaxial breakout cables set

X75OPT-AS-16-L Audio synchronizer module with 
audio limiter

Same as X75OPT-AS-16, but with optional 
audio limiter soft key option

X75OPT-DOLBY-1 Internal Dolby-E decoder 
submodule

Dolby-E and Digital (AC3) integrated 
decompression; includes firmware upgrade

X75OPTFIBER-FC FC-type fiber connectors FC-type fiber connectors (factory installed)

X75OPTFIBER-ST ST-type fiber connectors ST-type fiber connectors (factory installed)

X75OPT-HDUPG HDTV submodule with up, down, or 
cross conversion

Inputs and outputs are coaxial and optical

X75OPT-PS Power supply field power supply 
retrofit kit, including AC internal 
connection

Field upgradeable

X75OPT-PQM Analog video input submodule with 
3D adaptive comb filtering, 
composite, S-video, and analog 
component BetacamTM inputs

• Provides the same inputs as the 
X75OPT-A3D module, but with slightly 
lower quality combing and decoding 
technology

• Field upgradable or factory installed

Table 1-2. X75HD/X75SD System Options(Continued)

Product Code Description Major Features
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X75OPT-STR Optional video and audio streaming 
for Ethernet monitoring (SDTV and 
down-converted HDTV)

Streaming submodule, field-upgradable

X75-RCP Remote control panel for 
X75HD/X75SD

Can control DPS-475/575

Cable Options

X75OPTCAB-MULTI Cable set for multi input/output 
connectors
• Sync/comp out
• Blue, Green, and Red out
• Y/C out
• SDTV and HDTV audio delay
• GPI1 and GPI2 in
• GPI1 and GPI2 out

1 ft (30 cm) multi I/O breakout cable with the 
following connector types:

• DB26(M) to 6 x BNC(F), 1 x XLR(F), 1 x 
MiniDin4(F), and 4 x RCA(F)

X75OPTCAB-DVI Cable for DVI-D single-link output DVI-D to DVI-D (digital-single link) cable

X75OPTCAB-8-C 1 cable set for 8-channel audio 
synchronizer, with the following 
unbalanced coax AES connectors:
• AES1, AES2, and DARS in 
• AES1 and AES2 out

1 ft (30 cm) breakout cable with the 
following connector types:
• DB26(M) to 5 x BNC(F)

X75OPTCAB-8-X 1 cable set for 8-channel audio 
synchronizer, with the following 
balanced XLR AES connectors:
• AES1, AES2, and DARS in 
• AES1 and AES2 out

1 ft (30 cm) breakout cable with the 
following connector types:

• DB26(M) to 3 x XLR(F)
• 2 x XLR(M) 

X75OPTCAB-8-CX 1 cable set for 8-channel audio 
synchronizer, with the following 
unbalanced coax AES and XLR 
connectors:
• AES1, AES2, and DARS in 
• AES1 and AES2 out

1 ft (30 cm) breakout cable with the 
following connector types:

• DB26(M) to 5 x BNC(F)
• 3 x XLR(F)
• 2 x XLR(M)

Table 1-2. X75HD/X75SD System Options(Continued)

Product Code Description Major Features
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X75OPTCAB-16-C 2 cable sets for 16-channel audio 
synchronizer, with unbalanced coax 
AES connectors
• AES1, AES2, and DARS in 
• AES1 and AES2 out
• AES3, AES4, and AES5 in
• AES3, AES 4, and AES 5 out

2 X 1 ft (30 cm) breakout cables with the 
following connector types:
• DB26(M) to 5 x BNC(F)
• DB44(M) to 6 x BNC(F)

X75OPTCAB-16-X 2 cable sets for 16-channel audio 
synchronizer, with balanced XLR 
AES connectors
• AES1, AES2, and DARS in 
• AES1 and AES2 out
• AES3, AES4, and AES5 in
• AES3, AES 4, and AES 5 out

2 X 1 ft (30 cm) breakout cables with the 
following connector types:

• DB26(M) to 3 x XLR(F) and 
2 x XLR(M) 

• DB44(M) to 3 x XLR(F) and 
3 x XLR(M)

X75OPTCAB-16-CX 2 cable sets for 16-channel audio 
synchronizer, unbalanced coax AES 
and balanced XLR AES
• AES1, AES2, and DARS in 
• AES1 and AES2 out
• AES3, AES4, and AES5 in
• AES3, AES 4, and AES 5 out

2 X 1 ft (30 cm) breakout cables with the 
following connector types:

• DB26(M) to 5 x BNC(F), 3 x XLR(F), and 
2 x XLR(M)

• DB44(M) to 6 x BNC(F), 3 x XLR(F), and 
3 x XLR(M)

Table 1-2. X75HD/X75SD System Options(Continued)

Product Code Description Major Features
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Software Upgrades 

X75OPT-ASL Audio limiter for X75OPT-AS-16 or 
X75OPT-AS-8 digital audio 
synchronizers

Field-upgradable software key

X75OPT-HDDUOCON Software key, required for 
simultaneous up, down, or cross 
conversions. 

Field-upgradable software key

X75OPT-NR SDTV noise reducer Three-dimensional SDTV digital noise 
reduction with the following features:

• Impulse noise reduction
• Gaussian random noise reduction
• Compression “blocky-ness” and mosquito 

artifact reduction
• Directional softening/sharpening filter

X75OPT-SNMP Software upgrade that permits the 
X75HD/X75SD to communicate 
using SNMP over an Ethernet 
network

Field-upgradable software key

X75OPT-V2A Automatic video/audio timing 
correction for lip sync problems

Field-upgradable software key

Spare Replacement Kit (X75SD and X75HD)

X75SPR-KIT Replacement parts for in-field 
servicing

Includes the following parts:
• 2 fans
• 4 stackers
• 1 power supply with no connectors
• 1 shaft encoder

Table 1-2. X75HD/X75SD System Options(Continued)

Product Code Description Major Features
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Available Documentation

X75MANUAL X75HD/X75SD Multiple Path 
Converters and Frame 
Synchronizers Installation and 
Operation Manual (hardcopy) plus 
documentation CD

The Documentation for X75HD/X75SD 
Systems and Control Panels CD includes 
PDFs of the following documents:

• X75HD/X75SD Multiple Path Converters 
and Frame Synchronizers Installation and 
Operation Manual

• Control Panels for X75HD/X75SD 
Systems Installation and Operation 
Manual

• X75HD/X75SD Multiple Path Converters 
and Frame Synchronizers Quick Start 
Guide

• X75HD/X75SD Module Installation Note
The CD also includes the Control Parameter 
List HTML document that contains specific 
descriptions about available menus, 
submenus, parameters, or options. 

All documentation is also available for 
download from the Leitch Web site at 
www.leitch.com.

X75MANUAL-RCP Control Panels for X75HD/X75SD 
Systems Installation and Operation 
Manual (hardcopy) plus 
documentation CD

See above.

Table 1-2. X75HD/X75SD System Options(Continued)

Product Code Description Major Features

http://www.leitch.com
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Typical Control Configurations
The X75HD/X75SD models can be configured, controlled, and 
monitored using the following methods:
• Local control panel on X75HD/X75SD models (see the Control 

Panels for X75 Systems Installation and Operation Manual for 
details)

• X75-RCP remote control panel (see the Control Panels for X75 
Systems Installation and Operation Manual for details)

• Local control panel on DPS-575 frames on the same network
• RC-575 Remote control panel
• Web server control, viewable on a browser program such as Internet 

Explorer™ (IE) or Netscape™ (see “Configuring for HTTP Control 
via Web Browser” on page 98 or “Overview” on page 129 for 
details)

• CCS™ (Command and Control System) applications such as Pilot 
or Navigator (see the CCS application online help for details)

• SNMP (Simple Network Management Protocol) and third-party 
control software through Leitch CCS Protocol (see“Configuring 
Third-Party SNMP Software Control” on page 315 for details)

All remote methods of operation involve Ethernet connections. See 
Figure 1-4 on page 24 for an illustration of these various control 
configurations.

Note
The maximum recommended 
length for a standard 
10/100Base-T cable is 328 ft 
(100 m).
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Figure 1-4. Typical Configuration, Control, and Monitoring Methods
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Overview of Operating Modes
Video Functional Block Diagram

Fully loaded X75HD/X75SD frames are the aggregate of discrete 
modular solutions as indicated in Figure 1-5. The X75HD/X75SD 
contains four independent video frame synchronizers (each with its own 
video processing capabilities) and support for multiple processing 
functions including up/cross/down conversion, test signal generation, 
noise reduction, and aspect ratio conversion. Single or multiple input 
video processing is possible, allowing either one input signal to be sent 
to all outputs, or independent synchronization, phasing and processing 
capabilities for up to four video channels. 

 

Figure 1-5. Video Functional Block Diagram
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The controls for those processing blocks are located in the submenu 
located at Video Setup>Processing, and will appear automatically as 
the respective hardware and software options are installed.

Default (Auto Detect) vs. Video Routing and Simulcast 
Modes

There are two main operational modes for defining the input video: 
M-Path (multiple-path) processing, and Simulcast processing. A third, 
Auto Detect, is the default mode.
X75HD/X75SD units are shipped with Auto Detect video mode as the 
factory default setting. This mode sets the X75HD/X75SD to 
automatically detect analog, SD1, SD2, HD-F, HD1, HD2, composite, 
and S-video inputs. When video is connected to any of these inputs, the 
X75HD/X75SD automatically selects the applied input video and then 
sends the converted video to all outputs. The Video Input LEDs on the 
front panel show the selected video source.
In the video routing mode, an output is selected, and then the input to be 
processed to that output is selected. Depending on the configuration, up 
to four paths can be set up.
To operate an X75HD/X75SD frame in Simulcast mode (where any two 
inputs are selected to switch simultaneously between determined 
outputs, such as SDTV and HDTV), you will need to set up the unit to 
process signal information differently. To do this, see “Simulcast 
Operation” on page 32.
For more information on the conversion capabilities and options 
provided by the X75HD/X75SD, see “HD Conversion Capabilities” on 
page 349.
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X75OPT-HDDUOCON Option
An X75 provides up, down, or crossconversion. With the addition of the 
HDDUOCON option, simultaneous up and down, or cross and down 
conversions are possible.

By selecting the M-Path mode, you can quickly route a particular input 
source to all of the X75’s outputs simultaneously. To do this, use the All 
Out Select parameter. Follow this path: Video Setup>Routing 
Setup>All Out Sel.
Several examples of M-Path video processing are illustrated in 
Figure 1-6 on page 28 and Figure 1-7 on page 29.
When you need a single input video source to be processed and sent to 
all outputs, press the Video In button or select the Video 
Setup>Routing Setup>All Out Sel parameter to select the desired 
input video source to be processed. The X75HD/X75SD automatically 
routes the selected input to all outputs and inserts any selected 
processing blocks. 
When multiple and independent video channel processing is required, 
the Video M-Path parameter in Video Setup>Routing Setup menu 
allows each video output group to be assigned an input source. 
Press the Audio In button or select the Audio Setup>Routing>Audio 
In Src Select parameter to select a single audio group type to be 
synchronized, processed and sent to all outputs. Depending on the 
selected input audio group type, the software automatically handles all 
internal processing, including de-multiplexing, signal routing, 
synchronization, and re-embedding.
The available input audio group types for selection are the following:
• User—When more than one audio input group types is selected
• Analog—Selects all four analog audio inputs for processing
• AES—Selects all AES inputs for processing

Table 1-3. “DUOCON” Conversion Capability

Conversion With 
X75OPT-HDDUOCON

Without 
X75OPT-HDDUOCON

Upconversion and downconversion Yes No

Upconversion and crossconversion No No

Downconversion and crossconversion Yes No

Note
If you have routed a particular 
input feed to an output, (or 
series of outputs) for up, down, 
or cross-converting, and then 
begin setting up a new 
conversion pattern, the existing 
conversion will be disrupted 
immediately.

Note
Analog component video inputs 
are only available if your 
X75HD/X75SD system 
includes an X75OPT-PQM or 
X75OPT-A3D module.
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• SD—Selects the demuxed audio from SDI input for processing
• DV—Selects the DV input audio for processing (future release)
• HD—Selects the demuxed audio from HD-SDI input for processing
• Dolby Dec—Selects the internally decoded Dolby audio signals for 

processing

For complex audio processing applications, you can also manually 
route the signal by changing the parameters. Follow this path:
Audio Setup>Routing>Input and Audio Setup>Routing>Output 
Each SRC can be independently configured to accept one of the 
available stereo audio inputs using the controls under the Audio 
Setup>Routing>Input menu. 
The controls under the Audio Setup>Routing>Output menu allow 
each mono audio output to be independently derived from any of the 
SRCs, audio mute, or test tones.

Figure 1-6. M-Path Single-Source Video and Audio Processing

Note
The Ctrl and A Proc and audio 
Gain buttons provide quick 
access to the Gain controls for 
each SRC.

Note
DV input and output is reserved 
for future use.
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Figure 1-7. M-Path (Dual Source Video and Audio) Processing
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Figure 1-8. Audio Functional Block Diagram-16 Channel
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HDTV Demux  7/8
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AES 3/4
AES 5/6
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AES 9/10
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Analog 3/4

DOLBY-E, AC-3

AES 1-5

DV 1-2
(left and right audio channels)
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Figure 1-9. Audio Functional Block Diagram-8 Channel
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and selected to any output
(single channel capability)

4 SRCS

AES 1/2
AES 3/4
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Simulcast Operation
General Description

Using the Simulcast mode, you can quickly switch between the two 
input sources (Input A, and Input B) out of the many possible inputs. 
Select the video sources to both Input A and Input B via the following 
path: Video Setup>Routing Setup>Simulcast.
The Simulcast Sel parameter switches between the two inputs. This 
switching can also be activated from the GPI input. To operate the unit 
in Simulcast mode, use the I/P Video Mode parameter in the Routing 
Setup menu.
When you enable the Simulcast mode, the X75HD/X75SD can switch 
SDTV and HDTV inputs to simultaneous, deterministic SDTV and 
HDTV outputs. Use this mode when you need to alternate between both 
HDTV and SDTV signals and broadcast them together (for example, if 
you have an HDTV satellite feed carrying the programming and an 
SDTV local feed carrying the advertisements). Figure 1-10 shows a 
simplified illustration. For more information on selecting inputs for 
Simulcast processing, see “Processing Modes” on page 101. 

Figure 1-10. Simulcast Processing
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Switcher Application
As a switcher, the X75HD switches between two SDTV inputs with 
clean outputs and voice-over (see Figure 1-11).

Figure 1-11. Simulcast Switcher Application

Synchronizer,
up/down/cross

converter

Synchronizer

Video

Audio

X75SD
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Chapter 2

Applications

Overview
X75HD and X75SD units function in many different ways, taking on a 
wide variety of roles. This chapter includes some common applications 
that may apply in your facility: 
• “Input Video Processing” on page 36
• “Output Video Processing” on page 43
• “Input Video and Audio Processing” on page 44
• “Video and Audio Converting” on page 47
• “Bridging Router Switchers” on page 49
• “Simulcast Switching” on page 50
The multi-conversion and frame synchronization abilities of the 
X75HD/X75SD make it ideal for hybrid SDTV and HDTV broadcasts 
in cable, satellite, mobile, and production facilities.
In the following pages, a variety of typical applications are described, 
along with the settings required for quick setup.
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Input Video Processing
This section includes the following common input video processing 
applications:
• Table 2-1: "Input Video Processing for Mobile or Outside 

Broadcast Vehicles"  on page 37
• Table 2-2: "Critical Input Video Processing for 

Satellite/Microwave Reception"  on page 38
• Table 2-3: "Input Video Processing for News Production"  on 

page 40
• Table 2-4: "Ingest Input Video Processing with Audio 

Decompressing and Processing"  on page 41
• Table 2-5: "Ingest Input Video Processing with Internal Audio 

Decompression and Processing"  on page 42
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Table 2-1. Input Video Processing for Mobile or Outside Broadcast Vehicles

Description Products
The X75HD auto-detects a composite, SD-SDI or HD-SDI input and 
then sends it through the video processing engine to provide multiple 
types of outputs.

The X75HD automatically converts any composite, SD-SDI or HD-SDI 
signal to the required output format. A single BNC connector on the 
bulkhead of a mobile or outside broadcast vehicle feeds a wideband 
distribution amplifier. The wideband distribution amplifier feeds into 
the composite, SD-SDI and HD-SDI inputs of the X75HD. The X75HD 
is set up to auto-detect any of the three types of inputs and provide 
processed video to all of the outputs. 

You can preset the HDTV output to provide the required format (for 
example, 1080i or 720p) for production.

X75HD with these options:

• X75OPT-A3D analog video 
input option

• INT-EX6X1 (16 channel video 
wideband distribution amplifier)

Required Settings Navigation Path
I/P Video Mode Video Setup>Routing Setup>Auto Detect

Analog Video Source Video Setup>Analog Input (A3D or PQM)>Composite

Analog In Video Setup>Routing Setup>Auto Detect Setup>Normal

SD 1 In Video Setup>Routing Setup>Auto Detect Setup>Normal

HD 1/HD-Fiber In Video Setup>Routing Setup>Auto Detect Setup>Normal

CBVS

Synchronizer,
up/down/cross

conversion

X75HD

SVID

SD1

HD1
HD2

HDF

SD2
DV

CAV

BNC
(Bulkhead)

INT-EX6X1

AUX
CBVS

SVID

RGB/S

HD
ENET

HDF

SD
DV

CAV
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Table 2-2. Critical Input Video Processing for Satellite/Microwave Reception

Description Products
The X75HD auto-detects and then switches HD-SDI main and backup 
receivers (with an SDTV backup receiver) through the video processing 
engine to provide multiple types of outputs.

Main (primary) and backup (secondary) HDTV receivers provide inputs 
which are automatically switched and processed to the required output 
format. A tertiary SDTV receiver provides a backup if both HDTV 
receivers do not have outputs.

X75HD-AV with X75OPT-A3D 
analog video input option

Required Settings Navigation Path
I/P Video Mode Video Setup>Routing Setup>Auto Detect

HD 1/HD-Fiber In Video Setup>Routing Setup>Auto Detect Setup>Highest

HD 2 In Video Setup>Routing Setup>Auto Detect Setup>High

SD 1 In Video Setup>Routing Setup>Auto Detect Setup>Normal

Ch1-Aud Follows Vid Audio Setup>Routing>Audio Follow Video>SRC 1>On

Ch1-AFV-HD1 Audio Setup>Routing>Audio Follow Video>SRC 1>AES1a/1b

Ch1-AFV-HD2 Audio Setup>Routing>Audio Follow Video>SRC 1>AES2a/2b

Ch1-AFV-SD 1 Audio Setup>Routing>Audio Follow Video>SRC 1>AES3a/3b

X75HD
AUX

CBVS

SVID

RGB/S

HD
ENET

HDF

SD
DV

CAV

CBVSNTSC/ PAL/SECAM

Analog audio

SDI 525, 625

Embedded audio

Embedded audio

SDI 525, 625

AES

AES

HD 1080I, 720P

HD 1080I, 720P

Synchronizer,
up/down/cross

conversion

SVID

SD1

HD1

HD2

HDF

SD2
DV

CAV

Main

Backup

Backup

AA

AA

DV DV
SD

HD

AES

AES
Synchronizer

SD1

HD1
HD2

HDF

SD2
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Additional Factory Default Settings

AA Out1 Audio Setup>Routing>Output>SRC1a

AA Out2 Audio Setup>Routing>Output>SRC1b

AES1 OutA Audio Setup>Routing>Output>SRC1a

AES1 OutB Audio Setup>Routing>Output>SRC1b

SD 1/HD1 OutA Audio Setup>Routing>Output>SRC1a

SD 1/HD1 OutB Audio Setup>Routing>Output>SRC1b

Table 2-2. Critical Input Video Processing for Satellite/Microwave Reception
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Table 2-3. Input Video Processing for News Production

Description Products
The X75HD selects and accepts inputs from various composite, 
SD-SDI or HD-SDI tape machines, and then sends the signal through 
the video processing engine to provide multiple types of outputs.

Select and convert any tape format to the required output format.

X75HD-AV with X75OPT-A3D 
analog video input option

Required Settings Navigation Path
I/P Video Mode Video Setup>Routing Setup>M-Path (User)

All Out Sel Button Shortcut: Video In 
or Video Setup>Routing Setup> Composite/S-Video/CAV/SD 1/DV/HD 
1 (Select one)

Audio In Src Select Button Shortcut: Audio In 
or Audio Setup>Routing>Analog, AES, SD, DV, HD (Select one)

CBVS
VHS, 3/4”, 1”

Betacam

Digital Betacam

S-video

DV (25 Mb/s)

HD 1080I, 720P

Synchronizer,
up/down/cross

conversion

SVID

SD1

HD1

HD2

HDF

SD2
DV

CAV

Analog audio

Embedded audio

Embedded audio

AES

DV

AA

AA

DV
DV
SD

HD

AES

AES
Synchronizer

SD1

HD1
HD2

HDF

SD2

AUX
CBVS

SVID

RGB/S

HD
ENET

HDF

SD
DV

CAV

X75HD
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Table 2-4. Ingest Input Video Processing with Audio Decompressing and Processing

Description Products
The X75HD processes HD-SDI signals with embedded compressed 
audio using an external audio decompressor.

The system will also de-embed an embedded compressed audio stream 
and provide it as an AES stream into the audio decompressor. The 
X75HD processes decompressed audio streams (four AES, eight 
channels) and times them with the video signal. A discrete audio input 
can be used for a voice-over channel.

X75HD and audio decompressor 
(for example, Dolby™ Digital 
AC-3™, or E™).

Required Settings Navigation Path
I/P Video Mode Video Setup>Routing Setup>M-Path (User)

All Out Sel Button Shortcut: Video In or Video Setup>Routing Setup>HD1

SRC1 Input Select Audio Setup>Routing>Input>AES1a/1b

SRC2 Input Select Audio Setup>Routing>Input>AES2a/2b

SRC3 Input Select Audio Setup>Routing>Input>AES3a/3b

SRC4 Input Select Navigation Path: Audio Setup>Routing>Input>AES4a/4b

SRC5 Input Select Audio Setup>Routing>Input>HDX1/2

AES5 OutA Audio Setup>Routing>Routing>Output>SRC5a

AES5 OutB Audio Setup>Routing>Routing>Output>SRC5b

HD 1080I, 720P

Voice-over

Synchronizer,
up/down/cross

conversion

AA
AES

AES
AES

AES

Demux
compressed

audio

Decompress
audio Synchronizer

AUX
CBVS

SVID

RGB/S

HD
ENET

HDF

SD
DV

CAV
X75HD
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Table 2-5. Ingest Input Video Processing with Internal Audio Decompression and Processing

Description Products
HD-SDI video with embedded compressed audio is processed using the 
X75HD with the optional internal audio decompressor.

The embedded compressed audio stream is de-embedded and provided 
as an AES stream into the internal audio decompressor. The 
decompressed audio streams (four AES, eight channels) are processed 
and timed with the video signal.

X75HD with optional Dolby-X75 
internal audio decompressor

Required Settings Navigation Path
I/P Video Mode Video Setup>Routing Setup>M-Path (User)

All Out Sel Button Shortcut: Video In or 
Video Setup>Routing Setup>HD1

Dolby Input Select Audio Setup>Routing>Input>HDX1/2 (Assuming the compressed audio is in 
Group 1: channels 1 and 2)

SRC1 Input Select Audio Setup>Routing>Input>Dolby1/2

SRC2 Input Select Audio Setup>Routing>Input>Dolby3/4

SRC3 Input Select Audio Setup>Routing>Input>Dolby5/6

SRC4 Input Select Audio Setup>Routing>Input>Dolby7/8

HD 1080I, 720P

Voice-over

Synchronizer,
up/down/cross

conversion

AA
AES

AES
AES

AES

Demux
compressed

audio

Decompress
audio Synchronizer

AUX
CBVS

SVID

RGB/S

HD
ENET

HDF

SD
DV

CAV
X75HD
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Output Video Processing
Table 2-6 describes a sample output video processing application 
commonly used with audio compression and processing.

Table 2-6. Output Video Processing with Audio Compression and Processing

Description Products
The X75HD synchronizes and processes HDTV and AES signals. 
Using an external audio compressor, the four AES signals get 
decompressed. This compressed AES stream is later fed back to 
the X75HD/X75SD where it is re-embedded with the HD-SDI 
signal. A discrete audio input can be used for a voice-over channel.

X75HD-AV with an external audio 
compressor (for example, DOLBY™ 
Digital AC-3™, or E™).

Required Settings Navigation Path
I/P Video Mode Video Setup>Routing Setup>M-Path (User)

All Out Sel Button Shortcut: Video In
or Video Setup>Routing Setup>HD1

Audio In Src Select Button Shortcut: Audio In
or Audio Setup>Routing>AES

Voice-over

HD 1080I, 720P
Synchronizer,
up/down/cross

conversion

Mux compressed
audio

Compress
audio

Synchronizer
AES
AES
AES
AES

AUX
CBVS

SVID

RGB/S

HD
ENET

HDF

SD
DV

CAV
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Input Video and Audio Processing
Tables 2-7 and 2-8 describe common input video and audio processing 
applications.

Table 2-7. Input Video, Embedded Audio, and Compressed Audio Processing with External 
Audio Compression and Decompression

Description Products
The X75HD processes HD-SDI video with embedded audio and 
embedded compressed audio using an external audio decompressor 
and compressor.

The system also processes HDTV video and AES program signals. 
Embedded compressed audio is sent to an audio decompressor, 
providing three AES (5.1) signals to the X75HD. The X75HD 
processes the audio signals and then sends them to an audio 
compressor. The compressed audio signal is sent to the X75HD 
where it is embedded into the output processed program video signal.

X75HD-AV and external audio 
compressor and decompressor (for 
example, Dolby™ Digital (AC-3™) or 
E™).

Required Settings Navigation Path
I/P Video Mode Video Setup>Routing Setup>M-Path (User)

All Out Sel Button Shortcut: Video In or Video Setup>Routing Setup>HD1

Audio In Src Select Button Shortcut: Audio In or Audio Setup>Routing>AES

SRC6 Input Select Audio Setup>Routing>Input>HDX1/2

AES5 OutA Audio Setup>Routing>Output>SRC6a

AES5 OutB Audio Setup>Routing>Output>SRC6b

AES 1
AES 2
AES 3
AES 4
AES 5

Compress audio

Decompress audio

AES 1
AES 2
AES 3
AES 4
AES 5

HD with embedded
audio (AES)

Demux
audio

Synchronizer,
up/down/cross

conversion

Mux audio HD with embedded
audio (AES)

Synchronizer

X75HD
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Table 2-8. Input Video, Embedded Audio, and Compressed Audio Processing with External 
Audio Compression and Internal Audio Decompression 

Description Products
HD-SDI video with embedded audio and embedded compressed 
audio is processed using the X75HD, an internal audio 
decompressor, and an external audio compressor.

The HDTV video and AES embedded program signals are 
processed through the X75HD. Embedded compressed audio is sent 
to an internal audio decompressor, providing three AES (5.1) 
signals to the X75HD audio processor. Two embedded program 
audio streams are sent to the X75 audio processor. The X75HD 
processes the audio signals. The processed 5.1 audio signals are sent 
to an external audio compressor which feeds the compressed (5.1) 
signals into the X75HD where they are embedded into the program 
signal. The processed program audio signals are embedded into the 
output.

X75HD-AV, Dolby-X75 internal audio 
decompressor, and external audio 
compressor (for example Dolby-E™, 
AC-3™)

Required Settings Navigation Path
I/P Video Mode Video Setup>Routing Setup>M-Path (User)

All Out Sel Button Shortcut: Video In
or Video Setup>Routing Setup>HD1
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Dolby Input Select Audio Setup>Routing>Input>HDX1/2 (Assuming the compressed audio 
is in Group 1: channels 1 and 2)

SRC1 Input Select Audio Setup>Routing>Input>Dolby1/2

SRC2 Input Select Audio Setup>Routing>Input>Dolby3/4

SRC3 Input Select Audio Setup>Routing>Input>Dolby5/6

SRC4 Input Select Audio Setup>Routing>Input>Dolby7/8

AES1 OutA Audio Setup>Routing>Output

AES1 OutB Audio Setup>Routing>Routing>Output>SRC1a

AES2 OutA Audio Setup>Routing>Routing>Output>SRC1b

AES2 OutB Audio Setup>Routing>Routing>Output>SRC2a

AES3 OutA Audio Setup>Routing>Routing>Output>SRC2b

AES3 OutB Audio Setup>Routing>Routing>Output>SRC3a

SRC5 Input Select Audio Setup>Routing>Routing>Output>SRC3b

Table 2-8. Input Video, Embedded Audio, and Compressed Audio Processing with External 
Audio Compression and Internal Audio Decompression (Continued)
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Video and Audio Converting
Table 2-9 describes a common video and audio converting application, 
using a wrap-around for tape transports. (The X75OPT-HDDUOCON 
software key option is required for this application.)

Note
Many input and output choices 
are possible. This example is 
based on SD 1+AES1 inputs for 
up-conversion and CVBS+AA 
(analog audio) outputs for 
down-conversion.

Table 2-9. Wrap-Around for Tape Transports

Description Products
The X75HD provides conversion and processing for video and 
audio for HDTV and all SDTV formats.

Video and audio connections through the X75HD provide 
conversion and synchronization (along with time base 
correction, if required) for standard definition and high definition 
tape transports.

X75HD-AV

Synchronizer,
upconversion

Synchronizer,
downconversion HD1

HD2

HDF

HDF

HD

VHS, 3/4”, 1”

Betacam
Digital Betacam

S-video

DV (25 Mb/s)

Audio

Video

Synchronizer

HD1

HD

HD2

HDF

HDF

X75HD

CBVS

CBVS

SVID

SVID

RGB/S

SD2

SD

DV

DV

CAV
SD1

CAV

AA

AA

DV

DV
SD

HD

AES

AES

SD1
SD2

HD D5
HDCAM
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Required Settings Navigation Path
I/P Video Mode Video Setup>Routing Setup>M-Path (User)

HD Out Sel Video Setup>Routing Setup>Video M-Path>SD 1

Analog Out Sel Video Setup>Routing Setup>Video M-Path>HD 1

SRC1 Input Select Audio Setup>Routing>Input>AES1a/1b

SRC2 Input Select Audio Setup>Routing>Input>AES1a/1b

SRC3 Input Select Audio Setup>Routing>Input>AES>HDX1/2

AA Out1 Audio Setup>Routing>Output>SRC3a

AA Out2 Audio Setup>Routing>Output>SRC3b

Table 2-9. Wrap-Around for Tape Transports
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Bridging Router Switchers
Table 2-10 describes a common application for bridging router 
switchers. To configure the X75HD for this application, use the 
parameter settings shown for “Wrap-Around for Tape Transports” on 
page 47.

Note
The X75OPT-HDDUOCON 
software key option is required 
for this application.

Table 2-10. Bridging Between Routing Switchers with Different Formats

Description Products
The X75HD provides conversion and processing for video and audio for HDTV 
and all SDTV formats.

Video and audio can be converted through the X75HD providing bridges 
between sources and destinations in hybrid facilities.

X75HD, Panacea and 
Integrator Routing 
Systems

Synchronier,
upconversion

Analog
video router

Analog
audio router

Digital
router

Digital
audio router

Synchronizer,
downconversion

Audio

Synchronizer

Synchronizer

Video

HD1
HD2

HDF

HDF
HD

HD1

HD

HD2

HDF

HDF

X75HD

Digital
router

CBVS

CBVS

SVID

SVID

RGB/S

SD2

SD

DV

DV

CAV
SD1

CAV

AA

AA

DV

DV
SD

HD

AES

AES

SD1
SD2
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Simulcast Switching
Table 2-11 describes a common application for simulcast switching of 
SDTV and HDTV signals.

Table 2-11. Simulcast Switching of Standard and High Definition Signals

Description Products
You can configure the X75HD to do an A/B switch using any two 
inputs; all inputs are provided simultaneously. In this example, 
A=HD, and B=SD. Simultaneous HD and SD outputs are available. 
You can perform the A/B switch manually or by GPI.

X75HD-AV

Required Settings Navigation Path
I/P Video Mode Video Setup>Routing Setup>Simulcast

Input A Video Setup>Routing Setup>Simulcast>HD1

Input B Video Setup>Routing Setup>Simulcast>SD1

Simulcast Sel Video Setup>Routing Setup>Simulcast>Input A

Ch1-Aud Follows Vid Audio Setup>Routing>Audio Follow Video>SRC 1>On

Ch1-AFV-HD1 Audio Setup>Routing>Audio Follow Video>SRC 1>HDX1/2

Ch1-AFV-SD 1 Audio Setup>Routing>Audio Follow Video>SRC 1>AES1a/1b
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Module and Back Panel Descriptions

Overview
This chapter briefly describes the X75HD/X75SD modules and their 
corresponding back panels, including card-edge LEDs and controls, 
jumper settings, and connector information. The following topics are 
included:
• “X75OPT-AS-16/X75OPT-AS-8 Modules and Back Panels” on 

page 52
• “X75OPT-A3D Module and Back Panel” on page 58
• “X75OPT-PQM Module and Back Panel” on page 60
• “X75HD Module and Back Panel” on page 63
• “X75OPT-STR Module and Back Panel” on page 65

See the following chapters for more information on back panel cables 
and connectors, servicing, and performance specifications:
• “Cables and Pinouts” on page 195
• “Servicing” on page 255
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X75OPT-AS-16/X75OPT-AS-8 Modules and 
Back Panels

General Description
The X75OPT-AS-16/8 audio modules and associated back panels 
provide two/five AES inputs and outputs, one DARS input, a 
four-channel analog audio input, and a four-channel analog audio 
output. With this module, the X75HD/X75SD can process, embed, and 
de-embed 16/8 channels from/to SDTV and from/to HDTV.
Looking from the rear, this back panel is located in the top, left corner 
of the frame, above the SDTV video connectors.

Figure 3-1. X75OPT-AS-16/X75OPT-AS-8 Back Panel

This module provides all audio processing for the X75HD/X75SD and 
is required to access, configure, and enable audio parameters in the 
Audio Setup submenu, including gain, delay, tone, mute, fade, 
voice-over, and AFV (audio follow video).

Analog audio 
input connector DARS input

Analog audio 
output connector

 AES I/O connectors
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Required Jumper Settings and Local Configuration
Setting Jumpers
To configure the impedances of analog audio inputs and outputs, you 
must set specific jumpers. 
Jumpers 1 through 12 are located at the rear of the module. Figure 3-2 
on page 54 shows the location of the jumpers. See Table 3-1 for the 
correct placement of the jumpers. The white triangle next to each 
jumper indicates pin 1.

Table 3-1. Analog Audio Input and Output Impedance Jumper Settings

Input Settings
Input Number Jumper Numbers Channel Pin Numbers Setting

1 J5 Left (1A) 1 and 2 600Ω

2 and 3 100kΩ

2 J6 Right (1B) 1 and 2 600Ω

2 and 3 100kΩ

3 J7 Left (2A) 1 and 2 600Ω

2 and 3 100kΩ

4 J8 Right (2B) 1 and 2 600Ω

2 and 3 100kΩ

Output Settings
Output Number Jumper Numbers Channel Pin Numbers Setting

1 J1 and J9 Left (1A) 1 and 2 600Ω

2 and 3 66Ω

2 J2 and J10 Right (1B) 1 and 2 600Ω

2 and 3 66Ω

3 J3 and J11 Left (2A) 1 and 2 600Ω

2 and 3 66Ω

4 J4 and J12 Right (2B) 1 and 2 600Ω

2 and 3 66Ω
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Figure 3-2. Jumper Locations for X75OPT-AS-16 and X75OPT-AS-8 Modules

4 3 2 14 3 2 1

Jumpers for 
outputs 4, 3, 2, 1

Jumpers for 
inputs 4, 3, 2, 1

J5J6J7J8
J1/9J2/10J3/11J4/12

4 3 2 14 3 2 1



X75HD/X75SD Installation and Operation Manual 55

Chapter 3: Module and Back Panel Descriptions

 

Installing Audio Receptacles
To make analog audio input and output connections, you need to 
properly connect stripped wires for each audio channel to the provided 
audio receptacle. Once done, install the wired receptacle to the back 
panel audio input and output connectors. Follow these steps:
1. Insert a small, flathead screw driver into a rectangular hole of the 

audio receptacle. 
The corresponding round wire hole will open either directly above 
or directly below the screwdriver (see Figure 3-3).

2. Heeding the positive (+), negative (-), and ground (GND) markings 
on the back panel, place an appropriate stripped audio wire into the 
open hole.
The top row of wire connection holes alternate between positive 
and ground. The bottom row of wire connection holes alternate 
between negative and ground. See Figure 3-3.

Figure 3-3. Installing Analog Audio Receptacles

3. Remove the screwdriver to lock the wire into place. 
4. Repeat for other wire connections.
5. Once all wiring in completed, plug the receptacle into the analog 

audio input ports (each labelled CH1 CH2 CH3 CH4), and then 
secure the receptacle into place with the attached connector screws. 

+ G + G + G +

- G - G - G -

CH1 CH2 CH3 CH4

+
- GND GND GND+

-
+
-

+
-

Connector 
screw

Rectangular slot
Insert a flathead screwdriver into a rectangular slot to 
open a corresponding round connection point (above or 
below)

Connector 
screw
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Special Control Considerations
For the AES input signals on DB-26 and DB-44 connectors, you can 
select either an Unbalanced or Balanced input from the Audio Setup 
submenu (accessed from the Main menu). For coaxial connections, 
select the default setting Unbalanced. For XLR connections, select the 
Balanced setting.

X75OPT-AS-16 or X75OPT-AS-8-L Audio Limiters 
Audio limiters are available as software options on both the 16-channel 
and 8-channel versions of the X75OPT-AS audio synchronizers. The 
audio limiters have the following available options:
• Soft Limit Level
• Slope
• Attack Rate
• Attack Time
• Decay Rate
• Decay Time
• Noise Gate Level
• Noise Gate Time
Figure 3-4 shows the transfer function of the audio limiter. Table 3-2 on 
page 57 describes the various options of the audio limiter.

Figure 3-4. Audio Limiter Transfer Function

Input (dB)

Output (dB)

Threshold

Slope = 1.0

Slope = 0.5

Slope = 0.0

Slope = 0.75

Slope = 0.25
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Table 3-2. Audio Limiter Options

Option Description
Soft Limit Level • Sets the threshold level for the input audio signal, measured in dB (decibels), 

where the audio signal limiter's attack and decaying function will be based
• When a signal exceeds this level, compression will be applied

Slope • Sets the amount a signal is reduced by the compressor 
• When the slope is set to 0.25, the audio input signal exceeding the soft limit 

threshold level will be reduced by the factor of 4 at the output.

Attack Rate Controls the rate of attack soft limiting

Attack Time • Activates limiter only after the input audio level remains over the Soft Limit 
Level for the duration specified in the Attack Time option

• Audio that exceeds the specified Soft Limit Level for less than the specified 
Attack time will not activate the limiter

• Attack Time indicates how long it takes for the compressor to act after a signal 
has exceeded the threshold level

Decay Rate Controls the rate of decay soft limiting.

Decay Time • Once the input audio signal has exceeded the Soft Limit Level and the limiter 
has been activated, the limiter remains active until the audio signal has returned 
below the Soft Limit Level for the duration specified in the Decay Time option

• If the input audio signal returns below the Soft Limit Level for less than the 
specified Decay Time, the limiter remains active

Noise Gate Level • Sets the noise gate threshold level, measured in dB.
• When an input signal falls below this level, the noise gate will be applied.

Noise Gate Time Indicates how long it takes for the noise gate to start or stop acting after the input 
signal has fallen below or risen above the threshold level.
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X75OPT-A3D
Module and Back Panel

General Description
The optional X75OPT-A3D analog video input module and associated 
back panel provide selectable analog composite, component Betacam 
(CAV), and S-video inputs (see Figure 3-5).
The composite input is processed through a high-performance industry- 
leading 3D adaptive comb filter. The TBC mode is always used when 
the S-video input is selected. When component analog video is selected 
as the input, it is converted to digital and then further processed as 
required.
Looking from the rear, this back panel is located in the top, right corner 
of the frame, above the dual Ethernet ports.

Figure 3-5. X75OPT-A3D Module Back Panel

To access, configure, and enable the analog video parameters associated 
with this module, enter the Video Setup parameter.

Analog composite 
video input connector

S-video input 
connector

Component Betacam 
video input connectors

Y In B-Y In R-Y In
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Special Control Considerations
Unlike SD-SDI inputs, only a single analog video source can be 
auto-detected. Therefore, you must pre-select the desired analog input 
video source (composite, S-video, or CAV) in order for the 
auto-detection to work across the HD-SDI/SD-SDI/analog inputs. To 
select a desired input, follow this path through the menu structure: 
Video Setup>Analog Input>Analog Video Source.
Additionally, set the I/P Video Mode parameter to Auto Detect.
For more information, see “Input Video Modes” on page 102. 
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X75OPT-PQM Module and Back Panel

General Description
The optional X75OPT-PQM module and associated back panel provide 
selectable analog composite, component Betacam (CAV), and S-video 
inputs (see Figure 3-6). This module is an economical alternative to the 
X75OPT-A3D option.
Composite input is processed through a 3D-adaptive comb filter. The 
TBC mode is always used when the S-video input is selected. When the 
component analog video input is selected, it is converted to digital and 
then further processed as required.
Looking from the rear, this back panel is located in the top, right corner 
of the frame, above the dual Ethernet ports.

Figure 3-6. PQM-X75 Back Panel

To access, configure, and enable the analog video parameters associated 
with this module, enter the Video Setup parameter.

Analog composite 
video input connector

S-video input 
connector

Component Betacam 
video input connectors

Y In B-Y In R-Y In
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Special Control Considerations
Unlike SD-SDI inputs, only a single analog video source can be 
auto-detected. Therefore, you must pre-select the desired analog input 
video source (composite, S-video, or CAV) in order for the 
auto-detection to work across the HD-SDI/SD-SDI/analog inputs. To 
select a desired input, follow this path through the menu structure: 
Video Setup>Analog Input>Analog Video Source. Additionally, you 
must set the I/P Video Mode parameter to Auto Detect.
For more information see “Input Video Modes” on page 102. 

Alternate PQM Color Decoding Algorithm (NTSC Only)
The current version of the PQM decoder code provides a superior 
separation of luma and chroma for the digital domain (SDI output). In 
some cases, however, when the luma and chroma are re-combined in 
the encoder, the resulting image may appear “soft” (see Figure 3-7). 

Figure 3-7. Current PQM Algorithm

When this condition occurs, the X75HD/X75SD has a useful alternate 
NTSC decoding algorithm that may provide better results. If an NTSC 
output is required (via back-to-back decoder/encoder), you can enable 
or disable the alternate PQM algorithm by following this path:
Video Setup>Analog Input (PQM)>Proc>Chroma Bandpass.

NTSC
NTSC (quality is diminished due to back-to-back PQM decoder

and encoder depending on output timing or picture position)
Current PQM algorithm

SDI (PQM decoder separates luma and chroma for a
superior quality in the digital domain)PQM color

decoder
color

encoder

X75 with X75OPT-PQM

Note
The alternate PQM algorithm 
results in diminished quality in 
the digital domain. If the SDI 
output is not being used, the 
alternate can be selected for an 
improved NTSC output.
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Figure 3-8. Alternate PQM Algorithm

NTSC
NTSC (quality is improved for back-to-back PQM decoder and
encoder and is not dependent on output timing or picture position)

New PQM algorithm

SDI (quality is diminished due to how new PQM decoder
separates luma and chroma into digital domain)PQM color

decoder
color

encoder

X75 with X75OPT-PQM
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X75HD Module and Back Panel

General Description
The X75HD (or X75OPT-HDUPG) module and associated back panel 
provides two HDTV coaxial inputs, two HDTV coaxial outputs, one 
HDTV fiber input, and one HDTV fiber output. This module provides 
and processes on-board up/down/cross-conversions.
The back panel is located in the top, middle of the frame, above the 
Multi I/O and DVI-D ports. X75HD modules are factory-installed in all 
X75HD systems, and available as an upgrade (X75OPT-HDUPG) for 
all X75SD and X75-DPS frames.

Figure 3-9. HD-X75 Back Panel

This module provides up, down, and crossconversion with both coaxial 
and fiber interfaces for HD. To access, configure, and enable the HDTV 
input and output parameters, enter the Video Setup parameter.

HD In2 HD In1
(includes BNC 
and fiber)

HD Out1
(includes BNC 
and fiber

HD Out2
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Precautions
The HD-X75 fiber optic module is a CLASS 1 laser product. 
Avoid looking directly at a laser. Laser radiation is invisible and can 
cause serious eye damage.

For more information on handling and connecting fiber optics, see 
“Understanding and Working With Fiber Optics” on page 257.

Special Control Considerations
The selection between HD1 and HD-Fiber is not automatic. You must 
pre-select the desired input video source first in order for auto-detection 
to work across the HD-SDI/SD-SDI/analog inputs. To select a desired 
input, follow this path through the menu structure: Video Setup>HD 
Input>HD1/HDF Input Select.
For more information, see “Input Video Modes” on page 102. 

Caution
USE OF CONTROLS OR 
ADJUSTMENTS OR 
PERFORMANCE OF 
PROCEDURES OTHER 
THAN THOSE SPECIFIED IN 
THIS MANUAL MAY 
RESULT IN HAZARDOUS 
RADIATION EXPOSURE.

LASER

!DANGER!
Class 1 Laser Product
Avoid Direct Exposure
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X75OPT-STR Module and Back Panel

General Description
X75HD/X75SD units provide the following two types of streaming: 
• A small “thumbnail” 128 x 96 pixel feed, which is available from 

the Ctrl/Strm port on all X75 frames (see page 138 for details)
• An optional, higher-quality 352 x 240 pixel (525) or 352 x 288 

pixel (625) feed provided at the Streaming Ethernet port, which is 
generated by the X75OPT-STR module

The optional higher-quality (1/4 VGA) streaming uses MPEG4 codec 
video compression. The image can be displayed at up to 30 frames per 
second (25 fps for PAL) with a bit rate of 200 Kbps, adjustable up to 
1Mbps (the frame rate drops each time you lower the bit rate). The 
streaming is viewable on QuicktimeTM version 7.0 or above, and 
requires v. 1.7 or later X75 firmware. The X75OPT-STR module 
provides both audio and video streaming, delayed approximately four 
seconds. Although the thumbnail and the higher-quality streaming feeds 
are provided by different modules, they both show the same output 
image.
The following “broadcast” standards are among those that are not 
supported as a streaming output from the X75OPT-STR module: 
• AVC
• AVI
• JVT 
• MPEG4 Part 10 (H.264)
• SMPTE VC-1 (WM9 or Windows Media 9)

To select the video source for the X75OPT-STR module, follow this 
path:
Video Setup>Routing>Video M-Path>StrV Out Sel

To select the audio streaming sources, follow this path:
Audio Setup>Routing>Output>Stream Out A (left channel) and/or 
Stream Out B (right audio channel)

Note
The streaming module requires 
its own network address. See 
the installation section 
beginning on page 279 for more 
information.
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Minimum Requirements
The PC that monitors the X75HD/X75SD’s streaming video using 
QuickTime should have the following minimum specifications when 
the lowest bit rate is used (200 KBps): 
• Pentium 3 processor (16 MHz)
• 512 MB SD-RAM
• 300 MB free disk space
• 10 BaseT network connection
• 19-inch monitor 
At the highest setting (1Mbps), the minimum requirements are the 
following:
• Pentium 4 processor, 3.0 GHz
• 512 MB SD-RAM
• 300 MB free disk space
• 100 BaseT network connection 
• 19-inch monitor
For installation and configuration instructions, see page 279.
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System Installation and Connections

Overview
This chapter contains the following information:
• “Checking the Packing List” on page 68
• “Preparing for Installation” on page 70
• “Installing Rack Support Brackets and Cable Relief Bar” on 

page 72
• “Making Cable and System Connections” on page 75
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Checking the Packing List
Before unpacking your product, read the “Unpacking/Shipping 
Information” on page xv.
Standard Items
The following items are included with every X75HD/X75SD system:
• One X75HD/X75SD Multiple Path Converters and Frame 

Synchronizers
• One AC power cable (773-254 or 773-505)
• Two rear support brackets (741-983A) and corresponding hardware
• Two cable relief support brackets (164-000306-00) and one 

corresponding cable relief bar (164-000305-00)

The following items are only included with X75HD/X75SD-AV and 
-LCAV systems:
• Two 2x7 analog audio terminal blocks (134-000228-00) 
• Eight-channel audio module with X75OPTCAB-8-C breakout cable
Or
• Sixteen-channel audio module with X75OPTCAB-16-C and 

X75OPTCAB-8-C coax breakout cables

Optional Items
You may have additional items included in your shipment if you have 
ordered any of the available options or upgrades. Some options may 
include the following:
• X75OPT-A3D high performance 3D-adaptive decoder, composite, 

component Betacam, and S-video input
• X75OPT-AS-8/16 digital audio synchronizers
• X75OPT-ASL audio limiter software key for X75OPT-AS-8/16 

digital audio synchronizers
• X75OPT-DOLBY-1 internal Dolby-E decoder submodule
• X75OPT-FIBER-FC and -ST fiber connectors
• X75OPT-HDUPG-HDTV submodule
• X75OPT-PS power supply kit
• X75OPT-PQM video module
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• X75OPT-STR streaming module
• X75-RCP remote control panel
• X75OPTCAB-MULTI breakout cable
• X75OPTCAB-16-C breakout cable set
• X75OPTCAB-16-X breakout cable set
• X75OPTCAB-16-XC combination BNC/XLR audio breakout cable 

set
• X75OPTCAB-8-C breakout cable 
• X75OPTCAB-8-XC breakout cable
• X75OPTCAB-8-X breakout cable
• X75OPTCAB-DVI cable
• X75OPT-ASL audio limiter
• X75OPT-HDDUOCON software upgrade key
• X75OPT-NR digital noise reduction and digital bandwidth filtering 

software key
• X75OPT-SNMP software upgrade
• X75OPT-v2A automatic video-to-audio timing tool
• X75SPR-KIT spare parts kit

Replaceable Parts Kit
The replaceable parts kit (X75SPR-KIT) includes the following items:
• 2 fans
• 4 stackers
• 1 power supply with no connectors
• 1 shaft encoder
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Preparing for Installation
Prior to installing your system, ensure that certain environmental and 
electrical conditions are met.

Meeting Electrical Requirements
The X75HD/X75SD power supply has a universal input of 100-240 
VAC at 47 to 63 Hz (nominal). There is no voltage selector switch. 
Ensure that a proper power supply source is available prior to operating 
your system.
Table F-25 and Table F-26 on page 346 describe the power 
consumption of individual components and system packages. These 
ratings refer to the total module power consumption (excluding that of 
the power supply) allowable within a X75HD/X75SD frame. The limits 
are based on the ability of the unit to dissipate heat over a temperature 
range of 32° to 122°F (0° to 45°C).
Each X75HD/X75SD frame has space for two power supplies; 
however, a single power supply can meet the requirements of a 
fully-loaded frame. An optional second power supply can be purchased 
to provide full backup redundancy. See “Installing a Redundant Power 
Supply” on page 293 for more information.

Meeting Environmental Requirements
X75HD/X75SD units are cooled by forced air drawn in from the front 
and exhausted through vents at the rear. There must be free passage for 
air flow at the front and back of each unit to allow for adequate 
ventilation. Take care to select a dry, well-ventilated location with a 
minimum of dust.
X75HD/X75SD units are designed for mounting in a standard 19-in. 
(48-cm) rack using front-mounting ears and rear support brackets, 
occupying a 1RU vertical space of 1.75 in. (4.4 cm). When installing an 
X75 in a rack, ensure that there is adequate space behind the mounting 
ears and clearance for the rear connecting cables. Allow about 10 inches 
(25 cm) of slack in the rear connecting cables for frame access and 
maintenance.

Caution
To ensure proper ventilation and 
to prevent overheating, keep the 
front panel closed.
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After unpacking the unit, and before installing into a console or rack, 
allow at least 30 minutes for temperatures to equalize and to eliminate 
any condensation that may have developed. The X75 requires an 
ambient temperature of between 41° to 113°F (5° to 45°C), with a 
relative humidity of 10-90% (non condensing). Proper operating 
temperatures can be maintained only when the front panel is properly 
installed.
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Installing Rack Support Brackets and Cable 
Relief Bar

Although the front-mounting ears provide the main support for the X75 
within a rack, you must install additional brackets and a cable relief bar 
at the rear of the unit to support the weight of cabling and frame 
stacking. The following procedure describes how to install an 
X75HD/X75SD unit in a standard 19-inch rack using the provided 
front-mounting ears, rack support brackets, and cable relief bar.
1. Locate two sets of rack support brackets in the packing box, along 

with the cable relief bar and the provided screws. 
Each support bracket comes in two pieces and requires assembly. 
The cable relief bar is a single piece. (See Figure 4-1.)

Figure 4-1. Rack Support Brackets

2. Attach the short rack support brackets to the sides of the 
X75HD/X75SD frame using the screws that are provided in the 
frame holes. (See Figure 4-2 on page 73.)

Short rack 
support brackets

Long rack 
support brackets

Cable 
relief bar

Caution
Do not use screws longer than 
those provided for the rear 
support brackets. Five 4-40 x
1/4-inch flat-head screws are 
provided for this purpose. 
Longer screws could cause 
internal damage.
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Figure 4-2. Location of Short Bracket Support Screw

3. Attach the cable relief bar between the long rack support brackets 
using the provided screws. 
You can secure the cable relief bar through any of the screw holes 
on the rack support bracket. (See Figure 4-3.)

Figure 4-3. Installed Cable Relief Bar

Installing short rack support bracket 
Remove this screw from the frame, place the 
short bracket over the hole, and then secure 
the bracket to the frame with the screw.

Secure the cable relief bar to the long rack support 
bracket through any of the bracket’s screw holes.

Inside view 
(between support 
brackets)

Outside view

Long rack 
support bracket

Cable relief bar
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4. Using the screws that are provided, attach the ends of the rack 
support brackets to the rear of the rack. 
Ensure that the holes on the rack support brackets face outward, 
away from the frame. (See Figure 4-4.)

Figure 4-4. Long Rack Support Bracket

5. Push the X75HD/X75SD into the front of the rack, ensuring that the 
rack support brackets slide into the slotted rack supports. 
(See Figure 4-5.)

Figure 4-5. Installed Long and Short Rack Support Brackets

6. Attach the frame’s front-mounting ears to the rack using the 
appropriate rack screws.

Long rack support bracket

Secure this end to the rack. 

Holes point away from the 
frame (for example, this 
bracket will support the right 
side of the frame, rear view).

Slide the frame onto the installed 
rack support brackets, ensuring 
that the long brackets slide into 
the short, slotted brackets 
attached to the frame.
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Making Cable and System Connections
Some connections to the X75HD/X75SD are provided via supplied 
breakout cable(s), while others are made directly to the frame via 
single-link cabling. Figure 4-6 identifies the various connectors on the 
X75HD/X75SD back panel:

Figure 4-6. X75HD/X75SD Back Panel 

When making cable connections, maintain approximately 10 in. 
(25 cm) of slack in the rear connecting cables (wrap or tie extra cable 
around the cable relief bar). This allows you to pull the frame out from 
the rack for servicing without needing to remove any cable connections.



76 X75HD/X75SD Installation and Operation Manual

 
Chapter 4: System Installation and Connections

Multi-Purpose Breakout Cable and Connections
The optional X75OPTCAB-MULTI breakout cable connects to the 
high-density DB-26M connector on the back of the unit labelled 
Multi I/O. Input connections include GPI 1 and GPI 2. The cable 
provides the following output connections: 
• S-video (Y/C)
• RGB (Blue, Green, Red)
• Aux Composite or Sync 
• GPI 1 and GPI 2 
• SDTV audio delay 
• HDTV audio delay. 
For pinout descriptions of this cable, see “Multi I/O Cable 
(X75OPTCAB-MULTI)” on page 203. 

S-Video (Y/C) Output
This four-pin mini-DIN connector on the Multi I/O breakout cable 
provides processed, synchronized/time base-corrected S-video (Y/C) 
output.

RGB (Blue, Green, Red) Video Output
These Red, Green, Blue, and Sync BNC connectors provide processed, 
synchronized/time base-corrected RGB(S) (RGB with auxiliary sync) 
video output. You can turn all three RGB channels’ sync signals on or 
off independently. If RGB without auxiliary sync is sufficient, reassign 
the Sync/Composite connection as an auxiliary composite output.

Synchronized Composite Output 
As described above, you can reassign the sync composite connection on 
the Multi I/O breakout cable. This capability is set by the Aux 
Sync/Comp option in the Video Setup menu.

GPI 1 and GPI 2 Input/Output
To use a GPI-based external controller as a trigger for internal functions 
of the X75HD/X75SD unit, use the two RCA-jack GPI inputs provided 
on the Multi I/O breakout cable. To configure the function triggered by 
each GPI input, navigate to System Config>Setup>GPI Input.
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To trigger external devices, use the two RCA-jack GPI outputs provided 
on the Multi I/O breakout cable. Configure the functionality of this 
output by navigating to System Config>Setup>GPO Output.

SD Audio Delay Output
This BNC connector provides the varying width TTL pulse that is 
directly proportional to input-to-output propagation delay of the 
selected SDTV signal path. Some external audio synchronizer devices 
can use this pulse signal to auto-synchronize the audio signal to the 
video.

HD Audio Delay Output
This BNC connector provides the varying width TTL pulse that is a 
direct output from the HDTV frame synchronizer output. The pulse 
width is directly proportional to the frame synchronizer's 
input-to-output propagation delay. Some external audio synchronizer 
devices can use this pulse signal to auto-synchronize the audio signal to 
the video.
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Video Connections
The following are direct single-link video connections (not via breakout 
cables) visible on the rear of the X75HD/X75SD.

Digital Video Input
This six-pin IEEE-1394 connector, labelled DV, is reserved for future 
use.

Serial Digital Input
These BNC connectors, labelled SDI In 1 and SDI In 2, accept serial 
digital ITU-R BT.601 video and embedded audio data at a rate of 
270 Mb/s. SDI In 1 has a relay bypass capability to SDI Out 1.

Serial Digital Outputs
These BNC connectors, labelled SDI Out 1 and SDI Out 2, provide the 
processed and synchronized serial digital ITU-R-BT.601 video and 
embedded audio at an output rate of 270 Mb/s.

HDTV Serial Digital Inputs
There are three HDTV video input connectors on the X75HD frame that 
allow for three possible input choices. Choose from HD-Fiber, 
HD In1, or HD In2.

HDTV Serial Digital Outputs
There are three available outputs on the X75HD frame: HD Fiber, 
HD Out1, and HD Out2. All three outputs will contain the same 
content.

Genlock Input
X75HD/X75SD models accept NTSC, PAL-B and Tri-Level Sync as 
the reference sources to provide the stable clock-to-output signals. The 
two Genlock BNC ports can be set either to Loop-Thru or Split 
operation. You can select any feed for the Tri-Level Sync, but in Split 
mode operation, you must select the port at which the signal is 
connected. To select the port, follow Reference Setup>GL Source 
Config. All other genlock parameters are accessible in the Reference 
Setup menu.
There are three genlock connection modes: Loop-thru, Split-525, and 
Split-625.
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• Loop-thru disconnects the internal terminations, connects the 
loop-through path and feeds the looped signal to the genlock 
subsystem

• Split-525 disconnects the loop-through path and connects the 
terminations to both ports (the genlock source becomes the 525 
Genlock BNC connector)

• Split-625 disconnects the loop-through path and connects the 
terminations to both ports (the genlock source becomes the 625 
Genlock BNC connector)

The genlock signal must be a stable, time base-corrected source, such as 
color bars or black burst. You can choose one of the following reference 
sources for the frame:
• External reference input (either color black or tri-level sync)
• Freerun (the internal clock generated by the X75HD/SD)
• Any video input, including SD-SDI 1, SD-SDI 2, HD, or Analog 

Video. 
When the input video is selected as the reference source, the unit 
runs in one clock system; therefore it is in the delay mode rather 
than the synchronization mode.

The GL Standard Set parameter selects the operational video standard 
mode for the genlock circuitry. You can manually force it to a specific 
standard to match the source being fed into the Genlock port, or set it to 
Auto to let X75 unit to automatically detect and configure its circuitry.
When a valid signal is connected to the genlock input, all video outputs 
from the X75HD/SD will be genlocked to this signal. When this occurs, 
the Genlock LED will be lit. When no external reference is supplied to 
the genlock input, the unit will operate using its own internal clock 
source.

Component Analog Video Outputs
These three BNC connectors, labeled B-Y, R-Y, and Y Out, are used to 
output the signals to analog component devices, such as Betacam 
VTRs.

Composite Video Output
This BNC connector, labeled Composite Out, provides processed, 
synchronized versions of any of the input signals.
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DVI Output
This connector, labelled DVI-Out, is a digital-only transmitter that 
provides up to 330 MHz bandwidth signal and supports 1080i/59.94, 
1080i/50, and 720p/59.94, and 720p/50 outputs. From this output, 
connect the optional X75OPTCAB-DVI DVI-D to DVI-D (digital, 
single-link) cable to your DVI monitor.

Composite Video Input
This BNC connector, labelled Cmpst In, is used to feed composite 
1 V pk-to-pk 75Ω video to the X75HD/X75SD. The input video signal 
must be direct color or monochrome (such as from a satellite feed or 
live camera).

S-Video Input
This four-pin mini-DIN connector, labelled S-Video, is used for 
S-video (Y/C) signals, such as from an S-VHS or Hi-8 device. The 
internal time base corrector automatically processes any signal received 
at this port.

Component Analog Video Inputs
These three BNC connectors, labeled Y In, R-Y In, and B-Y In, are 
used to input the signals from analog component devices, such as 
Betacam VTRs.
If component analog video input is not needed, the CAV-Y In 
connection can be reassigned as a second composite video input with 
the CAV-Y Composite option in the Video Setup/Analog Input/Proc 
menu (see “Chapter 8: Video Configuration” on page 143).
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Audio Connections
On X75HD/X75SD systems equipped with an HDTV audio option, up 
to eight stereo channels can be processed from any of the following 
inputs:
• 4 analog mono channels
• 2 or 5 x AES
• SDTV embedded (four groups, eight mono channels)
• HDTV embedded (four groups, sixteen mono channels)

DARS Inputs
The DARS input is available on the standard X75OPTCAB-8-C coax 
cable, optional X75OPTCAB-8-X XLR cable, or optional 
X75OPTCAB-8-CX combination BNC/XLR breakout cable. 
The DARS Bal/UnBal Sel parameter selects between the unbalanced 
(coax) and balanced (XLR) type of connection. Primarily, the DARS 
(Digital Audio Reference Signal) is used for the audio synchronization.

AES/EBU Inputs
The AES1 and AES2 inputs are available on the standard 
X75OPTCAB-8-C coax, optional X75OPTCAB-8-X XLR cable, or 
optional X75OPTCAB-8-CX combination BNC/XLR breakout cable. 
The AES3, AES4 and AES5 inputs are available only on the standard 
X75OPTCAB-16-C coax, optional X75OPTCAB-16-X XLR cable, or 
optional X75OPTCAB-16-CX combination BNC/XLR breakout cable. 
The AES# Bal/UnBal Sel parameters select between the unbalanced 
(coax) and balanced (XLR) type of connection. Only one input 
connection type is supported.

AES/EBU Outputs
The AES1 and AES2 outputs are available on the standard 
X75OPTCAB-8-C coax, optional X75OPTCAB-8-X XLR cable, or 
optional X75OPTCAB-8-CX combination BNC/XLR breakout cable. 
The AES3, AES4 and AES5 outputs are available only on the standard 
X75OPTCAB-16-C coax, optional X75OPTCAB-16-X XLR cable, or 
optional X75OPTCAB-16-CX combination BNC/XLR breakout cable. 
Both the unbalanced (coax) and balanced (XLR) AES audio signals are 
present at all time on both D-Sub connectors.
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Analog Audio Inputs and Outputs
Four channels (two stereo pairs) of analog audio inputs and outputs are 
supported. The analog audio input and analog audio output connectors 
are labelled In CH1 to In CH4, and Out CH1 to Out CH4, 
respectively. Each balanced analog audio input channel can be 
configured as 600Ω or high impedance.
Two analog audio receptacles (included with purchase of an 
X75OPT-AS-16 or X75OPT-AS-8 module) must be plugged into these 
connectors before configuration. See “X75OPT-AS-16 or 
X75OPT-AS-8-L Audio Limiters” on page 56 for more information.

Remote Control Ports
Supported remote control methods include the following: 
• 10Base-T or 100/Base-T Ethernet (used for control through a 

TCP/IP-based network) using a CCS™ (Command and Control 
System) application such as Pilot or Navigator, or using a controller 
such as the X75-RCP remote control panel or an X75HD/X75SD 
local control panel

• Web browser program such as Internet Explorer™ or Netscape™
• SNMP (Simple Network Management Protocol) and third-party 

control software through Leitch CCS Protocol 
• GPI (General Purpose Interface) input/output used for remote 

triggering of functions such as Freeze or triggering of external 
devices

Ethernet Ports
The 10/100Base-T Ethernet connector, labelled Ctrl/Strm, connects 
X75HD/X75SD models to a TCP/IP-based network for remote control 
and status monitoring. Web-browsing software, an X75-RCP remote 
control panel, or a frame-mounted local control panel then control the 
unit. See “Configuring for HTTP Control via Web Browser” on 
page 98 for details about controlling the unit from your Web browser.
When using Ethernet, you must configure the IP Address, Subnet Mask, 
and Default Gateway settings of the unit for your network; your 
network administrator can provide you with these settings. The network 
settings are located in the System Config>Setup menu. When all the 
changes are made, the Save IP function must be performed to actually 
save the changes in non-volatile memory.
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A second port, labelled Streaming, is activated when the optional 
X75OPT-STR module is installed. For more details, see “X75OPT-STR 
Module and Back Panel” on page 65.
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Chapter 5

Initial Configuration

Overview
This chapter describes the various configurations and settings that are 
required before you begin operating the X75HD/X75SD. Although you 
can modify all parameters and settings at any point during operation, 
there are certain control options and configurations that you need to set 
first, including those listed below:
• “Initial Power-Up and Control Steps” on page 86
• “Configuring Network Settings” on page 88
• “Remotely Controlling X75HD/X75SD Systems” on page 95
• “Processing Modes” on page 101
• “Configuring Video” on page 105
• “Configuring Audio” on page 107

Unless otherwise specified, instructions in this chapter are provided for 
making changes via a local or remote control panel.
For more details on using local and remote control panels, see the 
Control Panels for X75 Systems Installation and Operation Manual.
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Initial Power-Up and Control Steps
1. If you have an X75OPT-AS-8/16 audio option card, ensure all 

jumper settings have been made.
See “X75OPT-AS-16/X75OPT-AS-8 Modules and Back Panels” 
on page 52 for details about the jumper settings.
The X75OPT-AS-8/16 audio module is shipped with the following 
jumper settings: 100 kΩ for input impedance, and 66Ω for output 
impedance. If 600Ω impedance is required, all input and output 
jumpers should be placed on pins 1 and 2.

2. Install the X75HD/X75SD in a rack and make the required system 
connections (see the instructions beginning on page 72).

3. Plug the unit into a grounded electrical source.
The unit is factory configured with default settings, including the 
following network settings:
• IP address: 192.168.100.250
• Subnet mask: 255.255.255.0
• Gateway: 192.168.100.250
• Machine name: Leitch X75
(Upon request, Leitch can preconfigure X75HD/X75SD systems 
with specific IP addresses and network settings. Please contact your 
Leitch customer service representative for more details.)

4. Using a frame-mounted local control panel, configure the network 
settings for each system by assigning a unique IP address to each 
unit, configuring the subnet mask to be the same for all units on a 
shared network, and changing the gateway if required (see 
“Configuring Network Settings” on page 88 for details).

5. If you are controlling the unit remotely via remote control panel, 
make the required Ethernet connections (see “Remotely Controlling 
X75HD/X75SD Systems” on page 95 for details).

6. If you are controlling the unit via a third-party Web browser, launch 
the Web browser (see “Configuring for HTTP Control 
via Web Browser” on page 98 for details).

7. If you are controlling the unit via a third-party SNMP browser, 
make the appropriate connections and download/configure the 
appropriate MIB and SNMP agent files (see “Configuring SNMP 
Support” on page 311 for details).

Note
The current system IP address 
and network settings can be 
viewed on a local or remote 
panel VFD screen. If you do not 
have access to a control panel, 
and cannot remember the set IP 
address of your system, see 
“Forgotten IP address” on 
page 222 for more information.
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8. Configure your video (and audio) input settings prior to operation 
(see “Configuring Video” on page 105 and “Configuring Audio” on 
page 107 for details).
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Configuring Network Settings
When shipped, the X75HD/X75SD is configured with a default IP 
address, subnet mask, and default gateway. If you intend to control the 
unit remotely, or connect it to a network hub/switch along with other 
X75HD/X75SD units, you will need to reconfigure the IP with unique 
network settings. Local control (with a direct Ethernet crossover 
connection to a PC) does not require any IP configuration.

Supported Network Protocols
The X75HD/X75SD supports the following network protocols for 
remote/network control: 
• Leitch CCS Protocol (for example, using an X75-RCP remote 

control panel).
See “Remotely Controlling X75HD/X75SD Systems” on page 95 
for details.

• HTTP (for example, using a Microsoft Internet Explorer 6.0).
See “Configuring for HTTP Control via Web Browser” on page 98 
for details.

• SNMP (for example, using NuDesign Visual MIBrowser Pro 3.1). 
See “Configuring SNMP Support” on page 311 for details.

Making Required Hardware Connections
If you are connecting an X75HD/X75SD directly to a PC (no network 
connection), connect one end of a crossover Ethernet cable to the 
Ctrl/Strm RJ-45 port on the back of the X75HD/X75SD, and the other 
end to the PC Ethernet port. 
If you are establishing a network connection, connect a straight-through 
10/100Base-T Ethernet cable between the X75HD Ctrl/Strm port and 
the network hub/switch.
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Setting IP and Subnet Mask Addresses
To allow devices to communicate on a network, you need to set all 
devices to the same subnet (network location). When shipped, 
X75HD/X75SD units are configured with the same default IP (device 
identifier) and subnet addresses. These addresses need to be changed so 
that each unit is uniquely identified and the network location of all units 
is accurately reflected.
An IP address is made up of a four-item set of numbers (octet). The 
default (factory-configured) IP address for every X75HD/X75SD unit 
is 192.168.100.250. For a class C network, you must change the first 
three items in the octet to identify the location (address) of the unit on 
your network, and also change the last item in the octet to uniquely 
identify the device from other X75HD/X75SD units.
The default subnet mask address for every X75HD/X75SD is 
255.255.255.0.

Setting the IP Address of a Single Unit with LCP or RCP
Follow these steps to configure the network addresses using a local or 
remote control panel:
1. Apply power to the RCP or the LCP-enabled X75HD/X75SD unit. 

When ready for configuration, the X75HD/X75SD main menu 
shows on the display screen.

2. Follow this path: System Config>Setup (in the RCP, select Device 
Setup).

3. Scroll to the Device IP parameter, and then press Enter.
If this is a new unit being configured, the default IP displays. 
Otherwise, the current IP address of the unit displays.

4. Change the IP address by following these steps:
a. Press Enter to navigate to one of the four number sets in the 

octet.
b. Modify the address value by using the scroll knob to set a new 

number.
c. Press Enter to move to the next item in the octet, and then 

repeat step (b) above.
d. Press Exit when you are finished configuring the address.
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5. Scroll to the Subnet Mask parameter, and then press Enter. 
If this is a new unit being configured, the default subnet mask 
displays. Otherwise, the current subnet displays.

6. Repeat the procedure described in step 4, this time for the subnet 
mask.

7. Scroll to the Gateway parameter, and then press Enter. 
If this is a new unit being configured, the default gateway displays. 
Otherwise, the current gateway address displays.

8. Repeat the procedure described in step 4, this time for the gateway 
parameter.

9. Select Save IP, and then press Enter.
10. Select Yes option and then press Enter.
11. Press Exit to return to the Setup menu.
12. Navigate to the Setup menu, select Reboot, and then press Enter.

To restart an X75HD/SD unit with a blank front panel, unplug it 
and then reapply power.

Setting the IP Addresses of Multiple Units
If you have multiple X75HD/X75SD systems that require network 
configuration, you will need to set unique IP addresses and assign a 
subnet mask and gateway address for each of them one at a time. The 
following procedure summarizes the required steps:
1. Apply power to the first X75HD/X75SD unit with a frame-mounted 

local control panel. 
When ready for configuration, the main X75HD/X75SD menu 
shows on the display screen.

2. Configure the network settings for this unit, as described in the 
procedure on page 89. 

3. Restart the X75HD/X75SD unit.
4. Plug in the next X75HD/X75SD system, configure its network 

information, and then restart the unit.
Follow this procedure for all remaining X75HD/X75SD units that 
require configuration.

5. If you will be using a remote panel, configure the RCP’s network 
settings in the same way as you would for an X75HD system (see 
page 95).
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6. Connect all X75HD/X75SD systems and remote panels to a 
network hub or switch using a 10/100Base-T Ethernet cable.

7. Ensure that all configured X75HD/X75SD units are detected on the 
network. 
To do this, press Remote on the front panel of either an RCP or a 
frame-mounted local control panel. All units configured with the 
same subnet mask address will display (you will see a list of all 
detected IP addresses). 
If a unit or RCP is not detected, ensure that the subnet mask address 
is accurate. Alternatively, confirm that all units were restarted after 
configuring any network settings.

Note
If configured to be on the same 
network, the following items 
will be detected: 
X75HD/X75SD systems, 
X75-RCP panels, and any 
DPS-575 systems.
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Changing the PC Network Settings
In unusual situations, such as correcting a failed software upgrade, you 
may need to change your PC network settings. Follow these steps to 
change the settings:
1. Change the IP Address of the PC to match that of the 

X75HD/X75SD, by following theses steps:
a. Click Start>Settings and then click Control Panel. 

This opens the Control Panel window.
b. Double-click Network and Dial-up Connections, and then 

double-click Local Area Connection.
c. Click the General tab, and then click Properties.

This opens a new Local Area Connection Properties window.
d. On the General tab, select Internet Protocol (TCP/IP), and 

then click Properties..., ensuring you are working on the 
correct Ethernet adapter for the CCS network.
The IP Address of the Internet Protocol TCP/IP Properties 
box appears.
Figure 5-1 shows the portion of the Internet Protocol TCP/IP 
Properties box where you enter the IP Address, Subnet Mask, 
and Default Gateway of your PC.

Figure 5-1. Portion of IP Address Box

e. Note whether Obtain an IP address automatically is selected.
You may need to re-select this option later when you revert 
back to the original PC IP Address.

Note
You will probably require 
administrator privileges on your 
PC to change the IP Address
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f. Select Use the following IP address, and in the IP address 
box, type a new computer IP Address to match the first three 
octets of the IP Address of the X75HD/X75SD, and then add a 
different fourth octet. 
(For example, if the X75’s IP Address is 192.168.100.50, you 
could type 192.168.100.181).

g. In the Subnet Mask field, type: 255.255.255.0
This value applies to Class C IP addresses; confirm the number 
with your network administrator.

h. Enter the same Default Gateway number as the one on the 
X75HD/X75SD, or leave blank.

i. Click OK to close the TCP/IP Properties box, and then close 
the two Local Area Connection boxes.

2. Verify the network settings were accepted by following the ipconfig 
procedure, as described below:
a. Click Start, point to Programs>Accessories and then click 

Command Prompt to open the Command Prompt window 
on the PC.

b. Type the following at the MS-DOS command prompt, and then 
press ENTER:
ipconfig

The IP Address, Subnet Mask, and Default Gateway of the PC 
appear. (In some situations, the Default Gateway value is not 
shown. See Figure 5-2.)

Figure 5-2. IP Address, Subnet Mask and Default 
Gateway of PC
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c. Write down the IP Address, Subnet Mask, and Default Gateway 
numbers of your PC.

d. Compare the network numbers of the X75HD/X75SD, with the 
numbers found in step 2c.
In general, the two Subnet Mask and Default Gateway numbers 
should be identical. The first three octets of the two IP 
Addresses also are generally identical. For example, if the 
X75HD/X75SD has an IP Address of 192.168.248.50, the PC 
could have an IP Address of 192.168.248.181.

3. If the network settings match, click Close.

Note
Where more than one network is 
involved and the Point-to-Point 
option has been selected (see 
CCS PIlot/Navigator online 
help), the network address 
values may be entirely different. 
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Remotely Controlling X75HD/X75SD Systems
This section provides the following general configuration procedures:
• “Preparing for Remote Control via Control Panel” (below)
• “Selecting a Remote Unit to Control” on page 96
See your Control Panels for X75 Systems Installation and Operation 
Manual for more information about using an X75-RCP remote control 
panel.

Preparing for Remote Control via Control Panel
Control panels remotely control X75HD/X75SD units via broadcast. 
Switchers and routers in the network need to be configured accordingly. 
Follow these steps to prepare your X75HD/X75SD models for remote 
control:
1. Using an LCP, reconfigure each X75HD/X75SD and X75-RCP unit 

with unique IP addresses and other appropriate network settings, 
including shared subnet mask addresses. 
See “Setting IP and Subnet Mask Addresses” on page 89 for details.

2. Restart each X75HD/X75SD and X75-RCP unit, and then wait 20 
seconds to allow for network detection.

3. Connect all X75HD/X75SD systems and remote panels to a 
TCP/IP-based network hub or switch using 10/100Base-T Ethernet 
cable. 
On X75-RCP units, use the Control connector; on X75HD/X75SD 
units with frame-mounted local control panels, use the Ctrl/Strm 
port at the back of the X75HD/X75SD unit.

4. Discover all units found on the network, and then select the one you 
wish to control. See “Selecting a Remote Unit to Control” on 
page 96 below for details.

Note
A frame-mounted local control 
panel can also remotely control 
other networked 
X75HD/X75SD units. 
Procedures described in this 
section also apply to local panel 
control. See “Using a 
Frame-Mounted Local Control 
Panel for Remote Operation” on 
page 97 for more information.
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Selecting a Remote Unit to Control
You can remotely control all X75HD/X75SD systems that share the 
same subnet, using an X75-RCP panel or a frame-mounted local control 
panel. Both examples of remote control are described in the sections 
that follow. 

Using an X75-RCP for Remote Operation
Follow these steps to select and control a detected X75HD/X75SD over 
the network:
1. Ensure all connections and network settings have been made.
2. On the X75-RCP, press the Remote button to bring up a list of 

available units for control (see Figure 5-3).

Figure 5-3. List of Systems Available for Remote Control

The <local device> option shown on-screen represents the unit you 
are using (the local unit that is in front of you), and is always 
available on this list. An asterisk (*) beside the name indicates that 
this is the remote system currently being controlled by the panel.

3. Use the control knob to scroll through the list of available 
X75HD/X75SD devices, highlight the unit you wish to control, and 
then press Enter.
The X75-RCP screen reads Connecting...

Note
If the network settings are not 
configured properly (either on 
the RCP or individual 
X75HD/X75SD units), the units 
may not be detected. Confirm 
all network settings, if required.

Note
Instead of IP addresses, you can 
give alphabetical names to 
individual X75HD/X75SD units 
that will appear in the list To 
create an alphabetical name for 
an X75 unit (for example, 
Studio_B), follow this path: 
System Config>Setup> 
Machine Name. Use the scroll 
knob and the Enter button to 
create the name. When you have 
reached the end of the name, 
press Enter.

*
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4. Wait a few moments.
The menu of the selected X75HD/X75SD unit appears along with 
all of that unit’s settings. 

5. Operate the selected unit as required. 
Once a unit is selected for remote control, all front panel features 
operate as if you were actually at the front panel of the selected 
remote unit. This means that the VFD panel, status indicators, and 
buttons (with the exception of the Remote and Option button) all 
control and/or reflect the status of the remote unit, not the one you 
are physically operating.

6. To switch to another unit, or to control the local device you are 
physically operating, click Remote, and then select a new device to 
control. 

7. Select <local device> to resume normal single-unit operation.

Using a Frame-Mounted Local Control Panel for Remote Operation
After ensuring that all connections and network settings have been 
made, you can also remotely control X75HD/X75SD units that are on 
the network using a frame-mounted local control panel. To do this, click 
Remote on the LCP to enter Remote mode, and to view the list of 
X75HD/X75SD units available for control on the same subnet. The 
procedure remains the same for selecting and operating devices 
remotely via the LCP, as it does for the X75-RCP. 

Note
The light on the Remote button 
flashes while the unit is 
remotely controlling a device.



98 X75HD/X75SD Installation and Operation Manual

 
Chapter 5: Initial Configuration

Configuring for HTTP Control via Web Browser
Once the networking parameters of the X75HD/X75SD have been 
configured appropriately, and it is connected to the Ethernet network, 
the built-in Web server allows a standard Web browser to control the 
X75HD/X75SD unit. Before controlling your unit in this way, note the 
following system and browser requirements:
• The X75HD/X75SD supports Web browsers that are compatible 

with HTML 4.0 (and later).
• Although most standard Web browsers can be used with the 

X75HD/X75SD for HTTP control, the following browsers have 
been tested and approved by Leitch: Microsoft® Internet 
Explorer 6.0, Netscape® Navigator™ 7.2, and Mozilla® Firefox™ 
1.0.

Procedure
To select a unit for control, follow these steps:
1. Ensure all required connections and network settings have been 

made locally on your X75HD/X75SD unit(s).
2. Open a supported Web browser, and then type the IP address of the 

unit you wish to control into the Address, Location, or URL field 
of your Web browser (the name of the field depends on the Web 
browser you are using). For example, type the following to control 
an X75HD/X75SD unit with this IP address:

http://192.168.100.250

The Web browser then displays the Home page of the 
X75HD/X75SD Control interface (Web server).

See “Chapter 7: Web Server Software Control” on page 129 for more 
information.

Note
Web browser control is only 
available for X75HD/X75SD 
units, and not for X75-RCP 
panels.
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Configuring for CCS Software Control
The Windows-based CCS software applications, such as Pilot and 
Navigator, provide control of the X75HD/X75SD via a Windows-based 
PC and enables you to accomplish these tasks:
• Discover remote CCS devices dynamically on your CCS network 

without knowing their IP addresses
• Build custom hierarchical views of the distributed network for each 

network user, using icons, colored text, and other visual 
information

• Design, model, and test your CCS system
• Set up user accounts and groups with different access rights to CCS 

devices and their control parameters
• Centrally navigate, control, and monitor CCS devices over a local- 

or wide-area network
• Set alarms to signal visual, auditory, or e-mail alerts when CCS 

devices go off-line or malfunction
• Transfer software upgrades to CCS devices
• Diagnose and correct problems with the CCS network or devices
• Monitor the integrity of video signals throughout a facility



100 X75HD/X75SD Installation and Operation Manual

 
Chapter 5: Initial Configuration

Figure 5-4. Network Configuration Diagram

Configuring for SNMP and Third-Party Software Control 
SNMP is an industry-standard protocol that allows other (non-Leitch) 
control software to remotely monitor and control X75HD/X75SD units. 
Leitch provides a MIB file that you can download off the Leitch Web 
site for this purpose. The file defines the parameters of the 
X75HD/X75SD, and is required for third-party software control.
See “Configuring SNMP Support” on page 311 for details.

Remote PC-based software control and monitoring options

SNMP Web browser Third-party
control software

HP
OpenviewTM

Netscape
Navigator/

 Microsoft
Internet Explorer

Leitch CCS
Protocol

CCS Pilot/
Navigator

CCS application

X75HD/X75SD multiple path converter/synchronizer

3rd party hub or switch

Remote control hardware panel
X75-RCP

Existing Leitch product
DPS-575
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Processing Modes

General Information
Video M-Path configuration is performed on the following groups of 
video outputs:
• Analog (includes five analog output types: composite, CAV 

(Y, B-Y, R-Y), S-video, RGB, Aux-composite)
• HD (with various options, such as HD 1, HD 2, HD-Fiber, and 

DVI/HD)
• SD-SDI 1
• SD-SDI 2
• StrV (streaming video
These output groupings are used for configuration purposes. You can 
individually set each of these output groups to accept a specific input 
source. In addition, there are four special routable blocks in the SDTV 
video configuration path that may be included in the input path for any 
input signal.
Alternatively, you can use the AllOutSelect parameter to select an input 
source for all output groups simultaneously. Table 5-1 summarizes the 
video output groups and available input sources.

Note
If you are missing certain option 
modules, the corresponding 
outputs will not be available.

Table 5-1. Video Output Groups and Available Video Input 
Sources

Output 
Groups

Physical Outputs 
Forming Part of this 
Output Group

Input Source to 
Assign to Each 
Output Group

• Analog
• HD
• SD 1
• SD 2
• StrV

• Composite, CAV, S-Video, 
Aux, RGB

• HD 1, HD 2, HD Fiber, 
DVI

• SDI 1
• SDI 2 
• Streaming 

and future-use DV

• Composite
• S-Video
• CAV
• SD 1
• SD 2
• DV (future use)
• HD Fiber
• HD 1
• HD 2



102 X75HD/X75SD Installation and Operation Manual

 
Chapter 5: Initial Configuration

Input Video Modes
The Input Video Mode for manual configuration is M-Path (User). In 
this mode you assign input sources to each output group. However, if 
you set the Input Video Mode to Auto Detect, the X75HD/X75SD 
system will automatically detect the incoming input signal(s) and then 
send it to all output groups.

In the default Auto Detect mode, the X75HD/X75SD senses the 
presence of valid input signals, and then processes them to all outputs. 
This mode is a useful redundancy feature: If one input signal 
disappears, the X75HD/X75SD will automatically switch to 
AllOutSelect control, and will process whatever input is detected and 
send it to all outputs. If the X75HD/X75SD detects more than one valid 
input, it will refer to the precedence order set by you in the Auto Detect 
Setup submenu, or it will apply the default priority order.
A third input video mode is Simulcast Enable. In this mode you can 
assign two different input sources to selected output groups for the 
purpose of switching between the sources. In most instances, you would 
use a GPI control to switch between the selected input sources at the 
required time. When you change an input source, the AllOutSelect 
control also changes the output mappings accordingly.

Note
If you make manual changes to 
the input/output paths, Auto 
Detect mode will automatically 
revert to M-Path (User) mode.

Note
Precedence levels that can be 
assigned include Highest, High, 
Normal, Low, and Lowest. 
(For example, if the 
X75HD/X75SD unit detects two 
input signals, it will accept an 
HD signal tagged Higher over 
an SD-SDI signal that is tagged 
Normal.) See “Selecting a 
Video Source” on page 105 for 
more information.
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Configuration Exceptions and Further Information
There are a few exceptions to the input source/output group mapping 
process described in the previous sections, including the following:
• “Mutually Exclusive Inputs”
• “AllOutSelect Limitations”
• “SD-ARC Limitation”
• “Strobe or Film Mode and Closed Captioning”

Mutually Exclusive Inputs
Several input settings are mutually exclusive. For example, the back of 
the X75HD/X75SD allows for up to three HD input sources; however, 
only one of these input sources can be accepted at a time. In this 
example, all output groups must be set to the same HD input type, not to 
three different input types. If you attempt to map different HD inputs to 
various output groups, only the last setting you make will apply. 
Previous HD input mappings will change to reflect the last setting.
This scenario of mutually exclusive HD inputs also applies to the 
following input types: 
• SDI 2 and future-use DV
• Analog (Composite, CAV, and S-video)
These groupings are not independent inputs. Only one input type in 
each of these groups can be selected for each output group.

AllOutSelect Limitations
The AllOutSelect control lists all available input sources. But in cases 
where you have manually assigned different input sources to various 
output groups, AllOutSelect will not able to reflect a single input type. 
Instead, M-Path control becomes selected.
As soon as you manually configure any of the M-Path menu output 
groups, AllOutSelect control will change over to the M-Path control. 
Note that if you change AllOutSelect to a single input type, and you 
return to AllOutSelect control, all manual changes done previously 
during M-Path configuration will be overridden.
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SD-ARC Limitation
When SD-ARC selects one of the standard definition inputs, it uses the 
data path from the main board to the HD board for SD aspect ratio 
conversion. The same data path is also used for the up-conversion. Due 
to this limitation, when the HD-output selects any one of the standard 
definition inputs, the software also changes the SD-ARC source 
selection.

Strobe or Film Mode and Closed Captioning
The SDTV Strobe or Film mode does not support the passing of the 
closed captioning data to the outputs, as this process does not guarantee 
the continuation of the metadata.
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Configuring Video

Selecting a Video Source 
X75HD/X75SD units are shipped with Auto Detect video mode as the 
factory default setting. This mode sets the X75HD/X75SD to 
automatically detect composite, S-video, CAV, SD-SDI 1, SD-SDI 2, 
future-use DV, HD-SDI Fiber, HD-SDI 1, and/or HD-SDI 2 inputs. 
When video is connected to any of these inputs, the X75HD/X75SD 
automatically selects the applied input video and then sends out the 
converted video to all outputs. The Video Input LEDs on the front 
panel show the selected video source. For information on certain 
exceptions and limitations applied to video source selection, see 
“Mutually Exclusive Inputs” on page 103.
For analog video sources, only a single video source can be 
automatically detected. Therefore, you must pre-select the desired 
analog input video source first in order for auto-detection to work 
across the HD-SDI/SD-SDI/analog inputs.
To change the input signal type, follow these steps:
1. Press Video In on the control panel, or navigate to the Video 

Setup>Routing Setup menu and then select AllOutSelect). 
All available inputs will display on the control panel screen. 

2. Using the control panel knob, scroll through the list of input types, 
and then press to Enter to select one.

When multiple video sources are connected, the Auto Detect Setup 
menu determines the selection of the input video. For example, if the 
X75HD/X75SD unit detects two input signals, it will accept the signal 
tagged as Higher over another lower-precedence signal. Found in the 
top-level Video Setup>Routing Setup menu, precedence levels 
include Highest, High, Normal, Low, and Lowest. When multiple 
input types are present and assigned the same precedence level, the 
X75HD/X75SD uses the following default ordering:
1. Analog video input
2. SD-SDI 1 input
3. SD-SDI 2/DV input
4. HD-SDI 1/HD-SDI Fiber input
5. HD-SDI 2 input

Note
If you press the Video In button 
and then manually select a video 
source, the X75HD/X75SD unit 
reverts to User-Select mode. 
Video modes are found under 
Routing Setup>Input Video 
Mode.
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Using the Video Switch Delay parameter in the Video Setup>Routing 
Setup>Auto Detect Setup menu, you can enter the delay value in 
seconds to prevent inadvertent switching of the input video sources. 
Figure 5-5 graphically illustrates a single-source signal process, where 
one selected video input is fed to all outputs.

Figure 5-5. Single Source Processing

Adjusting Video Levels
Various control panel buttons provide quick access to the video 
processing parameters of a selected video source. Simply press a button 
and use the control knob to change the selection. For more information 
on configuring video, see “Video Configuration” on page 143.
For more information on using a local or remote control panel, see 
“Chapter 6: Operation via Front Panel Controls” on page 115 or refer to 
the Control Panels for X75 Systems Installation and Operation Manual.
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Configuring Audio
This section briefly describes how to select a single audio source and 
how to quickly adjust audio levels. For more information about audio 
configuration, see “Audio Configuration” on page 151.
For more information on using a local or remote control panel, see 
“Operation via Front Panel Controls” on page 115 or refer to the 
Control Panels for X75 Systems Installation and Operation Manual.

Selecting an Audio Source
Directly press the Audio In button to select any one set of audio inputs 
to be sent out to all audio multiple output sets. The LEDs to the top, 
right side of this button indicate which input is currently selected.

Adjusting Audio Levels
When a single audio source is selected and sent to all outputs, press the 
Ctrl and A. Proc buttons to quickly access the audio level controls of 
the selected audio input.
The selected audio input channels’ gain controls are mapped to the 
numbered buttons on the control panel accordingly. The mapped 
buttons will illuminate during audio proc control. The Audio Proc 
LEDs on the lower, right corner of the front panel indicate which 
processing block is currently selected.

Tracking and Delaying Audio
Each audio sample rate converter (SRC) can be configured to 
automatically track the processing delay of one of the video outputs. To 
apply the internal audio tracking feature, follow this path: Audio 
Setup>Global Audio Config>I/O Delay Config. Select one of the four 
or eight I/O Delay SRCs, and then select the accompanying video 
signal to track with that audio SRC.
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Configuring the GPI
The GPI inputs are internally pulled HIGH. External contact closure to 
ground will trigger the assigned function set by the user. 
In the System Config>Setup menu, the two GPI-1 Function and 
GPI-2 Function parameters allow the selection of pre-defined or user 
assigned GPI functions:
• Disabled—No action will be taken
• Freeze—Will freeze all the internal frame synchronizers memory
• Simulcast A/B—Switches between simulcast video source A and 

video source B
• Voice-Over—Ramps down the program audio channels and mixes 

the voice-over channel to the program audio outputs. 
• Fav1— Activates the GPI set parameter in the Favorite list 1.
• Fav2—Activates the GPI set parameter in the Favorite list 2.
For instructions on how to add a parameter and assign it as a GPI input 
in a Favorites list, see “Using the FAV1 and FAV2 Function” on 
page 176.
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Configuring an X75OPT-A3D-1 Module
The X75OPT-A3D-1 module is similar to the X75OPT-A3D, but uses 
an alternate color decoder algorithm. Typically, these modules are 
factory installed. However, if you add a new X75OPT-A3D-1 to an 
existing X75HD/X75SD unit, or if the module is moved from one X75 
unit to another, the module must be reconfigured.
Follow these steps to configure the X75OPT-A3D-1 module:
1. Turn the X75 power on while simultaneously holding the SHIFT + 

CTRL buttons.
2. When the Leitch logo appears on the display screen, release the 

buttons.
The factory calibration mode is now enabled.

3. Follow this parameter path: System Config>Calibration>Analog 
Input (A3D)>Ext Notch Filter>Enable.

4. Press the Exit button twice. 
5. Select Save Cal, and then select Yes.

The X75OPT-A3D-1 module is now functional. To make the 
version change visible in the Status/Version Info menu, you must 
first reboot the X75HD/X75SD unit.

Note
The X75OPT-A3D-1 module 
requires version 1.4 or higher 
software installed on the 
X75HD/X75SD unit.
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Launching QuickTime Player for Streaming Video
Using the X75OPT-STR streaming option, you can play streaming 
video in a Graphical Navigation window of CCS Navigator.
You can also view the streaming video separately, without CCS 
Navigator. In either case, you must have QuickTime Player version 7.0 
or later installed on your PC. See page 65 for more information.

CCS Navigator Streaming Installation
To add a button to launch streaming video using CCS Navigator, follow 
these steps: 
1. With Navigator in Build mode, place a button on a Graphical 

Navigator page. 
For information on creating buttons, see your CCS Pilot/Navigator 
manual or online help.

2. Right-click on the button and then select Properties... from the 
menu that appears.
The Object Properties dialog box opens. 

3. Select the Rules tab, and then click the New Rule button. 
A new line appears in the Rules table. 

4. In the new rule’s Event list, select OnMouseClick.
The default Condition setting for this event is Always; you can 
leave that as it is, or you can change it by clicking the Condition 
button. See “Defining Conditions” in your CCS Pilot/Navigator 
manual or online help for information on completing the Condition 
dialog box. 

5. From the new rule’s Action list, select Launch Application. 
6. Click the Action Properties button. 

The Action Property dialog box opens. 
7. Enter the following information in the Action Property dialog box:

• Command: c:\program files\quicktime\quicktimeplayer.exe
• Arguments: rtsp://172.25.101.101:554/x75streaming
• Initial Directory: leave field blank 
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8. Click OK to close the Action Properties dialog box, and then close 
the Object Properties window.
When you enter Control mode, the new button will open a 
QuickTime Player and play streaming video from the 
X75HD/X75SD. 
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Section II—Operation
This section contains the following topics:
• “Operation via Front Panel Controls” on page 115
• “Web Server Software Control” on page 129
• “Video Configuration” on page 143
• “Audio Configuration” on page 151
• “Special Function Buttons” on page 163
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Operation via Front Panel Controls

Overview
This chapter describes the main areas of the front panel, and provides 
the following general descriptions:
• “Front Panel Description” on page 116
• “Using the Control Knob and Menu Control Buttons” on page 117
• “Getting Visual Feedback: Status and Alarm LEDs” on page 122
• “Video Input LEDs” on page 126
• “Audio Input LEDs” on page 126
• “Control Mode Status LEDs” on page 127

This chapter does not give specific descriptions about available menus, 
submenus, parameters, or options. See the X75HD Control Options 
html file available from the Leitch Web site at www.leitch.com or on 
the accompanying X75HD/X75SD CD. 
Detailed information on using front panel controls can be found in the 
Control Panels for X75 Systems Installation and Operation Manual. 
Some limited control information (such as information on video and 
audio proc amp status LEDs, and audio proc amp channel mappings) 
can be found in the following chapters:
• “Video Configuration” on page 143
• “Audio Configuration” on page 151
• “Special Function Buttons” on page 163

http://www.leitch.com
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Front Panel Description
The front panel (Figure 6-1) is divided into several areas for control and 
monitoring, including the following:
• VFD screen for viewing menu options, selections, feedback, and 

device information
Changes to the display intensity and screen saver functionality can 
be made within the Setup submenu (press the Option button) in 
order to prolong the life of the VFD

• Control knob and buttons for scrolling, selecting, and setting menu 
options
The push and turn shaft encoder (knob) is used for menu navigation 
and selection, and for coarse and fine parameter adjustment; the 
knob direction can be changed to your preference from within the 
Setup submenu (press the Option button)

• Programmable and device-dedicated control buttons
• Status and alarm LEDs for monitoring the current mode and 

operating conditions of the unit
Information about each of these areas is available in this chapter.

Figure 6-1. X75HD/X75SD Front Panel
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Using the Control Knob 
and Menu Control Buttons

All menus and device settings for the X75HD/X75SD can be selected 
and configured by using the control knob and menu control buttons. 
Figure 6-2 shows the location of the control knob and various menu 
control buttons on the device. Use these items to open and navigate 
menus, scroll through and select options, and adjust various parameters 
and settings.

Figure 6-2. Control Knob and Menu Control Area

Setting the Direction of the Control Knob
If desired, you can change the direction of the control knob. To do this, 
press the Option button, open the Setup menu, and then select the 
Shaft Direction parameter. 
Set the direction of the knob to either Clockwise = Up or 
Clockwise = Down. 
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Using Multi-Function Buttons
Many of the buttons on the X75HD/X75SD control panel are 
multi-functional, and can have up to three functions assigned to them. 
To select a certain function from a multi-function button, perform one 
of the following steps:
• Press the desired multi-function button. The assigned default 

function is written in black text on the button face, either near the 
top or in the middle of the button.

• Press Shift and the desired multi-function button simultaneously. 
The assigned function is written in red text on the button face near 
the top of the button.

• Press Ctrl and the desired multi-function button simultaneously. 
The assigned function is written in blue text on the button face near 
the bottom of the button.

For more information on front panel buttons, see the Control Panels for 
X75 Systems Installation and Operation Manual.

Navigating Through the Menus
There are eight main menu items available. Each of them open up into 
several layers of submenus and parameter options that you can scroll 
through and edit as required. Table 6-1 briefly describes each of the 
eight main menu items.

Table 6-1. Main Menu Items 

Menu Name Menu Description
Video Setup Configures and controls the video settings

Audio Setup Configures and controls the unit’s audio settings

Reference Setup Configures and controls the genlock and other 
reference settings

System Config Configures settings of the initial setup parameters

Global Frame Rate Sets the unit’s frame rate per second

SD Operating Standard Provides a read-only view of the selected or 
detected SD-SDI operating standard 

HD Output Standard Provides a read-only view of the selected HD-SDI 
operating standard
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Procedure
To navigate through the menus of an active X75HD/X75SD system, 
follow these steps:
1. With the X75HD/X75SD Main menu displayed, rotate the control 

knob to scroll through the menu items.
2. Press Enter to open a selected submenu.
3. Scroll through the options and parameters using the control knob, 

and then press Enter to make a selection.
See “Changing Parameters” on page 120 for more information.

4. Press Exit to go back a step in the menu structure.



120 X75HD/X75SD Installation and Operation Manual

 
Chapter 6: Operation via Front Panel Controls

Changing Parameters
Once you have selected an option from a particular menu or submenu, 
use the control knob on the front panel to set the new value for the 
parameter by following the methods described below.
Alternatively, you can use the X75-RCP to remotely control the 
X75HD/X75SD. See “Configuring Network Settings” on page 88 and 
“Remotely Controlling X75HD/X75SD Systems” on page 95 for more 
information on configuring the X75HD/X75SD for remote control.

Setting Discrete Options
The control knob cycles through discrete parameter and value options 
(such as Auto, On, Off). Depending on the parameter type, it will either 
wrap or clip when the control knob reaches the end of the option list.
• A wrapping parameter returns to the beginning of its range/list of 

options after you have scrolled through all of them.
• A clipping parameter requires you to scroll back through the 

range/list of options to return to the beginning of the list.

Procedure
To set a discrete parameter option, follow these general steps:
1. Navigate to the required menu or submenu, and select a parameter.
2. Highlight a parameter with the control knob, and then press Enter.
3. Press Exit to accept your new value and return to the previous 

menu or submenu.
Selected settings affect the output immediately.
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Setting a Numeric Value
For parameters that have a numerical range of values, the VFD panel 
shows both a numeric and a visual representation of the range. 
Figure 6-3 shows this representation.

Figure 6-3. VFD Showing Numerical Range of Values

To set a parameter with a numerical value, follow these general steps:
1. Navigate to the required menu or submenu, and then select a 

parameter.
2. Change to Coarse adjustment mode if required (Fine mode is the 

default mode when you first enter a parameter adjustment screen).
As an example, you can use the control knob to either adjust a value 
in increments of 0.02 (Fine mode) or 0.50 (Coarse mode).
a. Press Enter to switch to Coarse mode where you can make 

large adjustments more quickly. 
When in Coarse mode, the Enter button lights up. 

b. Press Enter again to return to Fine mode. 
3. Use the control knob to select a new value, and then press Enter to 

set it. 
Selected settings affect the output immediately.

4. To reset the parameter to its default value, press Default on the 
front panel.
The Default LED lights up whenever the current value of the 
parameter is equivalent to the default value (whether you reached 
this value by pressing the Default button, or by scrolling to it with 
the control knob).

5. Press Exit to accept your new value and return to the previous 
menu or submenu.

Numerical 
representation of 
parameter value

Visual representation of parameter value
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Getting Visual Feedback: 
Status and Alarm LEDs

The status and alarm LEDs provide visual feedback on the current 
mode and operating conditions of the unit. These LEDs are located 
together in the center of the panels, as shown in Figure 6-4.

Figure 6-4. Status LED Area

Genlock Status LED
The Genlock LED indicates the current status of the external genlock 
source.

Table 6-2. Genlock LED Status Definitions

LED Status Operating Condition
On The control panel is configured to Auto Genlock and a 

stable genlock source is detected.

Off Genlock is not selected.

Flashing The genlock source is not stable or is missing.
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EDH Status LED
The EDH LED indicates the current configuration and status of Error 
Detection Handling (EDH) in the input standard serial digital video 
stream. The EDH LED receives both SD-SDI 1 and HD-SDI 2 inputs 
for status reporting.

TBC Status LED
The TBC LED indicates whether or not the composite input signal is 
timebase-corrected by the unit’s TBC circuitry.

Table 6-3. EDH LED Status Definitions

LED Status Operating Condition
On The EDH feature is monitoring incoming video from both 

SD-SDI inputs.

Off The EDH feature is turned off.

Flashing EDH detection is enabled and EDH errors have been 
detected, or the incoming SDI feed does not include EDH. 
For an EDH error count and other related information, 
follow this path: Video Setup>SD1 or SD2 Input>EDH.

Table 6-4. TBC LED Definitions

LED Status Operating Condition
On The internal time base corrector is operating and 

correcting the input signal, usually for heterodyned signals 
from sources such as a VTR. 

Off The internal time base corrector is not active (the unit may 
be in Sync mode).
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Autotrack Status LED
The Autotrack LED indicates whether or not the audio Auto Track 
mode is enabled. You can independently set each audio synchronizer to 
track the selected output video channel to auto compensate the 
propagation delay introduced in the processed video path. Also, you can 
add the additional delay with the Audio Delay controls. Follow this 
path: Audio Setup>Input Setup>Delay 

M-Path Status LED
The M-Path LED indicates whether or not the unit is in M-Path mode. 
If the M-Path LED is not lit, the Simulcast mode is in effect.

Simulcast Status LED
The Simulcast LED indicates when the unit is in Simulcast mode. If the 
Simulcast LED is not lit, the M-Path mode is in effect.

Table 6-5. Autotrack LED Definitions

LED Status Operating Condition
On Any one of the I/O Delay SRC# parameters in Audio 

Setup>Global Audio Config>I/O Delay Config is set to 
an option that is other than None. 

Off The audio delay feature is turned off.

Table 6-6. Digi-Triplex LED Definitions

LED Status Operating Condition
On The M-Path mode is enabled (one or more input signals 

are selected and routed to the outputs).

Off The M-Path mode is not enabled.

Table 6-7. Simulcast LED Definitions

LED Status Operating Condition
On The Simulcast mode is enabled.

Off The Simulcast mode is not enabled.
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Major and Minor Alarm LEDs
The Major and Minor Alarm LEDs are activated from the enabled list 
of alarms found in the selected frame’s parameters. Local and remote 
control panels only detect alarms that are activated on X75HD/X75SD 
models that are currently being accessed.
Major alarms appear as red LEDs; minor alarms are amber. See 
page 323 for a detailed list of all possible alarms.

Mem Active LED
This LED indicates there is activity on the SD card.

Table 6-8. Major and Minor Alarm LEDs

LED Status Operating Condition
On Alarms are detected.

Off No alarms are detected.



126 X75HD/X75SD Installation and Operation Manual

 
Chapter 6: Operation via Front Panel Controls

Video Input LEDs
Directly press the Video In button to select a video source manually 
and to send out to all outputs. The LEDs to the left side of this button 
indicate which input is currently selected. The M-Path selection allows 
any output group to be assigned with the video input sources. When 
more than one video source is selected and mapped to multiple output 
groups, the M-Path and corresponding video input source LEDs will 
light. When the selected input signal is absent, the LED flashes.
See “Video Configuration” on page 143 for more information.

Figure 6-5. Video Input LED Area

Audio Input LEDs
Directly press the Audio In button to select any one set of audio inputs 
to be sent out to all multiple audio output sets. The LEDs to the top, 
right side of this button indicate which input is currently selected. When 
the selected input signal is absent, the LED flashes.
See “Audio Configuration” on page 151 for more information.

Figure 6-6. Audio Input LED Area
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Control Mode Status LEDs
The Audio, Video, and DV LEDs indicate the current focus of control. 
• The Audio LED lights when an audio parameter adjustment is 

made.
• The Video LED lights when a video parameter adjustment is made.
• The DV LED lights when the DV control is enabled. 

(The DV function is reserved for future use.)

Figure 6-7. Control Mode Status LED Area 
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Chapter 7

Web Server Software Control

Overview
Once the networking parameters of the X75HD/X75SD have been 
configured appropriately, and it is connected to the Ethernet network, 
you can control the unit through standard Web browsing software (for 
example, Microsoft® Internet Explorer 6.0, Netscape® Navigator™ 
7.2, or Mozilla® Firefox™ 1.0). See “Configuring for HTTP Control 
via Web Browser” on page 98 for more information.
Controlling the X75HD/X75SD remotely from your PC through a 
standard Web browser gives you the same options for control and alarm 
monitoring as other local and remote control methods, without the 
additional costs of purchasing control panels or specialized software 
applications. Using a Web browser to control the X75HD/X75SD does 
not require any special hardware or software. 
The following topics are discussed in this chapter:
• “Launching the Web Server Software” on page 130
• “Controlling Devices” on page 131
• “Navigating Menus and Options via the Menu Navigation Tree” on 

page 137
• “Monitoring Alarms” on page 138
• “Getting Help” on page 141

Note
Web browsers do not 
automatically update when 
server information changes. As 
a result, your Web page may 
contain stale information. Using 
the Back and Forward buttons 
on your browser may also 
present you with stale data. 
Before monitoring a device, be 
sure to click Refresh on your 
browser to get the latest 
information from the X75HD/
X75SD server. 
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Launching the Web Server Software
To access the X75HD/X75SD, open a supported Web browser on your 
computer (supported browsers include Microsoft Internet Explorer 6.0, 
Netscape Navigator 7.2, and Mozilla Firefox 1.0, among others).
In the Address, Location, or URL field of your Web browser (the 
name depends on the browser), type http:// followed by the IP 
Address of the X75HD/X75SD you want to control. For example, if the 
X75HD/X75SD is configured with the IP Address 10.0.0.1, enter the 
following location into your Web browser:

http://10.0.0.1

The Web browser then displays the Home page of the X75HD/X75SD 
Control interface (hereafter referred to as the “Web server”), as shown 
in Figure 7-1.

Figure 7-1. X75HD/X75SD Control Home Page for Web Server

The Home page provides three options: 
• Menu Navigation Tree (see page 131)
• Menu Navigation (see page 137)
• Monitoring (see page 138)
Click an option to open the desired control page.
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Controlling Devices
Click Menu Navigation from the Home page to open the Main menu 
page. The Main menu page provides access to all available X75HD/
X75SD menus and options. These menus mirror those menus that are 
accessible through the local and remote control panels.

Navigating from the Main Menu Page
The Main menu page lists several major submenus through which you 
can navigate to a required parameter/setting. Click a menu to open the 
corresponding configuration page. Continue to navigate through the 
resulting submenus until you reach the desired parameter.
The Main menu also has a number of individual parameters that can be 
set directly from this page. Click a parameter name from the Main 
menu table to change the value; a separate parameter configuration 
page will open.
Figure 7-2 on page 132 describes the Main menu page interface. 
Figure 7-3 on page 133 illustrates the sequence of pages that results 
during navigation.
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Figure 7-2. Main Menu Page

Current location 
in menu structure

Available submenus
Click a menu name to open the 
corresponding configuration page.

Main menu parameter options
Click a parameter name to change 
the corresponding value.

General parameter 
description

Current value 
description
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Figure 7-3. Sequence of Pages that Result During Navigation (Example)

1. Main menu page
Click Routing Setup to open the 
corresponding menu page.

2. Routing Setup menu page
Click Auto Detect Setup to open the 
corresponding menu page.

3. Auto Detect Setup
menu page
Click a parameter name from 
the table (in this example, SD 1 
In) to open the corresponding 
parameter configuration page.

4. SD 1 In parameter configuration 
page
Change the parameter (currently set to 
Normal); see “Setting a Selected Value” 
on page 134 for more information.
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Setting a Selected Value
To set a parameter value, navigate through the required menu and 
submenu structure until you reach the desired option. Click the 
parameter name from the table to open the corresponding parameter 
page and to modify its value.
Individual parameter pages show a minimum, maximum, and default 
value for the selected option. Click a minimum or maximum value, or 
enter a specific value in the provided text field, to change the parameter 
setting. Alternatively, you can click the ---> or <--- arrows to increase or 
decrease the values incrementally, or click Default to return the 
parameter to its factory setting. (See Figure 7-4.)

Figure 7-4. Setting a Parameter Value (Range)

Incremental value adjustment
Click the arrows to cycle through the 
values incrementally.

Default setting
Click Default to 
return the parameter 
to its factory setting.

Minimum/maximum 
value
Click to select a minimum 
or maximum value.

Value entry field
Enter a specific 
value in the provided 
box.

Current parameter setting
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For parameter options with discrete values, all of the available values 
are displayed. Click one of the values to set the option for that value. 
Alternatively, you can click the ---> or <--- arrows to cycle through the 
values, or click Default to return the parameter to its factory setting. 
(See Figure 7-5). 

Figure 7-5. Setting a Parameter Value (Discrete)

Some parameters show read-only options that cannot be changed. 
Others may be disabled and unavailable for configuration. (See 
Figure 7-6 on page 136.) If you require more information about the 
read-only function, click Read Only to open a Help page. The Help 
page provides general information about read-only and disabled 
parameters. See “Getting Help” on page 141 for more information.

Incremental value adjustment
Click the arrows to cycle through 
the values incrementally.

Default setting
Click Default to 
return the 
parameter to its 
factory setting.

Current parameter settingDiscrete values
Click a specific value to set.

Note
To ensure that the values shown 
on your screen are current, be 
sure to refresh the screen on 
your browser regularly.
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Figure 7-6. Viewing a Read Only Parameter

Read only information 
Click Read Only to open a Help 
page with information about 
read-only and disabled 
parameters.

Current parameter setting or 
status
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Navigating Menus and Options via 
the Menu Navigation Tree

Click Menu Navigation Tree from the Home page to present the 
X75HD/X75SD menu structure for selecting and setting options. These 
menus mirror the menus that are accessible through the local and 
remote control panels of the unit.
The menu listings display available menus and submenus. Click any of 
these to open the corresponding configuration page. Figure 7-7 shows a 
sample of the Menu Navigation Tree page and a resulting 
configuration page that opens when you click a submenu.

Figure 7-7. Menu Navigation Tree Control Page

Menu tree
Click any menu or submenu item to open the 
corresponding configuration page.

Clipping submenu configuration page
Click a parameter name from the Clipping 
submenu table to set the value; see “Setting a 
Selected Value” on page 134 for details.
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Monitoring Alarms
Click Monitoring from the Home page to open the Leitch X75 Alarms 
page. On this page, you can view or change the status of the active and 
disabled alarms (see Figure 7-9 on page 139). For a complete list of all 
of the possible alarms, see page 323.

Thumbnail Streaming
All X75HD/X75SD units provide a “thumbnail” streaming video output 
that originates from the Ctrl/Strm Ethernet port and is displayed both 
in the Alarms page of the X75 Web Server and in the Control window 
of CCS Pilot and Navigator. To activate the streaming in the Web 
Server, click Enable Streaming at the top left corner of the Alarms 
page (see Figure 7-8).
The frame size of the thumbnail image is 128 x 96 pixels. On the 
X75HD/X75SD Web server, the default refresh rate is once every 10 
seconds, but you can adjust it to a rate of between 5 and 300 seconds. (It 
can also be turned off entirely.) The control for the refresh rate is 
located at the bottom of the Alarms page.

Figure 7-8. Monitoring Page with Streaming Enabled

Enable/Disable thumbnail 
streaming option
Click here to enable or disable 
the option

Thumbnail streaming 
option enabled
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Figure 7-9. Alarm Monitoring Page

Click Configure Alarms from the Monitoring page to open up the 
alarm configuration page (see Figure 7-10 on page 140). The Configure 
Alarms page allows enabling of the disabled alarms and also can 
change each alarm's reporting properties. 
Click the Edit in the Action column to change the selected alarm's 
properties (see Figure 7-11 on page 140).

 

Leitch X75 Control : Monitoring 
  

Configure Alarms : Disable Streaming 

Leitch X75 : Alarms 

 
Active Alarms  

Alarm Name Alarm Priority Acknowledged 
AV I/P video missing Major No 

AV I/P video missing Major No 

SD1 I/P missing Major No 

SD1 I/P frozen Minor No 

SD2 I/P missing Major No 

SD2 I/P frozen Minor No 

HD I/P missing Major No 

HDFS I/P frozen Minor No 

HD I/P video low Major No 

HD I/P luma peaked Major No 

 

Refresh Rate (Seconds) 10   Set 
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Figure 7-10. Configure Alarms Page

Figure 7-11. Editing Alarms Page

 

Leitch X75 Control : Configure Alarms 
  

 
Monitoring 

 

Leitch X75 : Configure Alarms 

Alarm Name Trigger 
Time 

Clear 
Time 

Alarm 
Priority 

Alarm 
Disabled Acknowledged Action 

AV I/P video missing 0.0 0.0 10  No  No Edit 

AV I/P Burst missing 0.0 0.0 8  No  No Edit 

AV I/P not locked 0.0 0.0 8  No  No Edit 

AV I/P frozen 5.0 0.0 4  No  No Edit 

AV I/P video low 5.0 0.0 6  No  No Edit 

AV I/P luma peaked 5.0 0.0 6  No  No Edit 

AV I/P chroma peaked 5.0 0.0 6  No  No Edit 

AV I/P video missing 0.0 0.0 10  No  No Edit 

AV I/P Burst missing 0.0 0.0 8  No  No Edit 

AV I/P not locked 0.0 0.0 8  No  No Edit 

 

 

Leitch X75 Control : Configure Alarms 
  

 
Monitoring 

 

Leitch X75 : Configure Alarms 

Alarm Name Trigger 
Time 

Clear 
Time 

Alarm 
Priority 

Alarm 
Disabled Acknowledged Action 

 

       

AV I/P video missing 0.0 0.0
 

10
 

No No
 

 Save 
 

 

AV I/P Burst missing 0.0 0.0 8  No  No Edit 
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Getting Help
For certain parameters, help text is provided to answer why a parameter 
may be disabled or is available only as a “read-only” item. On 
parameter setting pages where you cannot change the value, click 
Read Only to open the provided Help page. The Help page provides 
general information about read-only and disabled parameters. See 
Figure 7-12.

Figure 7-12. Read Only Parameter Sample 

Help text page

Read Only help link
Click Read Only to open 
the provided help text.
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 Video Configuration

Overview
This chapter briefly describes the major video configuration options 
that can be changed in the course of normal operation.
The following topics are found in this chapter:
• “Selecting a Video Source” on page 144
• “Adjusting Video Levels” on page 146
• “Video/Audio Timing Tool” on page 147

See the following for more detailed information:
• Control Panels for X75 Systems Installation and Operation Manual 

for control panel shortcuts to video settings
• X75HD/X75SD Control Parameter List HTML document 

(available for download from either the Leitch Web site at 
www.leitch.com or from the included Documentation for X75 
Systems and Control Panels CD) for lists of all available menus and 
parameter options

http://www.leitch.com
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Selecting a Video Source

General Information
With control panel video shortcuts, you can select an input (or multiple 
inputs) and immediately send it to all video outputs by pressing the 
Video In button. The LEDs on the left side of this button indicate which 
input is currently selected. The M-Path (multiple inputs) selection 
allows any output group to be assigned with the video input sources. 
When two or more video sources are selected and mapped to multiple 
output groups, the M-Path and corresponding video input source LEDs 
will be lit. When the selected input signal is absent, the LED flashes. 
Available inputs include the following:
• M-Path
• Composite
• S-Video
• CAV
• SD 1
• SD 2
• DV (future use)
• HD Fiber
• HD 1
• HD 2
If the Auto Detect feature is enabled when a selected input option is not 
installed or detected, the panel accepts the next available input. If the 
selected video signal is absent, the corresponding video input LED 
flashes.

Note
If you have not installed the 
appropriate modules, the 
corresponding sources are not 
available for selection.
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Procedure
X75HD/X75SD units are shipped with Auto Detect video mode as the 
factory default setting. This mode sets the X75HD/X75SD to 
automatically detect analog, SD-SDI 1, SD-SDI 2, future-use DV, 
HD-SDI Fiber, HD-SDI 1, HD-SDI 2, composite, and S-video inputs. 
When video is connected to any of these inputs, the X75HD/X75SD 
automatically selects the applied input video and then sends out the 
converted video to all outputs. The Video Input LEDs on the front 
panel show the selected video source.
For analog video sources, only a single video source can be 
automatically detected. Therefore, you must pre-select the desired 
analog input video source first in order for auto-detection to work 
across the HD/SD/analog inputs.
Similarly, you must select HD input sources (HD-SDI 1, HD-SDI 2, and 
HD-SDI Fiber) and SD-SDI 2 or future-use DV inputs first, for the 
auto-detection to function.
To change the input signal type, follow these steps:
1. Press Video In on the control panel, (or navigate to the Video 

Setup>Routing Setup menu and then select AllOutSelect). 
All available inputs will display on the control panel screen. 

2. Use the control panel knob to scroll through the list of input types, 
and then press to Enter to select one.

When multiple video sources are connected, the Auto Detect Setup 
setting determines the selection of the input video. For example, if the 
X75HD/X75SD unit detects two input signals, it will accept the signal 
tagged as Higher over another signal that has been given a 
lower-precedence. Found in the top-level Video Setup>Routing Setup 
menu, precedence levels include Highest, High, Normal, Low, or 
Lowest. When multiple input types are present and assigned the same 
precedence level, the X75HD/X75SD uses the following default 
ordering:
1. Analog video input
2. SD1 input
3. SD2/DV input
4. HD1/HD-fiber input
5. HD2 input

Note
If you press the Video In button 
and then manually select a video 
source, the X75HD/X75SD unit 
reverts to M-Path (User) mode. 
Video modes are found under 
Video Setup>Routing Setup > 
Input Video Mode.
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Figure 8-1 graphically illustrates a single-source signal process, where 
one selected video input is fed to all outputs.

Figure 8-1. Single-Source Processing 

Adjusting Video Levels
Various control panel buttons provide quick access to the video 
processing parameters of a selected video source. Simply press a button 
and use the control knob to change the selection.
For more details, see “Video Proc Amp” on page 166. 
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Video/Audio Timing Tool
The X75OPT-V2A video/audio timing tool is a software upgrade that 
makes it possible to correct lip sync problems that occur during 
conversions. (The video/audio timing tools consists of a receiver and 
transmitter; the transmitter is free; the receiver is an optional upgrade 
requiring a software key.) The V2A enables a receiving X75HD/X75SD 
to analyze video and audio test signals and then detect any time 
propagation differences that may occur during the following processes:
• Up-, cross-, and down conversion
• Analog to digital conversion
• Digital to analog conversion
• MPEG coding and decoding
The feature can be enabled to operate manually or automatically. The 
automatic mode aligns received video and audio signals that are up to 
1.3 seconds apart.
A user menu (Video/Audio Timing) includes the timing tool’s 
parameters. The menu’s parameters perform the following functions:
• Display the time by which each audio channel is leading or lagging 

the video (either SD1, SD2, HD, and/or analog)
• Enable you to load the currently measured video delays to the audio 

delay parameters, effectively performing audio/video 
synchronization

The X75OPT-V2A video/audio timing tool will only insert audio 
delays, and thus will not account for situations in which the measured 
audio processing paths (shown in the middle box of Figure 8-2 on 
page 148) are longer than the video processing paths—even though the 
tool will be able to display it. If audio is lagging behind the video, the 
V2A feature can measure the difference, but the user must add the video 
delay; it cannot be automatically corrected. 

Note
CCS versions 3.1.2 and earlier 
do not reliably distinguish 
between disabled audio 
parameters and read-only audio 
parameters. 
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Figure 8-2. X75OPT-V2A Video/Audio Timing Feature

Transmitter
Firmware versions 1.7 or later are capable of transmitting a special V2A 
video/audio test pattern. This pattern may be used directly to measure a 
system's relative video/audio timing delays, or recorded for later use. To 
manually configure an X75HD/X75SD unit to output this test pattern, 
follow these steps:
1. If an X75HD sub-module is present, perform the following steps to 

enable the HD TSG:
i. Navigate to the Video Setup>Processing>HD TSG & 

Slide menu.
ii. Set the HD-TSG Select parameter to Color Bars 100%.
iii. Set the HD-TSG Enable parameter to On.

2. Enable the SD TSG by performing the following steps:
i. Navigate to the Video Setup>Processing>SD TSG & 

Slide menu.
ii. Ensure that the Keyer/TSG Insert parameter is configured 

to the correct video path.
iii. Set the SD-TSG Select parameter to Bars 100%.
iv. Set the SD-TSG Enable parameter to On.

3. Set all audio left-channel outputs to Tone 3 and all audio 
right-channel outputs to Tone 4.
4. Navigate to the Video/Audio Timing menu and set the V2A Tx 
Enable parameter to Enable.

To disable the V2A blank insertion, set the V2A Tx Enable parameter 
to Disable.

X75
transmitting
test mode

(transmitting capability
is standard with every

X75 using v 1.7 or later
firmware)

Analog< >digital
up< > down < >cross

encode/decode

Video and audio
untimed

X75
receiving test

mode

(requires X75OPT-
V2A software key)

Video and audio
zero timed

HD

SD
AES

Analog video
Analog audio

Video and audio
zero timed

HD

SD
AES

Analog video
Analog audio



X75HD/X75SD Installation and Operation Manual 149

Chapter 8: Video Configuration

 

Receiver
The V2A receiver simultaneously monitors the inputs to the X75’s 
audio sources and compares them against one of the unit's video inputs. 
To configure an X75 unit for V2A reception, follow these steps:
1. Route the audio inputs containing V2A signals to the SRCs to be 

used in the unit's final processing (see “Selecting an Audio Source” 
on page 153 and “Advanced Audio Inputs and Outputs Selection” 
on page 160 for details).

2. Select a video input under the Video/Audio Timing>V2A Rx 
Video Src parameter. 
For analog and HD inputs, the source will be that which is currently 
selected in the X75A3D/X75PQM and X75HD submodules 
respectively.

Parameters under Video/Audio Timing>V2A Status indicate whether 
or not a valid V2A test signal is detected on the unit's inputs. If a valid 
V2A test signal is detected, the relative video delay will be indicated by 
a series of parameters under the Video/Audio Timing>Video Delay 
sub-menu. A series of parameters under the Video/Audio Timing> 
Channel Swap sub-menu report whether or not the unit detects a left/
right channel swap for stereo pairs. 
You can automatically set the measured video delays to the unit’s audio 
delay parameters using the Video/Audio Timing>Align Leading 
Audio parameter. Setting this parameter to Yes updates the unit’s audio 
delay parameters with the currently displayed V2A video delays, 
effectively compensating for measured video/audio timing differences.

Note
To prevent processing errors, 
you must ensure all unused 
audio channels are routed to 
Tone or Mute. The receiver 
takes approximately 5 seconds 
to generate audio/video timing 
information for all of the inputs. 
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Typical Applications
Figure 8-3 illustrates three typical applications for the timing tool.

Figure 8-3. X75OPT-V2A Applications

X75

Unknown signal

X75

V2A transmitter V2A receiver

ggg

X75 Record/ playback transport

Record/ playback transport X75

V2A transmitter

V2A receiver

Step 2: Check relative video to audio timing at an X 75

Step1: Record V2A signal on a file server or tape transport

X75

V2A transmitter

Step1: Send  the V2A signal into a transmission system.

X75

V2A receiver/transmitter

Step2: Loop back into the X75 and check the relative video-to-audio timing.

Application #1

Application #2

Step 1: Use current method to adjust for any 
video-to-audio timing issues

Step 2: X75 determines whether there have been any 
changes to the relative video-to-audio timing and can be 
set to correct for those changes.

Application #3

In loop back, HD to HD can be measured, and SD1 to SD2 (or SD2 to SD1) 
can be measured. 
Analog composite to analog composite, and analog component to analog 
component cannot be measured.
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Audio Configuration

Overview
This chapter describes the audio configuration options that can be 
changed in the course of normal operation.
The following topics are found in this chapter:
• “General Information” on page 152
• “Selecting an Audio Source” on page 153
• “Adjusting Audio Levels” on page 155
• “Audio LED and Buttons Map” on page 156

See the following for more detailed information:
• Control Panels for X75 Systems Installation and Operation Manual 

for control panel shortcuts to audio settings
• X75HD/X75SD Control Parameter List HTML document 

(available for download from either the Leitch Web site at 
www.leitch.com or from the included Documentation for X75 
Systems and Control Panels CD) for lists of all available menus and 
parameter options

http://www.leitch.com
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General Information
With control panel shortcuts, you can select an input (or multiple 
inputs) and immediately send it to all audio outputs. Directly press the 
Audio In button to select any one set of audio inputs to be sent out to all 
audio multiple output sets. The LEDs to the top, right side of this button 
indicate which input is currently selected. When the selected input 
signal is absent, the LED flashes.
Available audio input groups include the following:
• User
• Analog—4 mono channels of analog audio input
• AES—5 channels
• DV (future use)
• SD—8 or 16 channels from the SD-SDI de-embedder
• HD—8 or 16 channels from the HD-SDI de-embedder
• Dolby—10 channels from the internal Dolby encoder
Depending upon which input you have selected, the X75 unit 
automatically and logically maps all output channels. When you select 
two or more audio input groups, the Audio In Src Select parameter is 
automatically set to the User setting, and this control is available from 
the Audio Setup>Routing submenu. 
To switch between mono and stereo audio processing control, press the 
Ctrl and Mo/St buttons simultaneously. When mono control is active, 
each button controls an individual gain. When stereo control is active, 
the top and bottom front panel buttons work together (are “married”) so 
that either button will adjust the gain in stereo pairs.

Note
The optional X75OPT-AS-8/16 
module is required for 
synchronizing, delaying and 
processing mono audio for 
SD-SDI and HD-SDI inputs.
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Selecting an Audio Source
Press the Audio In button to select any one set of audio inputs to be 
sent out to all audio multiple output sets. The LEDs to the top, right side 
of this button indicate which input is currently selected. This table 
shows how the signals are routed internally and mapped to audio 
outputs.

Table 9-1. Audio Source Groupings 

Default 
Output 
Mapping

Input Audio Source Groups

Analog AES DV 
(future use) SD-SDI X HD-SDI X Dolby

AA_Out1 AA1 AES1a DV_a SDX1 HDX1 Dolby1

AA_Out2 AA2 AES1b DV_b SDX2 HDX2 Dolby2

AA_Out3 AA3 AES2a  SDX3 HDX1 Dolby3

AA_Out4 AA4 AES2b  SDX4 HDX2 Dolby4

AES1_OutA AA1 AES1a DV_a SDX1 HDX1 Dolby1

AES1_OutB AA2 AES1b DV_b SDX2 HDX2 Dolby2

AES2_OutA AA3 AES2a  SDX3 HDX3 Dolby3

AES2_OutB AA4 AES2b  SDX4 HDX4 Dolby4

AES3_OutA  AES3a  SDX5 HDX5 Dolby5

AES3_OutB  AES3b  SDX6 HDX6 Dolby6

AES4_OutA  AES4a  SDX7 HDX7 Dolby7

AES4_OutB  AES4b  SDX8 HDX8 Dolby8

AES5_OutA  AES5a  SDX9 HDX9 DolbyAuxL

AES5_OutB  AES5b  SDX10 HDX10 DolbyAuxR

SD1/HD1_OutA AA1 AES1a DV_a SDX1 HDX1 Dolby1

SD1/HD1_OutB AA2 AES1b DV_b SDX2 HDX2 Dolby2

SD2/HD2_OutA AA3 AES2a  SDX3 HDX3 Dolby3

SD2/HD2_OutB AA4 AES2b  SDX4 HDX4 Dolby4

SD3/HD3_OutA  AES3a  SDX5 HDX5 Dolby5
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SD3/HD3_OutB  AES3b  SDX6 HDX6 Dolby6

SD4/HD4_OutA  AES4a  SDX7 HDX7 Dolby7

SD4/HD4_OutB  AES4b  SDX8 HDX8 Dolby8

SD5/HD5_OutA  AES5a  SDX9 HDX9  

SD5/HD5_OutB  AES5b  SDX10 HDX10  

SD6/HD6_OutA    SDX11 HDX11  

SD6/HD6_OutB    SDX12 HDX12  

SD7/HD7_OutA    SDX13 HDX13  

SD7/HD7_OutB    SDX14 HDX14  

SD8/HD8_OutA    SDX15 HDX15  

SD8/HD8_OutB    SDX16 HDX16  

Table 9-1. Audio Source Groupings (Continued)

Default 
Output 
Mapping

Input Audio Source Groups
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Adjusting Audio Levels
When an audio source group is selected and sent to all outputs, press the 
Ctrl and A. Proc buttons to quickly access the audio level controls of 
the selected audio input.The selected audio input channels’ gain 
controls are mapped to the numbered buttons on the control panel 
accordingly. The mapped buttons illuminate during audio proc control. 
The Audio Proc LEDs on the lower, right corner of the front panel 
indicate which processing block is currently selected.

Figure 9-1. Audio Input Control Area

Press Audio In The Audio LED lights 
when the current 
control mode is set to 
an audio parameter.
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Audio LED and Buttons Map
When you press the Audio In or Ctrl + A Proc button on a local or 
remote control panel, or if you make audio input selections via your 
Web browser software or other control application, certain parameters 
and audio proc amp buttons get mapped, and various Channel LEDs 
and Audio I/P LEDs will light according to the selected input 
configuration. The following tables describe the LEDs and buttons that 
are assigned to selected input sources.
Tables 10-1 through 10-6 in “Chapter 10: Special Function Buttons” 
describe the various channels, LEDS, gain controls, and control panel 
buttons that are affected/activated by the selection of certain analog, 
AES, SD-SDI, and/or HD-SDI demuxed audio inputs. Use the Ctrl + A 
Proc buttons to switch between the audio input types.

Selecting an Audio Input
Directly press Audio In to select any one input group to be sent out to 
all audio outputs. Alternatively, open the Audio Setup menu and 
navigate to the Routing submenu. From here you can select and 
configure your audio inputs.
After configuring your audio inputs, the following LEDs will light (see 
Figure 9-2 on page 157 for their locations):
• The Audio Mode LEDs on the far right side of the front panel (top) 

indicate the current mode of operation.
• The Audio Proc LED on the far right side of the front panel 

indicates the current processing audio group.
• The Audio Input LEDs to the top, right of the button indicate 

which input group is currently selected.
• The Audio Channel LEDs immediately to the right of the button 

indicate which audio channels are mapped and internally routed to 
the SRC channels.
See “Audio Proc Amp” on page 167 for information on LED and 
channel mappings on a frame-mounted local control panel or 
X75-RCP remote control panel.

Note
For audio input configuration, 
an optional X75OPT-AS-8/16 
module must be installed.
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Figure 9-2. Location of Audio LEDs

Accessing Audio Level Controls
Press the Ctrl and A Proc buttons together to quickly access the audio 
level controls of a selected audio input. Along with LEDs, the selected 
audio input channel’s gain controls will be mapped to specific 
numbered buttons on the right side of the front panel. These buttons will 
light during audio processing and configuration.
See “Audio Proc Amp” on page 167 for information on LED and 
channel mappings on a frame-mounted local control panel or X75-RCP 
remote control panel.

Tracking and Delaying Audio
Each audio sample rate converter (SRC) can be configured to 
automatically track the processing delay of one of the video outputs. To 
apply the internal audio tracking feature, follow this path: Audio 
Setup>Global Audio Config>I/O Delay Config. Select one of the four 
or eight I/O Delay SRCs, and then select the accompanying video 
signal to track with that audio SRC.

Audio mode LED

Audio proc 
LEDsAudio input LEDs

Audio Channel LEDsAudio In/A Proc button

Ctrl 
button
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AFV (Audio Follows Video) Mode
In AFV mode, each of the selectable video inputs has an audio input 
selection linked to it. With this feature enabled, the audio input 
selection for the channel automatically changes when the video input is 
changed.
You can enable or disable AFV mode through the Audio menu. The 
<channel>-AFV-<input> parameters specify the audio input channel 
(“<channel>”) to be automatically switched when the SD Out Sel 
parameter is switched to a specified input (“<input>”). For example, 
the Ch1-AFV-SD1 parameter specifies the audio input for SRC 
Channel 1 will be automatically switched when the SD Out Sel 
parameter changes to SD1.
When AFV mode is enabled for any single SRC channel, the AFV LED 
on the front panel of the unit will be lit.
You can override AFV mode by manually selecting a different audio 
input. This will not, however, turn AFV mode off—the next time the 
video input selection is changed, the audio will again follow it. AFV 
mode can only be disabled through the audio menus.
Figure 9-3 on page 159 shows the default AFV audio and video 
assignments. It illustrates the linked audio channels in AFV mode when 
the video is switched from the composite input to SD-SDI 1 video. 
When the AFV is enabled for all SRC channels, the composite input 
video selection also routes analog input channels 1 and 2 to SRC 
channel 1, and analog input channels 3 and 4 to SRC channel 2. When 
SD-SDI 1 input video is selected, all four groups of de-multiplexed 
audio channels are routed through eight SRC channels.
You can assign different audio inputs to each SRC channel, as well as 
enable and disable the AFV function for each video input to create a 
complex routing.

Note
The AFV mode currently 
functions on the SD-SDI 1 
output.
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Figure 9-3. Default AFV Channel Assignment

CH1

CH2

CH3

CH4

CH5

CH6

CH7

CH8

AA1/2 AES1a/1b SDX1/2 SDX1/2 DV_a/b HDX1/2 HDX1/2 HDX1/2AA1/2

AA3/4 AES2a/2b SDX3/4 SDX3/4 DV_a/b HDX3/4 HDX3/4 HDX3/4AA3/4

AA1/2 AES3a/3b SDX5/6 SDX5/6 DV_a/b HDX5/6 HDX5/6 HDX5/6AA1/2

AA3/4 AES4a/4b SDX7/8 SDX7/8 DV_a/b HDX7/8 HDX7/8 HDX7/8AA3/4

AA1/2 AES5a/5b SDX9/10 SDX9/10 DV_a/b HDX9/10 HDX9/10 HDX9/10AA1/2

AA3/4 AES1a/1b SDX11/12 SDX11/12 DV_a/b HDX11/12 HDX11/12 HDX11/12AA3/4

AA1/2 AES2a/2b SDX13/14 SDX13/14 DV_a/b HDX13/14 HDX13/14 HDX13/14AA1/2

AA3/4 AES3a/3b SDX15/16 SDX15/16 DV_a/b HDX15/16 HDX15/16 HDX15/16AA3/4

Cmpst S-Vid CAV SD1 SD2 DV HDF HD1 HD2

Video Inputs
Toggles between inputs
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Advanced Audio Inputs and Outputs Selection 
In hybrid analog and digital standard definition processing for audio, 
typically 4 audio channels are used. Users of X75 for hybrid analog/
digital standard definition video processing with audio have discovered 
the M-PATH video and audio multiple path processing capabilities and 
have asked for an enhancement.
Today's X75 embedded audio functionality allows for the 8 or 16 
processed audio channels to be embedded into both SD-SDI outputs.
If you are processing two video signals, each with 4 channels of audio, 
the processed audio can only be selected into two different groups (for 
example group 1 and group 2).
For ease of configuration across multiple processes in a facility, the 4 
audio channels are typically embedded into group 1. The new free 
enhancement allows the user to place the processed audio channels for 
each video channel into the same embedded group (typically group 1).
The 16 processing audio channels can be embedded in any sequence 
independently on SD-SDI, SD-SDI2 and HD-SDI outputs. Embedded 
audio processing for X75 requires that an audio module be installed.
For custom applications, the X75 unit provides full input and output 
routing control. You can select multiple audio input sources 
simultaneously and route them internally to meet your application 
requirements (see Figure 9-4 on page 161). Each SRC can be assigned 
to any stereo input sources. Mono-based audio outputs can select any 
SRC outputs, including the summation, tones, and mutes. More than 
one audio input LED will light when multiple audio input sources are 
selected (for example, Analog and AES).
As Figure 9-4 on page 161 shows, the audio output is simultaneously 
sent to three embedders (HD, SDI 1, and SDI 2); routing blocks are 
located in front of the two SDI -‘embedders to allow these embedders to 
be independently configured. 
To make changes to these audio input and outputs, follow this path:
Audio Setup>Routing
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Figure 9-4. Advanced Audio Signal Routing 
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Chapter 10

Special Function Buttons

Overview
This chapter describes various special function buttons found on the 
frame-mounted local control panel or X75-RCP remote control panel, 
including the following:
• “Using the Freeze Control” on page 165
• “Using Proc Amp Controls” on page 166
• “Using the Memory Function” on page 172
• “Using the FAV1 and FAV2 Function” on page 176
• “Using the Bypass Function” on page 178
• “Using the Mo/St Button Function” on page 178
• “Using the Noise Reduction” on page 178
• “Using the Test Signal Generator” on page 180
• “Using the ARC Function” on page 184
• “Using the Timing Control” on page 188
• “Using Option Controls” on page 188
• “Display Screen Setup Parameters” on page 191

See the following for more detailed information:
• Control Panels for X75 Systems Installation and Operation Manual 

for control panel shortcuts to various audio and video settings
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• X75HD/X75SD Control Parameter List HTML document 
(available for download from either the Leitch Web site at 
www.leitch.com or from the included Documentation for X75 
Systems and Control Panels CD) for lists of all available menus and 
parameter options

http://www.leitch.com
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Using the Freeze Control
The freeze control freezes individual frames or fields of the incoming 
video source. The Freeze mode only affects the currently active video 
proc amp block. 
To use the freeze shortcut, follow these steps:
1. Press Frz Mode to open a menu in the VFD panel where you can 

select a mode to apply to the incoming video.
2. Press Frz Mode multiple times to cycle through the different 

modes.
Available modes include the following:
• Field 1
• Field 2
• Frame

3. Press Take to activate the selected Freeze mode and apply it to the 
incoming video.
The Take button flashes while the Freeze mode is active.

4. Press the Take button repeatedly to toggle between live and freeze 
modes.

Note
The Mute In Freeze option 
(Audio menu) specifies whether 
or not audio output will be 
muted while the video is frozen 
in Frame or Field mode.
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Using Proc Amp Controls

Video Proc Amp
There are four internal input video proc amps: HD-SDI, SD-SDI 1, 
SD-SDI 2, and Analog.
• HD-SDI 1, HD-SDI 2, and HD-SDI Fiber inputs share the HD 

video proc amp.
• SD-SDI 1 input has its own dedicated SD-SDI 1 video proc amp.
• SD-SDI 2 and future-use DV inputs share the SD-SDI 2 video proc 

amp.
• Composite, S-video and CAV inputs share the analog video proc 

amp.
The four most commonly used video processing controls are available 
from the control panel as the hot buttons, and include the following:
• Luma: Can be mapped to Analog Luma Gain, SD-SDI 1 Luma 

Gain, SD-SDI 2 Luma Gain, HD-SDI Luma Gain
• Black: Can be mapped to Analog Black Level, SD-SDI 1 Black 

Level, SD-SDI 2 Black Level, HD-SDI Black Level
• Chroma: Can be mapped to Analog Chroma Gain, SD-SDI 1 

Chroma Gain, SD-SDI 2 Chroma Gain, HD-SDI Chroma Gain
• Hue: Can be mapped to Analog Hue Phase, SD-SDI 1 Hue Phase, 

SD-SDI 2 Hue Phase
The VFD briefly displays the selected video proc amp block when the 
Ctrl and V Proc buttons are pressed simultaneously.

Video Proc Amp Status LEDs
The three Video Proc LEDs (Analog, SD-SDI, HD-SDI) on the far 
right side of the front panel become active whenever the control panel is 
set to adjust the video parameters. They indicate which input video 
processing block is currently selected for the adjustments.
• Analog: Lights when the analog video proc amp is selected
• SD: Lights when the SD-SDI 1 or SD-SDI 2 video proc amp is 

selected. When a shortcut (front panel) button is pressed, the 
parameter prefix on the VFD display indicates which video 
processing block is currently active

• HD: Lights when the HD-SDI video proc amp is selected 
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Audio Proc Amp
When an X75OPT-AS-8 or X75OPT-AS-16 module is installed, you 
can synchronize, delay, and process up to 8 or 16 mono channels for 
each of the two embedder (SD-SDI and HD-SDI) inputs. Depending on 
the selected audio source group type, the numbered buttons 1 through 8/
16 are mapped accordingly to allow quick access to its audio gain 
controls.
The audio source group types include the following: 
• 4 mono channels of analog audio
• 5 AES channels (2 in the X75SD)
• DV audio (future use)
• 16 channels from the SD-SDI demultiplexer
• 16 channels from the HD-SDI demultiplexer
Tables 10-1 through 10-6 in the following pages describe the button 
mappings for single and multiple audio source configurations.

Single Source Configuration
Tables 10-1, 10-2, 10-3, and 10-4 show the mapped buttons on the 
control panels and the parameters affected when you use a single source 
of analog, AES, SD-SDI demuxed, or HD-SDI demuxed audio, 
respectively.
For more information about the items in these tables (for example, what 
each of the column headings refers to), see “Appendix to Tables” on 
page 170.

Table 10-1. Analog Audio Inputs Selected

Selected 
Inputs

Lit Channel 
LEDs

Lit Audio 
Input LEDs

Mapped 
Parameters

Mapped 
Buttons on 
Control 
Panel

Lit Audio 
Proc LEDs

AA1/2 1 Analog Gain1, Gain2 1, 2 Analog

AA3/4 2 Gain3, Gain4 3, 4
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Table 10-2. AES Audio Inputs Selected

Selected 
Inputs

Lit Channel 
LEDs

Lit Audio 
Input LEDs

Mapped 
Parameters

Mapped 
Buttons on 
Control 
Panel

Lit Audio 
Proc LEDs

AES1 1 AES Gain1, Gain2 1, 2 Digital

AES2 2 Gain3, Gain4 3, 4

AES3 3 Gain5, Gain6 5, 6

AES4 4 Gain7, Gain8 7, 8

AES5 5 Gain9, Gain10 9, 10

Table 10-3. SD-SDI Demuxed Audio Selected (SDX)

Selected 
Inputs

Lit Channel 
LEDs

Lit Audio 
Input LEDs

Mapped 
Parameters

Mapped 
Buttons on 
Control 
Panel

Lit Audio 
Proc LEDs

SD1/2 1 SD Gain1, Gain2 1, 2 SD

SD3/4 2 Gain3, Gain4 3, 4

SD5/6 3 Gain5, Gain6 5, 6

SD7/8 4 Gain7, Gain8 7, 8

SD9/10 5 Gain9, Gain10 9, 10

SD11/12 6 Gain11, Gain12 11, 12

SD13/14 7 Gain13, Gain14 13, 14

SD15/16 8 Gain15, Gain16 15, 16
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Multiple Audio Input Source Configurations
Tables 10-5 and 10-6 show the mapped buttons on the control panels 
and the parameters affected when you use multiple sources of analog, 
AES, SD-SDI and SD-SDI audio. Use the Ctrl + A Proc buttons to 
switch between the audio input types.

Table 10-4. HD-SDI Demuxed Audio Selected (HDX)

Selected 
Inputs

Lit Channel 
LEDs

Lit Audio 
Input LEDs

Mapped 
Parameters

Mapped 
Buttons on 
Control 
Panel

Lit Audio 
Proc LEDs

HD1/2 1 HD Gain1, Gain2 1, 2 HD

HD3/4 2 Gain3, Gain4 3, 4

HD5/6 3 Gain5, Gain6 5, 6

HD7/8 4 Gain7, Gain8 7, 8

HD9/10 5 Gain9, Gain10 9, 10

HD11/12 6 Gain11, Gain12 11, 12

HD13/14 7 Gain13, Gain14 13, 14

HD15/16 8 Gain15, Gain16 15, 16

Table 10-5. Multiple Audio Inputs Selected

Selected 
Inputs

Lit LED 
Channels

Lit Audio 
Input LEDs

Mapped 
Parameters

AA1/2 1 Analog Gain1, Gain2

AA3/4 2 Gain3, Gain4

AES1 3 AES Gain5, Gain6

AES2 4 Gain7, Gain8

SD1/2 5 SD Gain9, Gain10

SD3/4 6 Gain11, Gain12

HD1/2 7 HD Gain13, Gain14

HD3/4 8 Gain15, Gain16
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Appendix to Tables
Tables 10-1 through 10-6 describe the various channels, LEDS, gain 
controls, and control panel buttons that are affected/activated by the 
selection of certain inputs. Table 10-7, below, provides some general 
information and definitions about each of these items.

Table 10-6. Ctrl + A Proc Buttons Pressed

Lit LED 
Channels

Mapped 
Buttons on 
Control 
Panel

Lit Audio 
Proc LEDs

1 1, 2 Analog

2 3, 4

3 5, 6 AES

4 7, 8

5 9, 10 SD

6 11, 12

7 13, 14 HD

8 15, 16

Table 10-7. Table Definitions 

Item Description
Items Applied/Enabled when you Press the “Audio In” Button

Selected Inputs This identifies the selected input source. 
Select an input using the X75 Web server software (via 
a Web browser), or by pressing Audio In Src on a 
control panel.

Lit Channel LEDs This identifies the audio channels (and their LEDs) that 
correspond with your selected audio input source. 
Find these eight LEDs directly to the right of the Audio 
In/A Proc button on a control panel. 
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Audio Proc Amp Status LEDs
The four Audio Proc LEDs (Analog, Digital, SD-SDI, HD-SDI) on the 
far right side of the front panel indicate the selected audio input group 
that is being adjusted for the audio gain. 
• Analog: Lit during analog audio channels gain adjustments
• Digital: Lit for AES and future-use DV channel audio gain 

adjustments
• SD-SDI: Lit during SD1 or SD2 (SD-SDI demuxed) channel audio 

gain adjustments
• HD-SDI: Lit during HD1 or HD2 (HD-SDI demuxed) channel 

audio gain adjustments.

Lit Audio Input 
LEDs

This identifies the audio input LED that lights when an 
input source is selected.
Find these LEDs above, and to the right, of the Audio 
In/A Proc button on a control panel.
Options include Analog, AES, SD-SDI, HD-SDI, and 
AFV (Audio Follow Video).

Mapped 
Parameters

This identifies the selected audio input channel’s gain 
controls/parameters that are now enabled and available 
once a certain audio input source is selected.

Items Applied/Enabled when you Press the “Ctrl” + “A Proc” Buttons

Mapped Buttons 
on Control Panel

This identifies the audio proc amp buttons on the right 
side of the control panel (labelled 1 through 16) that 
become mapped to/correspond with the selected audio 
input channel’s gain controls.
Mapped buttons are backlit; unmapped buttons remain 
dimmed. Once mapped, press a numbered button to 
enable the gain controls assigned to it.

Lit Audio Proc 
LEDs

This identifies the audio proc LED that lights when an 
audio input source type is selected.
Find these four LEDs on the far right side of the control 
panel. Options include Analog, Digital, SD-SDI, and 
HD-SDI.

Table 10-7. Table Definitions (Continued)

Item Description
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Using the Memory Function
Using the Memory button, you can store and recall user settings for up 
to 100 presets on an SD card, or up to 10 presets in the X75 itself.
When storing each “package” of parameter settings, the memory will 
automatically save to a default file naming structure (X75Save00 in an 
SD card, or Preset Slot 1 in an X75). Files on the SD card can be 
renamed later, using Windows Explorer in a PC.
Once all of the available default filenames are “used up” you must 
delete the existing files, overwrite the existing files, or rename these 
files to make room for new default names.
Table 10-8 compares the process of saving in the X75 memory to that 
of saving in an SD card.

File Naming Conventions
When using SD card presets, filenames have a limit of 24 characters 
(before the extension), must have the extension of “.psf”, and must 
reside in the x75preset directory.
The following are some examples of usable and unusable file naming 
conventions (files are assumed to be in the /x75preset directory):
Example 1

“my preset that has a long name.psf” 
(30 characters)
Result: Will not work (will not display)

Note
A preset can not be saved if 
there is not enough space, the 
save protection tab is enabled, 
or the first 100 default names 
are used.

Table 10-8. Comparison of SD Card and X75 Memory Saving

Item SD Card X75 Memory
Default naming convention X75Save00, X75Save01, etc. Preset Slot 1, Preset Slot2, etc.

Limit to number of saved presets 100 using default naming convention
(up to 1000 can be visible when at 
least 900 have been renamed)

10 slots

Number of characters allowable in 
the filenames

24 63
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Example 2
“my preset w24 characters.psf” 
(24 characters)
Result: Will work

Example 3
“non-proper ext.txt”
(Extension is.txt)
Result: Will not work (will not display)

Example 4
“test.txt.psf” 
(the last four characters are is “.psf”, making the filename valid)
Result: Will work.

The various procedures for formatting, saving, recalling, renaming, and 
deleting presets are outlined below. 

Formatting an SD Card
New SD cards must be formatted in an X75 before use. Follow this path 
to format a card:
1. Insert the card into the slot
2. Press the Memory button.
3. Select SD Card Format, and then press Enter.
4. Click Yes when prompted.
A confirmation message will appear briefly.

Saving a Preset
To save a preset, follow these steps:
1. Press Memory.

A menu pops up with the following options:
• List Preset 
• Save Presets
• SD Card List Presets
• SD Card Save Presets
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2. Select Save Presets to save the settings to the X75, or press SD 
Card Save Presets to save the settings to the SD card. 
A list of ten slots appears in the X75 memory, or up to 1000 
filenames appear in the SD card.
When saving to the X75, the slots are named Preset Slot 1, Preset 
Slot 2, etc., or simply Empty. When saving to an SD card, the 
default filenames are X75Save00, X75Save01, X75Save02, etc., in 
addition to an option to create a new Preset.

3. Overwrite an old file, or, in the X75, scroll to the slot where you 
wish to save the entry, and then press the Enter button.

4. To save a new preset, scroll to a slot that is empty in the X75, or 
scroll to the New Preset option for the SD card, and then press the 
Enter button.

Recalling a Preset
To recall a preset, follow these steps:
1. Press Memory.
2. Select List Presets (to recall a setting stored in theX75) or SD 

Card List Presets (to recall a setting stored in the SD card). 
3. Scroll to the preset you would like to recall.
4. Press Memory again, or press Enter.

A menu opens with the following options:
• Restore Preset 
• Delete Preset 
• Rename Preset

5. Scroll through the list, select Recall Preset, and then press Enter. 
Your preset is recalled.

Renaming a Preset
To rename a preset, follow these steps: 
1. Press Memory.
2. Select List Presets for items stored in the X75, or SD Card List 

Presets for items in the SD card. 
3. Scroll to the preset you would like to rename, and then press Enter.
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4. In the new list, select Rename Preset, and then press Enter. 
You will be prompted to enter a new name. 

5. Enter a new name.

Deleting a Preset
To delete preset, follow these steps: 
1. Press Memory.
2. Select List Presets for items stored in the X75, or SD Card List 

Presets for items in the SD card. 
3. Scroll to the preset you would like to delete, and then press Enter.
4. Select Delete Preset, and then press Enter.

The item is deleted from the list.
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Using the FAV1 and FAV2 Function
The Fav1 and Fav2 buttons store lists of favorite menu locations or 
controllable parameters. Using these buttons, you can “go to” a 
Favorite, delete a Favorite, or set a Favorite to be activated by GPI. 
The procedures described below apply when the 1 Click Fav capability 
is not enabled. If the 1 Click Fav capability is enabled (see page 177), 
you can still access the full list of favorites by following this path: 
Option button>Favorite 1 or Favorite 2.

Reaching a Favorite
To go to a favorite, follow these steps:
1. Press Fav1 or Fav2.

A menu opens with the following options:
• List Favorites
• Add Favorite

2. Select List Favorites.
3. Scroll to the desired favorite, and then press Enter.

Deleting a Favorite
To delete a favorite, follow these steps:
1. Press Fav1 or Fav2.

A menu pops up with the following options:
• List Favorites
• Add Favorite

2. Select List Favorites.
3. Scroll to the favorite you want to delete.
4. Press Fav1 or Fav2 again.

A menu opens with the following options:
• Delete Favorite 
• Move Up 
• Move Down
• Set as GPI Parameter

5. Scroll to Delete Favorite, and then press Enter. 
A confirmation box appears stating that the favorite was deleted.

Note
If the listed favorite is a menu 
mode (video M-Path), it cannot 
be set as a GPI parameter.

Note
The Move Up and Move Down 
options are used to change the 
order of the presets.



X75HD/X75SD Installation and Operation Manual 177

Chapter 10: Special Function Buttons

 

Setting a GPI Activation
To set a parameter to be activated by a GPI input signal, follow these 
steps:
1. Press Fav1 or Fav2.

A menu pops up with the following options:
• List Favorites
• Add Favorite

2. Select List Favorites.
3. Scroll to the favorite you wish activated by a GPI input signal.
4. Press Fav1 or Fav2 again to store the parameter.

A menu opens with the following options:
• Delete Favorite 
• Move Up 
• Move Down
• Set as GPI Parameter

5. Scroll to Set as GPI Parameter, and then press Enter. 
An arrow (>) is placed just before the parameter name, indicating 
that the favorite is now set as a GPI-triggered parameter.

1 Click Capability
The Favorites feature has an additional 1 Click Fav capability that 
makes it possible for you to directly access the first item in your 
favorites list, saving several steps. In this mode, the first item in the 
Favorites list appears on the screen directly, and you can execute it by 
pressing Enter.
To enable this feature, follow these steps:
1. Press the Option button.
2. Rotate the control knob and then select Setup.
3. Press the Enter button.
4. Scroll to 1 Click Fav, select Yes, and then press the Enter button.
When 1 Click Fav is enabled, the normal functionality of the Fav 1 and 
Fav 2 shortcut buttons (as described on page 176) is locked out. In this 
instance, access the Favorites by following this path: Option 
button>Favorites 1 or Favorite 2.

Note
The Move Up and Move Down 
options are used to change the 
order of the presets.
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Using the Bypass Function
In Bypass mode, no processing is applied to the SDI 1 In video signal; 
the signal is instead passed directly to the SDI 1 Out connector that is 
closest to the SDI 1 In connector. (Only one of the two SDI 1 Out 
connectors provides a bypass output.)
To activate Bypass mode, press the Bypass button. From the resulting 
Bypass Menu, select On or Off, and then press Enter. When the unit is 
powered off, or forced by the user, this relay is not energized to pass the 
signal straight through the output without any processing. The Bypass 
button flashes when the Bypass mode is active.

Using the Mo/St Button Function
The Mono/Stereo button located just left of the Ctrl button changes the 
audio channels control style. Pressing the Ctrl and Mo/St buttons 
toggles between the mono or stereo level and delay adjustments. This 
button is also mapped to the Audio Control Style parameter in the 
Audio Setup>Global Audio Config menu. 
In mono control style, when adjusting the audio processing parameters 
such as the level, each numbered button is mapped directly to the 
individual gain controls. In stereo control style, even though a single 
button is pressed, both L/R channels are adjusted at the same time. 

Using the Noise Reduction
When the X75HD/SD unit is equipped with the X75OPT-NR option, it 
provides superior noise handling and image enhancement features on 
SDTV video processing paths. Press the NR button for quick access to 
the noise reduction menu. 
The SDNR Insert parameter under the Video Setup>Processing>SD 
NR/Enhancement menu selects a video input source to be processed 
by this block. All video output groups using the video input source 
selected by the SDNR Insert parameter will automatically have the SD 
noise reducer inserted into their video processing paths.

Note
If you are working in either the 
SD-SDI or HD-SDI noise 
reducer menu, the NR button 
will light up. If either of the 
noise reducers is enabled, the 
NR button will stay lit even if 
you exit the menu. In SD-SDI, 
the enabling parameter is Noise 
Reduction; in HD-SDI the 
enabling parameter is HD NR 
Enable.
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SD NR/Enhancement
The optional video noise and artifact reducer is based on Leitch's 
AVARI (Advanced Video Artifact Reducer I) technology. This feature is 
capable of impulse noise reduction, Gaussian random noise reduction, 
compression blockiness and mosquito artifact reduction and the 
sharpening and softening of images.
The impulse noise reducer is particularly effective in reducing satellite 
noise. It automatically detects impulse noise and applies a median filter 
when necessary. To achieve the ideal setting, adjust the Impulse Noise 
Level control to reduce more impulse noise, but not to the extent that 
excessive motion artifacts are generated.
AVARI technology uses a recursive 3D directional filter that reduces 
Gaussian noise and compression artifacts, which includes the ability to 
block artifacts and mosquito noise. For ideal effectiveness, adjust the 
Noise/Artifact Level control up to see more effect on filtering, but not 
to a level where excessive blurring is visible.
The directional softening/sharpening filter can be used in various 
applications. For example, the softening filter can be used as a 
compression pre-filter to reduce mosquito noise, and the sharpening 
filter can be used to enhance picture appearance. The Soften/Sharpen 
control provides this function; a negative value achieves a softening 
effect, and a positive value results in a sharpening effect. While 
adjusting these controls, the Split Screen feature may be used to 
compare the filtered video against unfiltered video.
The overall filter delay is approximately 1 line when the Minimum 
Delay parameter is set to Yes, and approximately 1 field when set to 
No. The overall performance is slightly better when Minimum Delay is 
set to No.

HD NR/Enhancement
The HD digital noise reduction and enhancement controls are included 
as a standard feature with the HD submodule and may be applied to the 
X75HD's HD outputs.
When equipped with the X75OPT-NR option, for the up-converted HD 
output signal, you can use either (or both) of the SD or HD noise 
reduction functions. To use the SD NR/Enhancement feature in this 
case, set the SDNR Insert parameter to the appropriate SD video input 
as described in the previous section.
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Using the Test Signal Generator
An X75HD/X75SD unit provides HDTV(8-bits) and SDTV(10-bits) 
internal test signals. Table 10-9 on page 181 and Table 10-10 on 
page 182 respectively show the list of test signals for each standard, and 
these options are directly accesible through the TSG button.The SD 
Keyer and the test signals function share the same processing block. 
Using the Keyer/TSGInsert parameter in Video 
Setup>Processing>SD TSG & Slide, you can select a video source to 
be processed by this block. All video output groups using the video 
input source selected at the Keyer/TSG Insert parameter will 
automatically have the Keyer/TSG inserted into their video processing 
paths.
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Table 10-9. HDTV Test Signals

HD-SDI 1080 HD-SDI 720
Black Black

Color Bars 100% Color Bars 100%

Color Bars 75% Color Bars 75%

Color Bars 100% 4:3 Color Bars 100% 4:3

Horizontal Sweep Y-only Horizontal Sweep Y-only

Horizontal Sweep Horizontal Sweep

White White

10-Step 10-Step

5-Step 5-Step

Ramp Y-only Ramp Y-only

Ramp Ramp

Multiburst Y-only Multiburst Y-only

Multiburst Multiburst

Pluge Pluge

Aspect 4:3 Aspect 4:3

RP219-1 RP219-1

RP219-2 RP219-2

RP219-3 RP219-3

RP219-4 RP219-4



182 X75HD/X75SD Installation and Operation Manual

 
Chapter 10: Special Function Buttons

Table 10-10. SDTV Test Signals 

SD-SDI 525 SD-SDI 625
SMPTE Bars Bars 100%

EIA Bars Black

Full Field Bars Gray

Bars/Reverse White

Bars/Red Luma Ramp

Bars 100% Modulated Ramp

Black Luma 5-Step

Gray Modulated 5-Step

White Shallow Ramp

 Luma Ramp Luma Sweep 5.5MHz

 Modulated Ramp Chroma Sweep

 Luma 5-Step VIRS

 Modulated 5-Step Cross Hatch

 Shallow Ramp Pluge

Multiburst-60IRE SIN(X)/X

Luma Sweep 5.5MHz Timing Bowtie

Chroma Sweep Matrix 1

Pulse and Bar FF Bounce

NTC7 Composite SDI EQ Test

NTC7 Combination SDI PLL Test

FCC Composite Zone Plate

VIRS Bars/Red 100%

Cross Hatch EBU Bars

Pluge EBU Bars/Red

SIN(X)/X Multiburst 5.0MHz

Red Field Multiburst 5.8MHz

Timing Bowtie Multiburst 420mV
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Matrix 1 Pulse & Bar 2410t

Matrix 2 Pulse & Bar 248t

FF Bounce Pulse & Bar 2t

SDI EQ Test Luma 10-Step

SDI PLL Test Valid Ramp

Zone Plate Multipulse 5.8MHz

SDI Pathological Shallow Ramps

30 Hz VITS 17

VITS 18

VITS 19

VITS 20

VITS 330

VITS 331

Red Field 75%

Red Field 100%

Ramp 100

Ramp 120

UBM Ramps

SDI Pathological

25 Hz

Table 10-10. SDTV Test Signals (Continued)

SD-SDI 525 SD-SDI 625
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Using the ARC Function
The SD-ARC Insert parameter under the Video Setup>Processing>
ARC (SD-SDI Out) menu selects a video input source to be processed 
by the SD aspect ratio converter. All video output groups using the 
video input source selected by the SD-ARC Insert parameter will 
automatically have the SD-ARC inserted into their video processing 
path. The HD-ARC is always available for HD outputs.
The ARC button provides quick access to the ARC (SD-SDI Out) and 
ARC (HD-SDI Out) controls. When the HD video processing block is 
currently selected, pressing the ARC button takes you straight to the 
ARC (SD-SDI Out) variable controls. When the SD 1, SD 2 or Analog 
video proc amp block is currently selected, pressing the ARC button 
takes you straight to the ARC (HD-SDI Out) variable controls.
Depending on the video configuration, you must manually select the 
appropriate ARC controls to apply the settings to outputs. The 
following options are available when the ARC button is pressed:
• Aspect Ratio Lock
• H. Size
• H Position
• V Size
• V Position
The manually adjusted User settings can be saved or recalled from the 
four ARC Presets that are available from each ARC (HD-SDI Out) and 
ARC (SD-SDI Out) menus. 
The X75HD/X75SD also provides viewing modes to allow the quick 
selection of predefined input and output aspect ratios.

Note
The ARC mode requires an 
HD-SDI module to operate in 
both HD-SDI and SD-SDI 
formats.
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ARC (HD-SDI Out)
Figure 10-1 on page 186 illustrates the options in the ARC (HD-SDI 
Out) preset. The following viewing modes are available:
• Anamorphic
• Pillar Box
• Middle Cut
• 14:9 Pillar Box
• 21:9 Letter Box

ARC (SD-SDI Out)
Figure 10-2 on page 187 illustrates the options in the ARC (SD-SDI 
Out) preset. The following viewing modes are available:
• Anamorphic
• Letter Box
• Center Cut
• 14:9 Letter Box
• 21:9 Letter Box
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Figure 10-1. ARC (HD Out) View Modes
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Figure 10-2. ARC (SD-SDI Out) Viewing Modes
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Using the Timing Control
Using the Timing button, you can quickly access the currently selected 
video processing block's phase controls. When multiple input video 
sources are selected and processed, pressing the Ctrl and V Proc 
buttons allows you to switch between the processing blocks and leads 
you directly to the selected timing controls. 
The Proc LEDs on the right side of the front panel and the display show 
the currently selected and active block. 
• When the Analog processing block is selected, press the Timing 

button to access the AVFS & Timing submenu.
• When an SD processing block is selected, press the Timing button 

to access the SD1 FS & Timing or SD2 FS & Timing submenus.
• When the HD processing block is selected, press the Timing button 

to access the HD Out V-Phase parameter under the Processing 
menu, and press the Exit button to access the HD Out H-Phase 
control. 

The timing controls for the down-converted signal can be adjusted with 
the SD-ARC/HD Dn V-Ph and SD-ARC/HD Dn H-Ph controls from 
the Video Setup>Processing menu.

Using Option Controls
The Option control panel shortcut allows quick access to certain 
parameters, some of which become enabled with the purchase and 
installation of various optional modules and upgrades.
To access the list of Option parameters, press the Option button, and 
then select one of the following items: 
• History: The last ten parameters that you have viewed or modified 

appear chronologically in the History list. The most recent event 
appears at the bottom of the list. This list is deleted if the control 
panel loses its power.

• Active Alarms: Using this parameter, you can set the parameters 
for alarms on your network of X75-RCP-enabled devices. For each 
alarm, you can make the following settings:
• Trigger Time
• Clear Time
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• Priority
• Alarm Mute
• Acknowledged

• Alarms Log: The last 20 alarms (minor and major) are listed in the 
Alarms Log. This is a read-only list; it can only be cleared by 
disconnecting power to the control panel.

• Configure Alarms: Use this parameter to set the parameters for 
alarms on your network of X75-RC- enabled devices. For each 
alarm, you can access the following options:
• Trigger Time
• Clear Time
• Priority
• Alarm Mute
• Acknowledged

For a complete list of all the possible alarms, see page 323.
• Favorite 1 and Favorite 2: Use these two lists to retain the ten 

most-needed parameters. With each parameter listing that you wish 
to save, press Favorite 1 or Favorite 2 from the Options List, and 
then select Add. The message “Item added” appears. See “Using 
the FAV1 and FAV2 Function” on page 176 for more information.

• Preset: This shortcut leads you directly to the Memory menu (see 
“Using the Memory Function” on page 172).

• MuteKeepAlive: The X75HD/X75SD unit sends out a “keep 
alive” message at approximately every 15 seconds. The keep alive 
checks to determine if the device is still active and resides on the 
control network. The following options are available:
• No: The keep alive message is broadcast every 15 seconds by 

the X75 unit to be discovered by the client control systems.
• Yes: Suppresses the keep alive message unless it is requested 

by any client control system.
If the X75 is repowered with the Mute KeepAlive option set to 
Yes, a client device such as a remote control panel will not be 
able to discover the unit until the control panel is repowered.

• Home: This option returns you to the Main menu.
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• Path: Using this feature, you can establish the path of the parameter 
that you are currently viewing or adjusting. To obtain the path, 
select Path from the options list, and then press Enter. Rotate the 
control knob to view the entire path.

• Lock Panel: By selecting and entering this parameter, all card-edge 
controls are locked out, preventing accidental changes. To remove 
the Lock Panel function, press Ctrl + Exit. If you are using a 
DPS-575 or RC-575 to control the X75, press the Default + Exit 
buttons on the DPS-575 or RC-575 to remove the locked panel 
function.

• Setup: The Setup menu contains a number of parameters that affect 
how your display screen operates (see “Display Screen Setup 
Parameters” on page 191).

More information on each of these control options can be found in the 
Control Panels for X75 Systems Installation and Operation Manual.

Rebooting Shortcut
To reboot the X75HD/X75SD unit without using the power switch, 
press the SHIFT + CTL + NR buttons simultaneously.
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Display Screen Setup Parameters
The display screen Setup parameters affect the way in which the display 
screen functions on your panel. These settings do not affect how 
parameters are seen on other panels.
To access the display screen Setup Menu, follow these steps:
1. Press the Option button.
2. Rotate the control knob and select Setup.
3. Press the Enter button.
The display screen Setup parameters are described in the following 
pages.

Scroll Mode
In Wrap mode, when you scroll through menus and non-numeric 
parameters, the module considers the list as a circular set of data. When 
the last parameter in the list is reached, the first parameter in the list 
immediately follows it. In Don’t Wrap mode, the module stops when the 
last parameter in the list is displayed. To return to the first parameter, 
you must scroll through the entire list in the opposite direction. The 
Scroll Mode options globally affect all non-numeric parameters as they 
appear on the control panel where you have made this setting. Numeric 
values are not affected by Scroll Mode options.

Display Intensity
To accommodate different equipment room lighting conditions, you can 
set the panel to five levels of display intensity: 100%, 75%, 50%, and 
25%.

Screen Saver Timeout
To extend the life of the display device, the screen saver automatically 
shuts off the display after a preset period of inactivity. Using the Screen 
Saver Timeout parameter, you can set the duration of inactivity after 
which the control panel display turns off, or you can disable the screen 
saver. The available time options are 5, 10, 20, and 30 minutes.
To exit the screen saver mode, press the control knob or any button. No 
parameters will be changed when you exit the screen saver mode.
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Screen Saver Select
The screen saver can be set to either Blank or Default. The Default 
screen saver consists of a line of scrolling text.

Shaft Direction
Using this parameter, you can determine whether the clockwise rotation 
of the control knob moves a parameter list up or down. The setting of 
this parameter only applies to navigation, and does not effect the 
adjustment of numeric values. To make numeric values increase, the 
control knob must always be turned the knob clockwise. To make 
values decrease, you must always turn the knob counter-clockwise.

1 Click Favorite
The Favorites feature has an additional 1 Click Fav capability that 
makes it possible for you to directly access the first item in your 
favorites list, saving several steps. In this mode, the first item in the 
Favorites list appears on the screen directly, and you can execute it by 
pressing Enter. To enable the 1 Click Fav capability, select Yes. See 
page 177 for details.

Backlite
This feature illuminates the X75’s buttons in dark locations; buttons 
that have been activated when the Backlite is enabled will now flash. 
To enable this feature, follow this path: 
Option button>Setup>Backlite>On.



 

Section III—Appendixes
This section contains the following topics:
• “Cables and Pinouts” on page 195
• Troubleshooting on page 221
• Servicing on page 255
• Software on page 303
• Alarms on page 321
These appendixes contain extra information useful for configuring, 
operating, and servicing your X75HD/X75SD system.
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Cables and Pinouts

Overview
This appendix describes various cable options and I/O, video, and audio 
cable pinouts (both standard and optional) available for use with the 
X75HD/X75SD. The following topics are covered in this chapter:
• “Summary of Cables and Cable Sets” on page 196
• “Analog Audio Connections” on page 202
• “Multi I/O Cable (X75OPTCAB-MULTI)” on page 203
• “DVI-D Output Cable (X75OPTCAB-DVI)” on page 205
• “Audio Coax Cable (X75OPTCAB-8-C)” on page 206
• “Audio Coax Cable (CAB-X75HD-COAX)” on page 208
• “Audio BNC/XLR Cable (X75OPTCAB-8-XC)” on page 210
• “Audio BNC/XLR Cable (CAB-X75HD-COMBO)” on page 213
• “Optional Audio XLR Cable (X75OPTCAB-8-X)” on page 216
• “Optional Audio XLR Cable (X75OPTCAB-XLR)” on page 218
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Summary of Cables and Cable Sets
Table A-1 lists all of the standard and optional cables and cable sets used in 
different X75HD/X75SD packages. Details begin on page 203.

Table A-1. Cables and Cable Sets

Part Number Type Components

Multiple Input/Output Set

X75OPTCAB-MULTI Single cable X75OPTCAB-MULTI

DVI-D Output

X75OPTCAB-DVI Single cable X75OPTCAB-DVI

Audio Cables and Cable Sets

X75OPTCAB-8-C Single cable
(BNC)

X75OPTCAB-8-C

X75OPTCAB-8-X Single cable
(XLR)

X75OPTCAB-8-X
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Standard/Optional Description Major Features

Optional One cable for multi input/output 
connectors
• Sync/comp out
• Blue, Green, and Red out
• Y/C out
• SDTV and HDTV audio delay
• GPI1 and GPI2 in
• GPI1 and GPI2 out

1 ft (30 cm) multi I/O breakout cable with the 
following connector types:

• DB26(M) to 6 x BNC(F), 1 x XLR(F), 1 x 
MiniDin4(F), and 4 x RCA(F)

Optional One cable for DVI-D single-link output DVI-D to DVI-D (digital-single link) cable

Standard (X75SD) One cable for 8-channel audio 
synchronizer, with the following 
unbalanced coax AES connectors:
• AES1, AES2, and DARS in 
• AES1 and AES2 out

1 ft (30 cm) breakout cable with the following 
connector types:
• DB26(M) to 5 x BNC(F)

Optional One cable for 8-channel audio 
synchronizer, with the following balanced 
XLR AES connectors:
• AES1, AES2, and DARS in 
• AES1 and AES2 out

1 ft (30 cm) breakout cable with the following 
connector types:

• DB26(M) to 3 x XLR(F)
• 2 x XLR(M) 
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Cables and Cable Sets (Continued)

Part Number Type Components

Audio Cables and Cable Sets (Continued)

X75OPTCAB-8-CX Single cable
(BNC and XLR)

X75OPTCAB-8-CX

X75OPTCAB-16-C Cable set
(BNC)

X75OPTCAB-8-C and CAB-X75HD-COAX

X75OPTCAB-16-X Cable set
(XLR)

X75OPTCAB-8-X and CAB-X75HD-XLR
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Cables and Cable Sets (Continued)

Standard/Optional Description Major Features

Optional One cable for 8-channel audio 
synchronizer, with the following 
unbalanced coax AES and XLR 
connectors:
• AES1, AES2, and DARS in 
• AES1 and AES2 out

1 ft (30 cm) breakout cable with the following 
connector types:

• DB26(M) to 5 x BNC(F)
• 3 x XLR(F)
• 2 x XLR(M)

Standard (HD) Two cable sets for 16-channel audio 
synchronizer, with unbalanced coax AES 
connectors
• AES1, AES2, and DARS in 
• AES1 and AES2 out
• AES3, AES4, and AES5 in
• AES3, AES 4, and AES 5 out

2 X 1 ft. (30 cm) breakout cables with the 
following connector types:
• DB26(M) to 5 x BNC(F)
• DB44(M) to 6 x BNC(F)

Optional Two cable sets for 16-channel audio 
synchronizer, with balanced XLR AES 
connectors
• AES1, AES2, and DARS in 
• AES1 and AES2 out
• AES3, AES4, and AES5 in
• AES3, AES 4, and AES 5 out

2 X 1 ft (30 cm) breakout cables with the 
following connector types:

• DB26(M) to 3 x XLR(F) and 
2 x XLR(M) 

• DB44(M) to 3 x XLR(F) and 
3 x XLR(M)
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Table A-2. 

Part Number Type Components

Audio Cables and Cable Sets (Continued)

X75OPTCAB-16-CX Cable set
(BNC and XLR)

X75OPTCAB-8-CX and CAB-X75HD-COMBO
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Table A-3. 

Standard/Optional Description Major Features

Optional Two cables for 16-channel audio 
synchronizer, unbalanced coax 
AES and balanced XLR AES
• AES1, AES2, and DARS in 
• AES1 and AES2 out
• AES3, AES4, and AES5 in
• AES3, AES 4, and AES 5 out

2 X 1 ft (30 cm) breakout cables 
with the following connector types:

• DB26(M) to 5 x BNC(F), 3 x 
XLR(F), and 2 x XLR(M)

• DB44(M) to 6 x BNC(F), 3 x 
XLR(F), and 3 x XLR(M)
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Analog Audio Connections
Figure A-1 shows the analog audio input and output terminal blocks.

Figure A-1. Analog Audio Input and Output Terminal Blocks

+ G + G + G +
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+
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+
-

+
-

Analog audio input
(Left terminal from rear)

Analog audio output
(Right terminal from rear)

Step 1: Rectangular slot
Insert flathead screwdriver into a rectangular slot to open
a corresponding round connection point (above or below)

Step 2: Round Hole
Insert a stripped audio cable into a round hole and
remove the flathead screwdriver from the rectangular slot
to hold the cable.
(Note: The holes are polarized.)
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Multi I/O Cable (X75OPTCAB-MULTI)
Figure A-2 identifies the cable connectors available on the optional 
multiple input/output X75OPTCAB-MULTI cable.

Figure A-2. X75OPTCAB-MULTI Cable Connectors

Figure A-3 shows the pinouts for the X75OPTCAB-MULTI DB-26M 
connector.

Figure A-3. X75OPTCAB-MULTI I/O Connector Pinout
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Table A-4 describes each pin on the X75OPTCAB-MULTI DB-26M 
connector and its connection type.

Table A-4. X75OPTCAB-MULTI Pinout Descriptions 

Pin Number Connection Type Description
1 BNC-Gnd Sync/composite out ground

2 BNC Sync/composite out signal

3 BNC-Gnd Blue out ground

4 BNC Blue out signal

5 BNC-Gnd Green out ground

6 BNC Green out signal

7 BNC-Gnd Red out ground

8 BNC Red out signal

9 4-Pin DIN-1-Gnd
4-Pin DIN-2-Gnd

S-video (Y) ground
S-video (C) ground

10 XLR-2 Future use

11 XLR-1-Gnd Future use

12 BNC-Gnd SDTV audio delay ground

13 BNC-Gnd HDTV audio delay ground

14 RCA-Gnd GPI out 1 ground

15 RCA Gnd GPI out 2 ground

16 RCA Gnd GPI in 1 ground

17 RCA Gnd GPI in 2 ground

18 4-Pin DIN-4 S-video (C) out

19 XLR-3 Future use

20 BNC SDTV audio delay out

21 BNC HDTV audio delay out

22 RCA GPI out 1

23 RCA GPI out 2

24 RCA GPI in 1

25 RCA GPI in 2

26 4-Pin DIN-3 S-video (Y) out 
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DVI-D Output Cable (X75OPTCAB-DVI)
The optional DVI-D to DVI-D digital single-link cable connects a 
monitor to the DVI Out port on the back of the X75HD/X75SD unit. 
This is a straight connection cable with no breakouts, and a single 
DVI-D connector for digital video output.

Figure A-4. DVI-D to DVI-D Cable
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Audio Coax Cable (X75OPTCAB-8-C)
Figure A-5 identifies the cable connectors available on the AES/EBU 
audio X75OPTCAB-8-C coax cable, supplied standard with each 
X75SD unit.

Figure A-5. X75OPTCAB-8-C Cable Connectors

Figure A-6 shows the pinouts for the X75OPTCAB-8-C DB-26M 
connector.

Figure A-6. X75OPTCAB-8-C Connector Pinout

Table A-5 describes each pin on the X75OPTCAB-8-C DB-26M 
connector and its connection type.

Pin 9 S - + - + S - +

G G G G G G G GG

- S G S + - S+

AES2
out

AES1
out

DARS
in

AES1
in

AES2 in

Pin 1

Pin 10

Pin 26

Pin 18

Pin 19

Table A-5. X75OPTCAB-8-C Pinout Description 

Pin Number Connection Type Description
1 NC N/A

2 NC N/A

3 BNC Unbalanced AES1 in
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4 NC N/A

5 NC N/A

6 NC N/A

7 NC N/A

8 BNC Unbalanced AES2 out

9 NC N/A

10 BNC-GND Unbalanced DARS in 
ground

11 NC N/A

12 NC N/A

13 BNC-GND Unbalanced AES1 in 
ground

14 NC N/A

15 BNC-GND Unbalanced AES1 out 
ground

16 NC N/A

17 NC N/A

18 BNC-GND Unbalanced AES2 out 
ground

19 BNC Unbalanced DARS in

20 NC N/A

21 NC N/A

22 BNC Unbalanced AES2 in

23 BNC-GND Unbalanced AES2 in 
ground

24 BNC Unbalanced AES1 out

25 NC N/A

26 NC N/A

Table A-5. X75OPTCAB-8-C Pinout Description (Continued)

Pin Number Connection Type Description
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Audio Coax Cable (CAB-X75HD-COAX)
Figure A-7 identifies the cable connectors available on the 
CAB-X75HD-COAX cable, which is one of two parts in the 
X75OPTCAB-16-C cable set (the X75OPTCAB-8-C is the second 
cable in the set). The CAB-X75HD-COAX supports unbalanced audio 
signals. Both cables are supplied standard with each X75HD unit.

Figure A-7. CAB-X75HD-COAX Cable Connectors

Figure A-8 shows the pinouts for the X75OPTCAB-16-C DB-44M 
connector.

Figure A-8. CAB-X75HD-COAX Connector Pinout

G G SS GS S G SGG S
AES3 in AES3 outAES4 in AES5 in AES4 out AES5 out

Pin 1Pin 15

Pin 30

Pin 44 Pin 31

Pin 16
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Table A-6 describes each pin on the CAB-X75HD-COAX DB-44M 
connector and its connection type.

Table A-6. CAB-X75HD-COAX Pinout Description 

Pin Number Connection Type Description
1 through 30 NC N/A

31 BNC Unbalanced AES5 out

32 BNC-Gnd Unbalanced AES5 out 
Ground

33 BNC Unbalanced AES4 out

34 BNC-Gnd Unbalanced AES4 out 
ground

35 BNC-Gnd Unbalanced AES3 out 
ground

36 BNC Unbalanced AES3 out

37 NC N/A

38 NC N/A

39 BNC Unbalanced AES5 in

40 BNC-Gnd Unbalanced AES5 in 
ground

41 BNC Unbalanced AES4 in

42 BNC-Gnd Unbalanced AES4 in 
ground

43 BNC-Gnd Unbalanced AES3 in 
ground

44 BNC Unbalanced AES3 in
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Audio BNC/XLR Cable (X75OPTCAB-8-XC)
Figure A-9 identifies the cable connectors available on the optional 
AES/EBU X75OPT-CAB-8-XC combination BNC/XLR audio cable, 
supporting both unbalanced and balanced audio signals.

Figure A-9. X75OPTCAB-8-XC Cable Connectors

Figure A-10 shows the pinouts for the X75OPTCAB-8-XC DB-26M 
connector.

Figure A-10. X75OPTCAB-8-XC Connector Pinout

S - + - + S - +

G G G G G G G GG

- S G S + - S+
AES1 In

AES2 InAES2
Out

AES1
Out

DARS
In

DARS InAES1
In

AES1 Out

AES2 In

AES2 Out

Pin 1Pin 9

Pin 10

Pin 26

Pin 18

Pin 19
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Table A-7 describes each pin on the X75OPTCAB-8-XC DB-26M 
connector and its connection type.

Table A-7. X75OPTCAB-8-XC Pinout Description 

Pin Number Connection Type Description
1 XLR-2 Balanced DARS in (+)

2 XLR-3 Balanced DARS in (-)

3 BNC Unbalanced AES1 in

4 XLR-2 Balanced AES2 in (+)

5 XLR-3 Balanced AES2 in (-)

6 XLR-2 Balanced AES1 out (+)

7 XLR-3 Balanced AES1 out (-)

8 BNC Unbalanced AES2 out

9 NC N/A

10 BNC-GND Unbalanced DARS in 
ground

11 XLR-1-GND Balanced DARS in ground

12 XLR-1-GND Balanced AES1 in ground

13 BNC-GND Unbalanced AES1 in 
ground

14 XLR-1-GND Balanced AES2 in ground

15 BNC-GND Unbalanced AES1 out 
ground

16 XLR-1-GND Balanced AES1 out ground

17 XLR-1-GND Balanced AES2 out ground

18 BNC-GND Unbalanced AES2 out 
ground

19 BNC Unbalanced DARS in

20 XLR-3 Balanced AES1 in (-)

21 XLR-2 Balanced AES1 in (+)

22 BNC Unbalanced AES 2 in

23 BNC-GND Unbalanced AES2 in 
ground
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24 BNC Unbalanced AES1 out

25 XLR-3 Balanced AES2 out (-)

26 XLR-2 Balanced AES2 out (+)

Table A-7. X75OPTCAB-8-XC Pinout Description (Continued)

Pin Number Connection Type Description
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Audio BNC/XLR Cable (CAB-X75HD-COMBO)
Figure A-11 identifies the cable connectors available on the optional 
AES/EBU CAB-X75HD-COMBO combination BNC/XLR audio 
cable, which supports both unbalanced and balanced audio signals.

Figure A-11. CAB-X75HD-COMBO Cable Connectors

Figure A-12 shows the pinouts for the X75OPTCAB-16-CX DB-44M 
connector.

Figure A-12. CAB-X75HD-COMBO Connector Pinout

+ G + G-

G - GG

G G SS

AES3 in AES3 out

G

+ G

G

+-

G G

-

G

G G GS
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+ -G

G G G

G

S G SG

+

G S

AES4 in
AES5 in
(data) AES4 out AES5 out

(data)

AES3 in AES3 outAES4 in AES5 in (data) AES4 out AES5 out (data)

G

Pin 1Pin 15

Pin 30

Pin 44 Pin 31

Pin 16
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Table A-8 describes each pin on the CAB-X75HD-COMBO DB-44M 
connector and its connection type.

Table A-8. CAB-X75HD-COMBO Pinout Description 

Pin Number Connection Type Description
1 XLR-2 Balanced AES5 out (+)

2 XLR-3 Balanced AES5 out (-)

3 NC N/A

4 XLR-2 Balanced AES4 out (+)

5 NC N/A

6 XLR-2 Balanced AES3 out (+)

7 XLR-3 Balanced AES3 out (-)

8 NC N/A

9 XLR-2 Balanced AES5 in (+)

10 XLR-3 Balanced AES5 in (-)

11 NC N/A

12 XLR-2 Balanced AES4 in (+)

13 NC N/A

14 XLR-2 Balanced AES3 in (+)

15 XLR-3 Balanced AES3 in (-)

16 NC N/A

17 XLR-1-Gnd Balanced AES5 out ground

18 NC N/A

19 XLR-1-Gnd Balanced AES4 out ground

20 XLR-3 Balanced AES4 out (-)

21 NC N/A

22 XLR-1-Gnd Balanced AES3 out ground

23 NC N/A

24 NC N/A

25 XLR-1-Gnd Balanced AES5 in ground

26 NC N/A
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27 XLR-1-Gnd Balanced AES4 in ground

28 XLR-3 Balanced AES4 in (-)

29 NC N/A

30 XLR-1-Gnd Balanced AES3 in ground

31 BNC Unbalanced AES5 out

32 BNC-Gnd Unbalanced AES5 out 
ground

33 BNC Unbalanced AES4 out

34 BNC-Gnd Unbalanced AES4 out 
ground

35 BNC-Gnd Unbalanced AES3 out 
ground

36 BNC Unbalanced AES3 out

37 NC N/A

38 NC N/A

39 BNC Unbalanced AES5 in

40 BNC-Gnd Unbalanced AES5 in 
ground

41 BNC Unbalanced AES4 in

42 BNC-Gnd Unbalanced AES4 in 
ground

43 BNC-Gnd Unbalanced AES3 in 
ground

44 BNC Unbalanced AES3 in 

Table A-8. CAB-X75HD-COMBO Pinout Description (Continued)

Pin Number Connection Type Description
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Optional Audio XLR Cable (X75OPTCAB-8-X)
Figure A-13 identifies the cable connectors available on the optional 
AES/EBU X75OPTCAB-8-X XLR audio cable, which supports 
balanced audio signals.

Figure A-13. X75OPTCAB-8-X Cable Connectors

Figure A-14 shows the pinouts for the X75OPTCAB-8-X DB-26M 
connector.

Figure A-14. X75OPTCAB-8-X Connector Pinout

Table A-9 describes each pin on the X75OPTCAB-8-X DB-26M 
connector and its connection type.

S - + - + S - +

G G G G G G G GG

- S G S + - S+
AES1 In

AES2 In DARS InAES1 Out

AES2 Out

Pin 1Pin 9

Pin 10

Pin 26

Pin 18

Pin 19

Table A-9. X75OPTCAB-8-X Pinout Description 

Pin Number Connection Type Description
1 XLR-2 Balanced DARS in (+)

2 XLR-3 Balanced DARS in (-)

3 NC N/A
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4 XLR-2 Balanced AES2 in (+)

5 XLR-3 Balanced AES2 in (-)

6 XLR-2 Balanced AES1 out (+)

7 XLR-3 Balanced AES1 out (-)

8 NC N/A

9 NC N/A

10 NC N/A

11 XLR-1-GND Balanced DARS in ground

12 XLR-1-GND Balanced AES1 in ground

13 NC N/A

14 XLR-1-GND Balanced AES2 in ground

15 NC N/A

16 XLR-1-GND Balanced AES1 out ground

17 XLR-1-GND Balanced AES2 out ground

18 NC N/A

19 NC N/A

20 XLR-3 Balanced AES1 in (-)

21 XLR-2 Balanced AES1 in (+)

22 NC N/A

23 NC N/A

24 NC N/A

25 XLR-3 Balanced AES2 out (-)

26 XLR-2 Balanced AES2 out (+) 

Table A-9. X75OPTCAB-8-X Pinout Description (Continued)

Pin Number Connection Type Description
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Optional Audio XLR Cable (X75OPTCAB-XLR)
Figure A-15 identifies the cable connectors available on the optional 
AES/EBU X75OPTCAB-XLR audio cable, which is one of the cables 
in the X75OPTCAB-16-X set. This cable supports balanced audio 
signals.

Figure A-15. X75OPTCAB-XLR Cable Connectors

Figure A-16 shows the pinouts for the X75OPTCAB-16-X DB-44M 
connector.

Figure A-16. X75OPTCAB-XLR Connector Pinout

+ +-

- GG
AES3 in AES3 out

+

G

+- -

G -

+ -

G G

+
AES4 in AES5 in AES4 out AES5 out

Pin 1Pin 15

Pin 30

Pin 44 Pin 31

Pin 16
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Table A-10 describes each pin on the X75OPTCAB-XLR DB-44M 
connector and its connection type.

Table A-10. X75OPTCAB-XLR Pinout Description 

Pin Number Connection Type Description
1 XLR-2 Balanced AES5 out (+)

2 XLR-3 Balanced AES5 out (-)

3 NC N/A

4 XLR-2 Balanced AES4 out (+)

5 NC N/A

6 XLR-2 Balanced AES3 out (+)

7 XLR-3 Balanced AES3 out (-)

8 NC N/A

9 XLR-2 Balanced AES5 in (+)

10 XLR-3 Balanced AES5 in (-)

11 NC N/A

12 XLR-2 Balanced AES4 in (+)

13 NC N/A

14 XLR-2 Balanced AES3 in (+)

15 XLR-3 Balanced AES3 in (-)

16 NC N/A

17 XLR-1-Gnd Balanced AES5 out ground

18 NC N/A

19 XLR-1-Gnd Balanced AES4 out ground

20 XLR-3 Balanced AES4 out (-)

21 NC N/A

22 XLR-1-Gnd Balanced AES3 out ground

23 NC N/A

24 NC N/A

25 XLR-1-Gnd Balanced AES5 in ground

26 NC N/A
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27 XLR-1-Gnd Balanced AES4 in ground

28 XLR-3 Balanced AES4 in (-)

29 NC N/A

30 XLR-1-Gnd Balanced AES3 in ground 

31 through 44 NC N/A

Table A-10. X75OPTCAB-XLR Pinout Description (Continued)

Pin Number Connection Type Description
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Troubleshooting

Overview
The following appendix describes some of the more common problems 
you might encounter while using the X75HD/X75SD, and it offers tips 
on how to correct these problems.
The following problems areas are covered:
• “Network Connectivity” on page 222
• “Front Panel Display” on page 225
• “Video Conversion” on page 231
• “Audio” on page 235
• “Alarms” on page 240
• “Softkey Installation” on page 242
• “Flash Memory” on page 244
• “Upgrading Firmware” on page 247
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Network Connectivity

Forgotten IP address
Problem
You can’t remember the set IP address for a specific X75HD/SD unit 
and are having a problem communicating with it on the network.

Solution 
Temporarily set the unit into the factory default IP Address. Follow 
these steps to set the default IP address:
1. Push the Def IP DIP switch on the back of the unit to the down 

position (see Figure B-1).
This resets the unit to the following default network addresses:
• Device IP: 192.168.100.250
• Subnet mask: 255.255.255.0
• Gateway: 192.168.100.250

Figure B-1. Location of DEF IP DIP Switch

Push this tab down to enter the 
Default IP mode
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2. Launch the X75 Web browser software, and then navigate to the 
System Config>Setup menu.

3. Select the Device IP parameter to view the currently set IP address 
and then use this IP address to access the unit again.

4. Return the Def IP DIP switch to the up position.
5. Reboot the system.
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No response to SNMP Walk command
Problem
After writing the SNMP configuration settings back to the X75HD/
X75SD using the CCS CoPilot/Pilot/Navigator application, the unit 
does not respond to the SNMPWalk command. 

Solution
Obtain and reinstall the latest version CCS application from Leitch and 
then rewrite the SNMP configuration back into the X75HD/X75SD 
unit. (CCS CoPilot/Pilot 2.99 and Navigator 2.1 do not write back the 
proper community strings within the x75agent.xnv file.)

To install the X75 agent configuration file work-around manually, 
follow these steps: 
1. Start up a DOS box from the Windows application and then go to 

the C:\ directory.
2. Use the following ftp commands to read out the x75agent.xnv file 

from the X75:
• ftp <ip address of x75 frame>
• User: leitch
• Password: LeitchAdmin (case sensitive)
• Get x75agent.xnv

3. Edit the x75agent.xnv file with a Notepad application.
4. Go to the [v1v2cCommunityTbl] section and then edit the lines as 

shown below:
(The public and private community names can be anything.)
• 1=public readOnly(2)
• 2=private readCreate(4)

5. Write the edited file back to X75 by issuing the command: put 
x75agent.xnv

6. Type bye to exit ftp session.
7. Reboot the X75 frame.
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Front Panel Display

Control panel display is blank
Problem
Even though the unit has been powered up, no information appears on 
the VFD screen. However, the LEDs on the control panel seem to be 
functioning.

Solution 1
The F.S. (fail-safe) switch at the back of the X75 is in the down position 
(see Figure B-2); this is preventing the unit from booting up properly. 
When the switch is down, the runtime code is suspended, and only the 
FTP port is opened for the file transfer.
Restore the switch to the up position, and then re-power the unit to see 
if it reboots correctly.

Figure B-2. Fail-safe Switch

Ensure the F.S. switch is in 
the up position
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Solution 2
Some of the early X75 and X75-RCP units have experienced premature 
failure of capacitor C38 (part # 101-000067-00; see Figure B-3 on 
page 227) made by Vishay (part # VJ1210Y334J(K)XBAT). This 
results in a blank VFD (Vacuum Florescent Display). 
Obtain the serial number of the X75HD/X75SD unit and the original 
PO number. Then contact Leitch customer support. The front control 
panel assembly (part number 170-000483-00) will be exchanged free of 
charge. No special programming or configuration is required.
The failure nature of this C38 capacitor is that it slowly builds up the 
resistance in an inverse way that eventually shorts out the power line 
supplying the power to the VFD. The resistance across this capacitor 
should be more than several thousand ohms, but failed capacitors are 
measured below several hundred ohms.
The VFD will function without this DC filtering capacitor. If your 
situation is urgent, carefully remove or replace this capacitor. Follow 
these steps to remove and replace the capacitor:
1. Pull the frame 2 inches from the rack and then remove a total of 14 

screws from the top and bottom of the front panel assembly. 
2. Detach the front panel from the chassis by gently pulling the panel 

forward. 
(There is a mating connector on the left side of the chassis.)

3. Remove and replace the defective capacitor.
See “Installing a Frame-Mounted Local Control Panel” on page 263 for 
more details.
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Figure B-3. Location of Failed Capacitor Behind VFD

Solution 3
If you have verified that capacitor C38 is good, but there is still no 
display on the VFD, it is most likely that the VFD (part number 
123-000003-00) has failed. 
Contact Leitch customer service for a Returned Merchandise 
Authorization (RMA) number. Then return or exchange the control 
panel assembly (part number 170-000483-00).

Capacitor C38
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Analog input video control menu is not showing up
Problem
The menus on the VFD appear to be functioning normally, but the 
Analog Input Video control menu does not appear, or it seems to 
appear randomly.

Solution 1
If the appearance of the Analog Input Video menu is random, the 
software version of the unit is 1.4 and therefore, an upgrade to version 
1.5 or greater is required.
Visit http://www.leitch.com/custserv/WebDL.nsf/
FF?OpenForm&X75HD/X75SD and then download the latest version 
of the software. Open up the Release Notes file for the update 
instructions, and then proceed with the firmware upgrade.

Solution 2
The X75OPT-PQM or X75OPT-A3D module, or its interconnecting 
stacker pins are not installed correctly. To remove and reinstall the 
module, follow these steps:
1. Remove the X75HD/X75SD from the rack, and then open the lid.
2. Remove the X75OPT-A3D or X75OPT-PQM submodule from the 

mainboard.
3. Inspect the stacker pins for proper installation and connection.

(See “Installing and Removing X75OPT-A3D or X75OPT-PQM 
Modules” on page 274 for more information.)

4. Re-install the submodule and lid.
5. Install the frame back into the rack and verify the presence of the 

Analog Input Video menu upon power up. 

Solution 3
The X75OPT-A3D or X75OPT-PQM submodule may be defective. If 
another A3D or PQM submodule is available, swap the submodule to 
determine if the original is defective.
If the submodule is proven defective, contact Leitch customer service 
for an RMA number, and then return the module to Leitch.



X75HD/X75SD Installation and Operation Manual 229

Appendix B: Troubleshooting

 

Power LEDs are off and there is no display on the LCP
Problem
The local control panel appears to be “dead.” There are no functioning 
LEDs, no buttons are lit, and the VFD is blank.

Solution 1
The unit is not receiving power. The AC cord(s) have become loose. 
Ensure the power cords are firmly pressed into the unit.

Solution 2
The internal power supply is defective. Open the lid of the X75HD/
X75SD, and using a voltage meter, determine if the power supply is 
producing +24VDC on the main DC cable(s). See Figure B-4 for the 
location of the power supply and Table B-1 on page 230 for pinout 
information.

Figure B-4. Location of Power Supplies DC Cables

Pin 6

Pin 1
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Solution 3
The internal flash memory is corrupted or locked up. See page 244 for 
details on restarting the flash memory. 

Table B-1. Main DC Cable Pinouts

Pin 1 Pin 2 Pin 3 Pin 4 Pin 5 Pin 6
+24V +24V +24V Ground Ground Ground
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Video Conversion

Performing an HD cross-conversion but can’t see the 
down-converted signal

Problem
The X75HD is taking 1080i input and forcing the output HD standard to 
720p for cross-conversion, but the down-converted signal is not present 
at the SDTV outputs. There is no visible SDTV content.

Solution:
The unit does not have the softkey option that makes it possible to 
perform simultaneous crossconversion and downconversion. Purchase 
and install the X75OPT-HDDUOCON software key option.
Follow these steps to purchase and install the HDDUOCON option:
1. Confirm the option is not installed by following this path: 

System Config>Status/Version Info>S/W Options
The word HDDUOCON will display if the option is installed.

2. If the option is not installed, follow this path to find and record the 
unit’s serial number:
System Config>Status/Version Info>Serial Number 

3. Contact Leitch’s sales department and then purchase the option.
Enter the softkey using either an X75HD/X75SD control panel, the 
X75HD/X75SD Web Browser, or a CCS software application. (The 
valid key character sets are numbers 2~9 and letters A~Z.)

To enter a softkey number using the control panel, follow these steps:
1. Select System Config>Setup>License Key.
2. Use the control knob and the Enter button to enter the characters.
3. Press the Exit button when completed.

1080i/59.94 HD1 input // ==== Internal processing ==== // HD output 720p/59.94

+ ==== // SD output No visible HD content
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To enter the softkey number using the Web Browser, follow these steps:
1. Type the IP address of the X75HD/X75SD unit you are upgrading 

into the Address field of your browser (Figure B-5).

Figure B-5. IP Address Insertion to Add X75OPT-HDDUOCON Option

2. Navigate to System Config>Setup>License Key.
3. Type in the supplied softkey codes.

The option should now function.

To enter the softkey number using a CCS software application, follow 
these steps:
1. With your X75HD/X75SD unit selected in CoPilot, click the 

Device tab in the Configuration window.
2. Type your license key in the License Key field.
3. Click the Write and Reboot button.

The writing process includes a validation step to prevent you from 
writing an invalid license key.

Address field
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Won’t perform up and down conversions simultaneously
Problem:
The unit performs upconversions and it performs downconversions, but 
not both at the same time.

Solution:
The unit does not have the softkey option that makes it possible to 
perform simultaneous crossconversion and downconversion. Purchase 
and install the X75OPT-HDDUOCON software key option.
Follow these steps to purchase and install the HDDUOCON option:
1. Confirm the option is not installed by following this path: 

System Config>Status/Version Info>S/W Options
The word HDDUOCON will display if the option is installed.

2. If the option is not installed, follow this path to find the unit’s serial 
number:
System Config>Status/Version Info>Serial Number 

3. Contact Leitch’s sales department and then purchase the option.
Enter the softkey using either an X75HD/X75SD control panel, the 
X75HD/X75SD Web Browser, or a CCS software application. (The 
valid key character sets are numbers 2~9 and letters A~Z.)

To enter a softkey number using the control panel, follow these steps:
1. Select System Config>Setup>License Key.
2. Use the control knob and the Enter button to enter the characters.
3. Press the Exit button when completed.

To enter the softkey number using the Web Browser, follow these steps:
1. Type the IP address of the X75HD/X75SD unit you are upgrading 

into the Address field of your browser (see Figure B-6 on 
page 234).
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Figure B-6. IP Address Insertion to Add X75OPT-HDDUOCON Option

2. Navigate to System Config>Setup>License Key.
3. Type in the supplied softkey codes.

The option should now function.

To enter the softkey number using a CCS software application, follow 
these steps:
1. With your X75HD/X75SD unit selected in CoPilot, click the 

Device tab in the Configuration window.
2. Type your license key in the License Key field.
3. Click the Write and Reboot button.

The writing process includes a validation step to prevent you from 
writing an invalid license key.

Address field
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Audio 

Lip sync problems
Problem 1
During normal audio processing, the audio and video are out of sync.

Solution 1
Each audio sample rate converter (SRC) can be configured to 
automatically track the processing delay of one of the video outputs. To 
apply the internal audio tracking feature, follow this path: 
Audio Setup>Global Audio Config>I/O Delay Config and then select 
one of the four or eight I/O Delay SRCx parameters.
To synchronize the audio, assign the output video type to the associated 
audio SRC(s).
The I/O Delay SRCx parameters are responsible for compensating the 
internal video propagation delay such that the audio channels are 
delayed in correct amount with respect to the chosen video output. 
Depending on the enabled internal processing options and signal path, 
the processed video's delay may vary from a few microseconds to 
several frames. Therefore, the aggregation of video delay is derived at 
the output as the I/O delay signal to be passed to the audio synchronizer 
to match the audio-to-video delay automatically.
Figure B-7 on page 236 illustrates how the I/O Delay signal is derived 
in SDI-to-SDI signal processing when some of the processing block(s) 
are activated. Some of the processing blocks that can be applied to the 
signal include SD ARC, Noise Reduction, User Fixed Delay. 
Due to the flexibility of the M-Path mode, the default setting for this 
parameter is None and this selection sets the X75 in Delay Only mode. 
When any one of the I/O Delay SRCx parameters is set to track certain 
output video, the Autotrack LED on the control panel is lit. 
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Figure B-7. I/O Delay Signal 

Problem 2
When passing the compressed audio via the AES input or embedded 
paths, the audio and video are out of sync.

Solution
A proper system configuration must be created. If the X75HD/X75SD 
is set to run in External Reference lock mode and the reference signal 
is applied, the source signal (including the audio) also must be locked to 
the same reference. Otherwise, the X75's internal frame sync will repeat 
or drop the video frame as the input and output clocks drift from each 
other. This will affect the lip sync over periods of time. Also, if the 
source device driving the X75HD/X75SD has an internal frame sync, it 
may cause pops or clicks on the downstream device as it drops or repeat 
frames.
If the source cannot be locked, the X75 must run in delay mode. This is 
done by selecting Genlock Lock Source as the current video input. 
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Application Example
The application example below describes how to set the X75 for Delay 
mode operation.
The X75HD takes a 1080i or 720p HD signal with embedded audio that 
is compressed, and at the output, provides fixed 720p with embedded 
audio. It is assumed that the Dolby embedded audio is present in one of 
the AES channels in group1’s audio space. The X75HD is set up in 
delay mode, locking to HD video input. Thus, the synchronization of 
video and audio is not possible. However, you can activate the video 
ProcAmp function, making it possible to adjust video levels, video 
delay, audio delay, and other parameters.
Make the following settings to the X75 unit:

Video Parameters
• Video Setup>HD Input>HD Input Std Select = Auto
• Video Setup>Routing Setup>All Out Sel = HD1
• Video Setup>Digital Output>HD Out Std Select = 720p/59.94

Reference Parameters
• Reference Setup>Genlock Lock Source = HD

Audio Parameters
• Audio Setup>Routing>Audio In Src Select = HD
• Audio Setup>Global Audio Config>I/O Delay Config>I/O 

Delay SRC1 = HD Out
• Audio Setup>Global Audio Config>I/O Delay Config>I/O 

Delay SRC2 = HD Out
If the lip sync problem still occurs, decode the compressed audio to the 
baseband using the internal plug-in Dolby decoder module in the X75 
and then re-encode again.
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Not passing the embedded audio
Without the optional audio submodule, the SD-SDI with embedded 
audio will pass through the SD-SDI output. The HD-SDI signal with the 
embedded audio will not pass through the HD-SDI output.
When the video frame sync repeats or drops a frame, or if there is a 
hot-switch, there will be a disturbance in the embedded audio data 
stream. This occurs with any video frame sync that passes embedded 
audio with no embedded audio processing.
When the X75SD unit has no audio submodule installed, the default 
factory setting will not allow the audio to pass. To change this setting, 
follow this path:
Video Setup>Processing>SD TSG & Slide>Keyer TSG Insert = 
None
Additionally, there is an implementation issue with X75 version 1.6.100 
and below.
When the frame is rebooted or the Video Input source is switched, the 
Keyer TSG Insert parameter follows the selected input video source. 
In order to pass the embedded audio again, this parameter must be set to 
None again.
This issue will be addressed in the subsequent software release.
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Analog input audio control menu not showing up
Problem
The menus on the VFD appear to be functioning normally, but the 
Analog Input Audio control menu does not appear, or it seems to 
appear randomly.

Solution 1
If the appearance of the Analog Input Audio menu is random, the 
software version of the unit is 1.4 and therefore, an upgrade to version 
1.5 or greater is required.
Visit http://www.leitch.com/custserv/WebDL.nsf/
FF?OpenForm&X75HD/X75SD and then download the latest version 
of the software. Open up the Release Notes file for the update 
instructions, and then proceed with the firmware upgrade.

Solution 2
The X75OPT-AS-8 or X75OPT-AS-16 audio submodule, and or its 
interconnecting stacker pins, are not installed correctly. Follow these 
steps to remove and reinstall the module:
1. Remove the X75HD/X75SD from the rack, and then open the lid.
2. Remove the X75OPT-AS-8 or X75OPT-AS-16 submodule from the 

mainboard.
3. Inspect the stacker pins for proper installation and connection.

(See “Installing and Removing an Audio Synchronizer Module” on 
page 264 for more information.)

4. Re-install the submodule and lid.
5. Install the frame back into the rack and verify the presence of the 

Analog Input Audio menu upon power up. 

Solution 3
The X75OPT-AS-8 or X75OPT-AS-16 submodule may be defective. If 
another module of the same type is available, swap the module. If the 
submodule is proven defective, contact Leitch customer service for an 
RMA number, and then return the module to Leitch.
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Alarms

Major and Minor Alarms are on
Problem
When the unit is powered up, all or many of the Alarm LEDs and 
network alarms are activated.

Solution 1
The X75 monitors all video and audio inputs, fans, and power supplies. 
When it detects failure conditions, it activates alarms because the 
factory default is set to monitor all alarms. You can globally disable all 
of the alarms, or manually enable only those that you want to monitor. 

To globally disable all of the alarms in the X75HD/X75SD control 
panel and in the Web browser, follow this path:
System Config>Alarm Assert Setup>Enable All Alarms and then 
select Disable.

Solution 2
You can choose to disable specific alarms, while leaving others 
activated.

To configure and activate only the alarms that you wish to monitor, 
using the X75HD/X75SD control panel, follow these steps:
1. Press the Option button and then select the Configure Alarm 

menu.
2. Select the desired alarm parameter by pressing the Enter button.
3. Within this parameter menu, configure the alarm appropriately. 

To configure and activate only the alarms that you wish to monitor, 
using the Web Browser, follow these steps:
1. Open up your Internet browser.
2. Type the IP Address of the X75 frame on the Address field (see 

Figure B-8).
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Figure B-8. IP Address Insertion to Access X75HD/X75SD Alarms

3. From the Main web page, select the Monitoring hyperlink.
4. Select the Configure Alarms hyperlink.
5. Press the Edit button corresponding to the alarm that you wish to 

enable and configure it.

Address field
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Softkey Installation

Can’t activate softkeys
To activate software options that you have purchased (including Dolby 
decoding) you must enter a softkey code into the License Key menu. 
The code, consisting of fourteen hexadecimal digits, will be provided 
when you purchase the option. Enter the softkey using either an 
X75HD/X75SD control panel, the X75HD/X75SD Web Browser, or a 
CCS software application. (The valid key character sets are numbers 
2~9 and letters A~Z.)

To enter a softkey number using the control panel, follow these steps:
1. Select System Config>Setup>License Key.
2. Use the control knob and the Enter button to enter the characters.
3. Press the Exit button when completed.

To enter the softkey number using the Web Browser, follow these steps:
1. Type the IP address of the X75HD/X75SD unit you are upgrading 

into the Address field of your browser (Figure B-9).

Figure B-9. IP Address Insertion to Add X75OPT-HDDUOCON Option

2. Navigate to System Config>Setup>License Key.
3. Type in the supplied softkey codes.

The upgrade will now take effect.

To enter the softkey number using a CCS software application, follow 
these steps:
1. With your X75HD/X75SD unit selected in CoPilot, click the 

Device tab in the Configuration window.
2. Type your license key in the License Key field.

Address field



X75HD/X75SD Installation and Operation Manual 243

Appendix B: Troubleshooting

 

3. Click the Write and Reboot button.
The writing process includes a validation step to prevent you from 
writing an invalid license key.

There is a different procedure for installing free firmware upgrades that 
appear on the Leitch Web site. See “Appendix D: Software” on page 
303 for details.
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Flash Memory

Flash memory is locked
Problem
The firmware update process was interrupted either by turning off the 
unit or breaking from the PC during the file transfer. The flash memory 
is now locked up.

Solution
A manual unlock procedure is required. Follow these steps to unlock 
the flash memory:
1. Push both Def IP and F.S. (Fail-safe) DIP switches at the back of 

the X75 unit to the down position, and then re-power the unit (see 
Figure B-10).
(This action sets the unit with the default IP of 
192.168.100.250 and opens the FTP port for the file transfer.) 

Figure B-10. Location of Def IP and FS DIP Switches

Push this tab down to enter the 
Default IP mode

Push this tab down to enter the 
Fail-safe mode
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2. Configure your PC's network setting to be on the same static 
network, using the network addresses shown in Table B-2.

3. Connect a cross-over Ethernet cable between the X75HD/X75SD 
and the PC directly, or a straight Ethernet cable when the PC and 
X75HD/X75SD are on a network hub or a switch.

4. Ping 192.168.100.250, and then press the ENTER button on 
your keyboard.
If the network connection is valid, the reply messages should be 
returned.

5. Type the following text: TELNET 192.168.100.250, and then 
press ENTER.

6. Type the following case sensitive login information into the Telnet 
session: 
a. login: leitch and then press ENTER
b. Password: LeitchAdmin and then press ENTER

7. In the Telnet session, follow these steps:
a. In the .vxWorks shell, type: m 0x4000000,2

and then press ENTER (there is a single space after the letter 
m).
You will be prompted with:    0x4000000: xxxx

b. Type in:    6060 
and then press ENTER
You will be prompted with: 0x4000002: xxxx - 

c. Press ENTER.
You will be prompted with: 0x4000004: xxxx - 

Table B-2. Network Addresses for Default IP and Fail-safe 
Modes

Network 
Settings X75HD/X75SD Unit PC

IP Address 192.168.100.250 192.168.100.2

Subnet 255.255.255.0 255.255.255.0

Gateway 192.168.100.1 192.168.100.1
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d. Type in:    d0d0 
and then press ENTER (Note: These are numeric zeroes)
You will be prompted with:   0x4000006: xxxx - 

e. Type in:    q 
and then press ENTER.

8. Close the Command Prompt DOS Box to quit the Telnet session.
9. Obtain the latest version of the release software from the Leitch 

Web site and then follow the instruction to upload the files.
10. When completed, put both the Def IP and F.S. DIP switches at the 

back of the X75 unit to the up position.
11. Reboot the X75HD/X75SD unit.
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Upgrading Firmware

Software can’t upload
Problem: 
Many attempts were made to update the X75HD/X75SD software, but 
there are network problems interfering with the procedure.

Solution: 
It’s likely that the file system became corrupted. In this case, the frame 
can be updated by using both the Fail-safe and Default IP switches. 
Follow these steps to correct the problem:
1. Push both Def IP and F.S. (Fail-safe) DIP switches at the back of 

the X75 unit to the down position, and then re-power the unit (see 
Figure B-11).
(This action sets the unit with the default IP of 
192.168.100.250 and opens the FTP port for the file transfer.) 

Figure B-11. Location of Def IP and FS DIP Switches

Push this tab down to enter the 
Default IP mode

Push this tab down to enter the 
Fail-safe mode
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2. Configure your PC's network setting to be on the same static 
network, using the network addresses shown in Table B-3.

3. Connect a cross-over Ethernet cable between the X75HD/X75SD 
and the PC directly, or a straight Ethernet cable when the PC and 
X75HD/X75SD are on a network hub or a switch.

4. Ping 192.168.100.250, and then press the ENTER button on 
your keyboard.
If the network connection is valid, the reply messages should be 
returned.

5. Type the following text: TELNET 192.168.100.250, and then 
press ENTER.

6. Type the following case sensitive login information into the Telnet 
session: 
a. login: leitch and then press ENTER
b. Password: LeitchAdmin and then press ENTER

7. In the Telnet session, follow these steps:
a. In the vxWorks shell, type: m 0x4000000,2

and then press ENTER (there is a single space after the letter 
m).
You will be prompted with:    0x4000000: xxxx

b. Type in:    6060 
and then press ENTER
You will be prompted with: 0x4000002: xxxx - 

c. Press ENTER.
You will be prompted with: 0x4000004: xxxx - 

Table B-3. Network Addresses for Default IP and Fail-safe 
Modes

Network 
Settings X75HD/X75SD Unit PC

IP Address 192.168.100.250 192.168.100.2

Subnet 255.255.255.0 255.255.255.0

Gateway 192.168.100.1 192.168.100.1
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d. Type in:    d0d0 
and then press ENTER (Note: These are numeric zeroes)
You will be prompted with:   0x4000006: xxxx - 

e. Type in:    q 
and then press ENTER.

8. Close the Command Prompt DOS Box to quit the Telnet session.
9. Obtain the latest version of the release software from the Leitch 

Web site and then follow the instruction to upload the files.
10. When completed, put both the Def IP and F.S. DIP switches at the 

back of the X75 unit to the up position.
11. Reboot the X75HD/X75SD unit.
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RCP is not booting up properly after upgrade
Problem: 
An X75HD/X75SD batch file was accidently uploaded to an X75-RCP. 
Now the Remote Control Panel is not booting up properly. The VFD 
screen appears “dead” and none of the buttons and LEDs are lit.

Solution: 
It is likely that the remote control panel is in fail-safe mode, with the 
factory default IP Address of 192.168.100.251. (Holding down the 
Bypass button for 3 seconds on power reboot forces the RCP into the 
manual fail-safe mode.)
Follow the instructions below to restart the RCP:
1. Configure your PC's network setting to be on the same static 

network, using the network addresses shown in Table B-4.

2. Connect a cross-over Ethernet cable between the X75HD/X75SD 
and the PC directly, or a straight Ethernet cable when the PC and 
X75HD/X75SD are on a network hub or a switch.

3. Ping 192.169.100.250, and then press the ENTER button on 
your keyboard.
If the network connection is valid, the reply messages should be 
returned.

4. If you receive successful replies, continue with step 4; otherwise, 
troubleshoot the networking connectivity.

5. Download and unzip the latest X75-RCP files to a directory such as 
C:\X75RCP.

Table B-4. Network Addresses for Default IP and Fail-safe 
Modes

Network 
Settings X75HD/X75SD Unit PC

IP Address 192.168.100.250 192.168.100.2

Subnet 255.255.255.0 255.255.255.0

Gateway 192.168.100.1 192.168.100.1
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6. Go to the directory where the RCP files are extracted.
Note: This assumes you had downloaded and unzipped the latest 
X75-RCP files to C:\X75RCP directory. For example: 
CD \X75RCP <ENTER> 

7. Within this directory, type the following:
x75rcp 192.168.100.251, and then press ENTER.

8. Reboot the panel. 
(Note: When the RCP files are restored properly, the RCP's IP Address 
will go back to its original address.)
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Software file updated incorrectly or became corrupted
During a firmware upgrade, if your files become corrupted, you can put 
the system into a fail-safe mode. To enter the fail-safe mode and 
upgrade your firmware, follow these steps:
1. Ensure your X75HD/X75SD is either connected to the network 

using a 10/100Base-T straight-through Ethernet cable or is directly 
connected to a PC using a cross-over cable.

1. Push down the F.S. DIP switch on the back of the X75HD/X75SD 
unit (see Figure B-12). 
All programs and current activity will cease, except for the 
capability to upload new software via FTP.

Figure B-12. Location of the F.S. (Fail-safe) DIP Switch

2. Push down the F.S. DIP switch on the back of the unit to put the 
X75HD/X75SD system into Fail-Safe mode.

3. Launch CoPilot on the remotely or directly connected PC.
4. Follow the procedure in your CoPilot User Manual or online help 

system for “Updating the Software on a CCS Device.”
5. Return the F.S. DIP switch to the up position, and then reboot your 

system.

Note
CCS CoPilot is a 
Windows-based software 
application provided with your 
X75HD/X75SD system that 
discovers devices on your 
network, and allows you to 
configure all system IP address 
settings (such as IP Address, 
Default Gateway, Subnet Mask, 
etc.). The current release of your 
X75HD/X75SD system only 
provides limited support for 
CoPilot. Contact your Leitch 
customer support representative 
for more information.

Push this tab down to enter the 
Fail-safe mode

Note
After rebooting, the network 
address settings of the X75HD/
X75SD should have been 
retained. If not, navigate to 
System Config>Setup, and 
then change or validate the 
settings. Ensure that you select 
Save IP.
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Troubleshooting the Software Installation
If you are not able to ping the X75HD/X75SD from your PC, the cause 
may be one of the following:
• The X75HD/X75SD is not powered up.
• The Ethernet cabling between your PC, the X75HD/X75SD, and 

any other network devices—such as hubs, switches, or routers—is 
not set up properly.

• You connected to the wrong Ethernet port on the back of your PC.
• During the “Correcting a Failed Upgrading Procedure”:

• An improper network cable was used.
• The network cable was connected to the Streaming port of the 

X75.
• The PC network settings and the X75HD/X75SD network settings 

don’t have matching subnets and/or belong to different subnets with 
no proper gateway linking the two networks together.

• The PC and the X75 have the same IP address.
• On the PC, you accidentally changed the network settings on the 

wrong LAN card.
6. If all of these causes have been investigated and the upgrade 

continues to fail, follow the instructions in “Correcting a Failed 
Upgrade Procedure” on page 310.
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Servicing

Overview
This appendix includes the following information and procedures:
• “Safety Precautions” on page 256
• “Understanding and Working With Fiber Optics” on page 257
• “Preparing the X75HD/X75SD for Servicing” on page 261
• “Common Replacement Part Numbers” on page 262
• “Installing the X75OPT-HDDUOCON Software Key” on page 262
• “Installing a Frame-Mounted Local Control Panel” on page 263
• “Installing and Removing an Audio Synchronizer Module” on 

page 264
• “Installing and Removing HDTV Modules” on page 269
• “Installing and Removing X75OPT-A3D or X75OPT-PQM 

Modules” on page 274
• “Installing and Removing the Streaming Module” on page 279
• “Installing Noise Reduction, Auto Audio/Video Timing, and Audio 

Limiter Software Options” on page 285
• “Installing a Dolby Decoder Module” on page 288
• “Replacing a Power Supply” on page 290
• “Installing a Redundant Power Supply” on page 293
• “Installing Fans” on page 299
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Safety Precautions
Only qualified personnel should perform service procedures. Refer to 
the X75HD/X75SD Product Safety Instructions booklet before servicing 
the X75HD/X75SD or its components.

Laser Caution
This product may contain lasers! Heed the following caution:

ESD Caution
When servicing the X75HD/X75SD and its components, take the 
proper precautions to avoid electrostatic discharge (ESD).

Laser Radiation When Open
CAUTION: To avoid damage from laser radiation, do not 
remove or displace any connections or protective panels.

CLASS 1
LASER PRODUCT

CLASS 1 LASER PRODUCT

[Finland] LUOKAN 1 LASERLAITE.
[Sweden] KLASS 1 LASER APPARAT.

Preventing Electrostatic Discharge
CAUTION: Electrostatic discharge (ESD) can damage components in the product. To prevent 
ESD, observe these precautions when directed:

• Use a ground strap. Wear a grounded wrist strap to discharge the static voltage from your body 
while installing or removing sensitive components.

• Use a safe work area. Do not use any devices capable of generating or holding a static charge 
in the work area where you install or remove sensitive components. Avoid handling sensitive 
components in areas that have a floor or benchtop surface capable of generating a static charge.

• Handle components carefully. Do not slide sensitive components over any surface. Do not 
touch exposed connector pins. Handle sensitive components as little as possible.

• Transport and store carefully. Transport and store sensitive components in a static-protected 
bag or container.
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Understanding and Working With Fiber Optics
Input and output modules using optical fibre transmitters and receivers 
were developed in response to a growing demand for a flexible method 
of transporting very high speed digital video and audio over long 
distances.
Fiber optic technology offers many benefits over copper wire systems:
• Longer distance capability
• Higher bandwidth
• Better signal quality
• Immunity from EM radiation and lightning
• Advantage of being lightweight
• Ability to be easily upgraded

Basic Principles
Fiber optic technology can be explained using these two concepts:
• Light is transmitted over optical fiber by reflecting it within a long 

“cylindrical mirror.”
• The mirrored surface occurs at the core cladding interface. By 

sending on/off bursts of light within the optical fiber, light can be 
guided along varying paths. 

See Figure C-1 and Table C-1 on page 258 for further explanation.

Figure C-1. Fiber Optic Transmitting and Receiving

Laser 
diode

Pin photo 
diode

Cross section

Core

Cladding

Optical transmitter

Optical receiver
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Handling and Connecting Fibers
Class 1 Laser Products

The X75OPT-HDUPG module with HDTV fiber input/output is a 
CLASS 1 laser product.
Avoid looking directly at a laser. Laser radiation is invisible and can 
cause serious eye damage.

Table C-1. Function and Description of Fiber Optic Components

Item Function Composition
Optical transmitter Converts a data signal into 

an equivalent optical power 
waveform and couples it 
into an optical fiber.

• Laser diode
• Laser diode driver
The role of the driver is to bias the laser. Some laser 
drivers contain circuitry to control power and temperature.

Optical receiver Converts the incoming 
optical power signal into an 
output data signal.

• PIN photo diode
• Transimpedance amplifier
• Decision circuitry
The receiver circuitry provides standard ECL outputs 
based on the input voltage.

Caution
USE OF CONTROLS OR 
ADJUSTMENTS OR 
PERFORMANCE OF 
PROCEDURES OTHER 
THAN THOSE SPECIFIED IN 
THIS MANUAL MAY 
RESULT IN HAZARDOUS 
RADIATION EXPOSURE. LASER

!DANGER!
Class 1 Laser Product
Avoid Direct Exposure
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General Precautions
Please take the following precautions when working with fiber optics:
• Never touch the end face of an optical fiber.
• Do not place optical fibers under heavy objects.
• Transmission characteristics of the fiber are dependent on the shape 

of the optical core; therefore, care must be taken to prevent fiber 
compression.

• Avoid abrupt fiber bending. 
A suggested minimum bending radius is 1.2 in. (3 cm). Bending 
radii smaller than this can lead to fiber bending loss which will 
decrease the maximum attainable link length by decreasing the 
available power budget.

• Make fiber interconnections very secure.
• Clean fiber every time that it is mated or unmated. (See “Cleaning 

Optical Fibers” below.) 
As dust particles on the ends of the optical fiber can add up to 1 dB 
of loss, it is important to clean them regularly. Larger dust particles 
can totally obscure light altogether.

• Cover a fiber immediately when unmated. 
Most fiber manufacturers provide a plastic boot that fits over the 
ferrule body for this purpose.

• Remove dust particles from the housing assembly with a blast of 
dry air when using interconnection housing to mate two optical 
fibres.

Cleaning Optical Fibers
Required Cleaning Equipment

Optical fibers must always be cleaned before mating and after 
unmating. You will need the following items:
• “Kimwipes” or a lens-grade, lint-free tissue
• Denatured alcohol
• Canned dry air

Note
The X75SPR-HD is supplied 
with an SC interconnection 
housing built into the module. 
With this style of connector, the 
fiber assembly and the housing 
assembly can only be connected 
in one way and with very good 
repeatability. The optical fiber 
with SC connectors must be 
customer supplied.
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Cleaning Technique
Use the following method to clean the fibers:
1. Fold the tissue twice so that it is four layers thick.
2. Saturate the tissue with alcohol.
3. Clean the sides of the connector ferrule. 

i. Place the connector ferrule in the tissue and apply pressure 
to the sides of the ferrule. 

ii. Rotate the ferrule several times to remove all 
contamination from the ferrule sides.

4. Clean the end of the connector ferrule.
i. Move to a clean part of the tissue.
ii. Be sure it is still saturated with alcohol and that it is still 

four layers thick. 
iii. Put the tissue against the end of the connector ferrule.
iv. Place your finger against the tissue so that it is directly over 

the ferrule.
v. Rotate the end of the connector.

5. Mate the connector immediately. Do not let the connector lie 
unattended before mating.

Note
Dry air can be used to remove 
dust from the connector housing 
or the transmitter or receiver 
ports.
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Preparing the X75HD/X75SD for Servicing
Some versions of X75HD/X75SD units use a two-part chassis cover, 
making it possible for you to perform maintenance on power supplies 
without removing the frame from the rack. Other versions use a 
full-size cover. Follow these steps to remove either version of the 
chassis cover:
1. Read and heed the safety precautions outlined in the X75 safety 

manual, and in the section “Safety Precautions” on page 256.
2. Confirm that the X75HD/X75SD unit is turned off and that the 

power cord is disconnected from the rear panel. 
3. Use a Phillips screwdriver to remove the retaining screws on the 

full chassis cover or split chassis cover. Figure C-2 shows the 
location of the screws along the back edge, front edge, top, and 
each side of the frame.
Keep the screws, as they will be needed to replace the top cover.

Figure C-2. Location of Chassis Cover Screws (Full Cover and Split Cover)

4. Lift off the chassis cover from the X75HD/X75SD. 

To complete the installation of all hardware options:
1. Replace the top cover, and use the original screws to secure the top 

cover. 
2. Plug the power cord back in.

Caution
With the power cord 
disconnected, the unit is no 
longer grounded. Be aware of 
potential damage from static 
electricity.
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Common Replacement Part Numbers
The following parts are the most commonly ordered as replacements.

Installing the X75OPT-HDDUOCON Software Key
If you have ordered the X75OPT-HDDUOCON software option 
separately, you will require a soft keycode. This unlock code, consisting 
of fourteen hexadecimal digits, will be provided when you purchase the 
option. Once you install the option, use a control panel or the web client 
server software to install the code.
Using the control panel or web server application, follow this thread to 
install the unlock code: System Config>Setup>License Key.

Table C-2. Common Replacement Part Numbers

Part Number Part Identification
122-000024-00 Power supply

131-000014-00 Fan

164-000262-00 Rubber keymat 

134-000212-00 Board stacker 2x15 pin

134-000228-00 Single 2x7 analog audio connector

170-000483-00 X75 Whole local control panel assembly

X75SPR-KIT Package that includes the following parts:
• 2 fans
• 4 stackers
• 1 power supply with no connectors
• 1 shaft encoder
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Installing a Frame-Mounted Local Control Panel
To remove a blank front panel and replace it with a frame-mounted 
local control panel, follow these steps:
1. Remove all power from the X75HD/X75SD unit, disconnect all 

cabling, and then remove the mounted unit from the rack.
2. Remove the two screws located at the back of each mounting ear 

that secure the blank front panel to the chassis.
Retain the screws.

3. Remove the screws along the top and bottom of the blank front 
panel that hold it to the frame.
Retain the screws.

4. Pull the blank front panel from the unit.
5. Replace the front panel with the new frame-mounted local control 

panel, and secure it to the unit using the screws removed in step 3. 
(See Figure C-3.)

Figure C-3. Removing the Front Panel

6. Replace the mounting ear screws removed in step 2, and then return 
the unit to the rack.

7. Reconnect all cabling, and restore power.

Replacing the front panel 

Location of panel screws 
Secure panel along top and 
bottom of chassis. 
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Installing and Removing an Audio 
Synchronizer Module

Installing a New Module
If you have ordered an audio synchronizer module (X75OPT-AS-8, 
X75OPT-AS-8-L, X75OPT-AS-16, or X75OPT-AS-16-L) separately to 
upgrade your system, follow these installation steps:
1. Remove the chassis cover (see “Preparing the X75HD/X75SD for 

Servicing” on page 261).
2. Remove the screws from the blank filler plate on the rear panel 

where the new audio synchronizer module is to be installed, and 
then remove the plate.
Retain the screws for later use.

3. Remove the packaging from the audio synchronizer module. 
The package includes one board, four stackers, and the required 
number of standoff screws.

4. Turn the module upside down and insert the four stackers into the 
corresponding connectors on the underside of the board. 
See Figure C-4.

Figure C-4. Connecting Four Stackers to Module

Caution
This module is not 
hot-swappable. To prevent 
damage, ensure that the power 
to the X75 is off before inserting 
or removing the module.

Connecting the stackers
Locate the stacker connection points 
on the module, and then push the 
stackers into place.
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5. Return the module to its upright position, and then align it with the 
installed standoffs on the main board. 
There are two standoffs on the back of the main board, and one in 
the middle. To assist with alignment, the standoff in the back left 
corner is higher than the others in order. See Figure C-5 and 
Figure C-6.

Figure C-5. Locating Main Board Standoffs

Figure C-6. Positioning Module over Standoffs

Locating the standoffs on the main board

Positioning the module over the main board
Align stackers with corresponding connectors 
on the main board.
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6. Inspect the connectors on both the module and the main board to 
ensure that all pins are straight, and then push the board gently over 
the main board stacker connection points until they lock into place. 
Figure C-7 illustrates the area of the module you should push so 
that the stackers lock firmly into place.

Figure C-7. Pushing the Module on to the Main Board

7. Secure the new module to the main board using the provided 
screws.
Figure C-8 on page 267 illustrates the location of the three module 
standoffs where you need to apply the screws.

Pushing the module onto the main board
Push the module above where the stackers 
are located.
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Figure C-8. Securing the Module to the Main Board

8. Screw the back panel into place using the screws removed in step 2.

Figure C-9. Securing the Back Connector to the Frame

9. Replace the chassis cover using the original screws. See page 261 
for more information on replacing the cover.

Securing the module to the 
main board
Screw the module to the main 
board via the three standoffs.

Securing the back 
connector to the frame
Screw the back connector to 
the frame in three locations.
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Removing an Existing Module
If you must remove an existing audio synchronizer module from a unit, 
follow these steps:
1. Remove the screws along the back edge and each side of the X75’s 

chassis cover (see Figure C-2 on page 261), and then slide the cover 
off.
Retain the screws for later use.

2. Remove the three rear connector screws that secure the module to 
the frame. 
See Figure C-9 on page 267 to locate these screws.

3. Remove the three screws that secure the module to the main board.
See Figure C-8 on page 267 to locate these screws.

4. Gently lift the module off of the main board. 
Be sure to lift the module off evenly to prevent the stacker 
connector pins from bending or breaking. 

5. Inspect the connectors on the module and main board to ensure that 
all pins are straight.

6. Store the board in a protective bag to protect it from damage or 
ESD.
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Installing and Removing HDTV Modules

Installing a New Module
If you have ordered a replacement or spare HDTV module, follow these 
installation steps:
1. Remove the chassis cover (see “Preparing the X75HD/X75SD for 

Servicing” on page 261).
2. Remove the screws from the blank filler plate on the rear panel 

where the new fiber connector module is to be installed, and then 
remove the plate.
Retain the screws for later use.

3. Remove the packaging from the connector module. 
4. Turn the board upside down and insert the seven stackers into the 

corresponding connectors on the underside of the board. 
See Figure C-10.

Figure C-10. Connecting Seven Stackers to Module

Caution
This module is not 
hot-swappable. To prevent 
damage, ensure that the power 
to the X75 is off before inserting 
or removing the module.

Connecting the stackers
Locate the stacker 
connection points on the 
module, and then push the 
stackers into place.
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5. Return the module to its upright position, and then align it with the 
installed standoffs on the main board. 
There are three standoffs on the back edge of the main board, and 
one in the middle. The middle standoff along the back edge of the 
module is higher than the others in order to assist with alignment. 
See Figure C-11 and Figure C-12.

Figure C-11. Locating Main Board Standoffs

Figure C-12. Positioning Module over Standoffs

Locating the standoffs on the main board

Positioning the module over the 
main board
Align stackers with corresponding 
connectors on the main board.
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6. Inspect the connectors on both the module and the main board to 
ensure that all pins are straight, and then push the board gently over 
the main board stacker connection points until they lock into place. 
Figure C-13 illustrates the area of the module you should push so 
that the stackers lock firmly into place.

Figure C-13. Pushing the Module on to the Main Board

7. Secure the new module to the main board using the provided 
screws.
Figure C-14 on page 272 illustrates the location of the three module 
standoffs where you need to apply the screws.

Pushing the module onto the main board
Push the module above where the stackers 
are located.
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Figure C-14. Securing the Module to the Main Board

8. Screw the back panel into place using the screws removed in step 2.

Figure C-15. Securing the Back Connector to the Frame

9. Replace the chassis cover using the original screws. See page 261 
for more information on replacing the cover.

Securing the module to the main board
Screw the module to the main board via 
three standoffs.

Securing the back connector to the 
frame
Screw the back connector to the frame 
in three locations.
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Removing an Existing Module
If you must remove an existing HDTV module from an X75, follow 
these steps:
1. Remove the screws along the back edge and each side of the X75’s 

chassis cover (see Figure C-2 on page 261), and then slide off the 
cover.
Retain the screws for later use.

2. Remove the three rear connector screws that secure the module to 
the frame. 
See Figure C-15 on page 272 to locate these screws.

3. Remove the three screws that secure the module to the main board.
See Figure C-14 on page 272 to locate these screws.

4. Gently lift the module off the main board. 
Be sure to lift the module evenly to prevent the stacker connector 
pins from bending or breaking. 

5. Inspect the connectors on the module and main board to ensure that 
all pins are straight.

6. Store the board in a protective bag to protect it from damage or 
ESD.
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Installing and Removing X75OPT-A3D or 
X75OPT-PQM Modules

Installing a New Module
If you have ordered an optional X75OPT-A3D or X75OPT-PQM 
module separately, follow these installation steps:
1. Remove the chassis cover (see “Preparing the X75HD/X75SD for 

Servicing” on page 261).
2. Remove the screws from the blank filler plate on the rear panel 

where the new module is to be installed, and then remove the plate.
Retain the screws for later use.

3. Remove the packaging from the module. 
The X75OPT-A3D and X75OPT-PQM packages include one board, 
three stackers, and the required number of standoff screws.

4. Turn the board upside down and insert the three stackers into the 
corresponding connectors on the underside of the board. 
See Figure C-16.

Figure C-16. Connecting Three Stackers to Module

Caution
This module is not 
hot-swappable. To prevent 
damage, ensure that the power 
to the X75 is off before inserting 
or removing the module.

Connecting the stackers
Locate the stacker 
connection points on the 
module, and then push the 
stackers into place.
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5. Return the module to its upright position, and then align it with the 
installed standoffs on the main board. 
There are three standoffs on the back edge of the main board, and 
one in the middle. The middle standoff along the back edge of the 
module is higher than the others in order to assist with alignment. 
See Figure C-17 and Figure C-18.

Figure C-17. Locating Main Board Standoffs

Figure C-18. Positioning Module over Standoffs

Locating the standoffs on the main board

Positioning the module over the 
main board
Align stackers with corresponding 
connectors on the main board.
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6. Inspect the connectors on both the module and the main board to 
ensure that all pins are straight, and then push the board gently over 
the main board stacker connection points until they lock into place. 
Figure C-19 illustrates the area of the module you should push so 
that the stackers lock firmly into place.

Figure C-19. Pushing the Module on to the Main Board

7. Secure the new module to the main board using the provided 
screws.
Figure C-20 on page 277 illustrates the location of the three module 
standoffs where you need to apply the screws.

Pushing the module 
onto the main board
Push the module above 
where the stackers are 
located.
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Figure C-20. Securing the Module to the Main Board

8. Screw the back panel into place using the screws removed in step 2.
9. Replace the chassis cover using the original screws. See page 261 

for more information on replacing the cover.

Securing the module to the main board
Screw the module to the 
main board via three 
standoffs.



278 X75HD/X75SD Installation and Operation Manual

 
Appendix C: Servicing

Removing an Existing Module
If you must remove an existing X75OPT-A3D or X75OPT-PQM 
module, follow these steps:
1. Remove the screws along the back edge and each side of the 

frame’s chassis cover (see Figure C-2 on page 261), and then slide 
the cover off.
Retain the screws for later use.

2. Remove the three rear connector screws that secure the module to 
the frame. 

3. Remove the three screws that secure the module to the main board.
See Figure C-20 on page 277 to locate these screws.

4. Gently lift the module off of the main board. 
Be sure to lift the module off evenly to prevent the stacker 
connector pins from bending or breaking. 

5. Inspect the connectors on the module and main board to ensure that 
all pins are straight.

6. Store the board in a protective bag to protect it from damage or 
ESD.
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Installing and Removing the Streaming Module

Installing a New Module
If you have ordered an X75OPT-STR streaming module separately, 
follow these installation steps:

1. Inspect the connectors on both the module and the main board to 
ensure that all pins are straight, and then push then board gently 
over the main board stacker connection points until they lock into 
place. 
Figure C-21 illustrates the area of the module you should push to 
lock the stackers into place.

Figure C-21. Pushing the Module on to the Main Board

2. Secure the new module to the main board using the provided 
screws.
Figure C-22 on page 280 illustrates the location of the three module 
standoffs where you must install the screws.

Caution
This module is not 
hot-swappable. To prevent 
damage, ensure that the power 
to the X75 is off before inserting 
or removing the module.

This module requires version 
1.7 or later X75 firmware.

Pushing the module onto the main board
Push the module above where the stackers are located.
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Figure C-22. Securing the Module to the Main Board

3. Replace the chassis cover using the original screws. See page 261 
for more information on replacing the cover.

4. Using the control knob interface, follow this path to reach the 
streaming module’s network address parameters: 
High End Streaming>Network Settings

5. Make the necessary Gateway, Subnet Mask, and IP Address 
settings in the Network Settings parameters, as shown in 
Table C-3 on page 281, and then select Save IP>Yes.
The default settings are: 
• Gateway: (192.168.100.1)
• Subnet Mask: (255.255.255.0)
• IP Address: (192.168.100.252)

6. On a computer linked via Ethernet to theX75HD/X75SD, visit 
www.apple.com and then download the free QuickTimeTM version 7 
player.

7. Launch QuickTime Player, click File, and then click Open URL. 

Securing the module to the main board
Screw the module to the main board via 
four standoffs.
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8. Type the following text into the Open URL field (where ipaddr 
represents the IP Address of the streaming module):
rtsp://ipaddr:554/X75streaming

The QuickTime player should begin receiving streaming media 
from the X75HD/X75SD after a delay of 4 seconds.

Table C-3. Streaming Module Settings

Main Menu High End Streaming VBR Quality 
(1 to 10)

Bit Rate

Control Mode

Variable

Fixed

Fixed Bit Rate 
(200 Kbps 
to 1 Mbps)

Network Settings

Streaming IP (Enter number)

Subnet Mask (Enter number)

Gateway (Enter number)

Save IP Yes

No

Video Output Enable

Disable

Audio Output

Enable

Disable
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Removing an Existing Module
If you must remove an existing streaming module from a unit, follow 
these steps:
1. Remove the screws along the back edge and each side of the 

frame’s chassis cover (see Figure C-2 on page 261), and then slide 
the cover off.
Retain the screws for later use.

2. Remove the three screws that secure the module to the main board.
See Figure C-22 on page 280 to locate these screws.

3. Gently lift the module off of the main board. 
Be sure to lift the module off evenly to prevent the stacker 
connector pins from bending or breaking. 

4. Inspect the connectors on the module and main board to ensure that 
all pins are straight. 

5. Store the board in a protective bag to protect it from damage or 
ESD

Launching QuickTime in CCS Pilot and Navigator
The streaming video output is viewable using QuickTime Player 
directly, or via QuickTime in CCS Pilot and Navigator. (Version 7.0 of 
the player must be installed.) 
In CCS Pilot and Navigator, you can add the streaming video module as 
a device icon in the Navigation window. In CCS Navigator only, you 
can view the streaming video either by adding a device icon in the 
Navigation window, or by installing a button on a Graphical Navigator 
page.

Adding Streaming as a Device Icon in the Navigation Window
To add a device icon to launch X75 streaming video, follow these steps:
1. With Pilot or Navigator in Build mode, right click in the Network, 

Discovery, or Temporary folder of the Navigation window, and 
then select Create > Server. 
This will create a Server icon in the Navigation window. 

2. Right-click on the server icon and select Properties... from the 
menu that appears.
The Navigation Properties dialog box opens.
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3. Select the Command tab, and fill it in with the following 
information:
Operation: Control
Command: c:\program 
files\quicktime\quicktimeplayer.exe

(Or the complete path to your QuickTime Player installation, if it 
differs from the above)
Arguments: rtsp://[IP address]:554/x75streaming
(Replace [IP address] with the IP address of the X75 
streaming Ethernet port)
You can leave the Initial Directory field blank.

4. Close the Navigation Properties dialog box by clicking the Close 
button in the top right corner.

When you enter Control mode, double-click on the server icon. This 
will open a QuickTime Player and play streaming video from the X75.

Adding Streaming via a Button in Navigator
To add a button to launch X75 streaming video, follow these steps: 
1. With Navigator in Build mode, place a button on a Graphical 

Navigator page. 
For information on creating buttons, see “Adding Buttons” in the 
CCS Navigator online help.

2. Right-click on the button and select Properties... from the menu 
that appears.
The Object Properties dialog box opens. 

3. Select the Rules tab, and then click the New Rule button. 
A new line appears in the Rules table. 

4. In the new rule’s Event list, select OnMouseClick.
The default Condition setting for this event is Always; you can leave 
that as it is, or you can change it by clicking the Condition button. See 
“Defining Condition” in the CCS Navigator online help for information 
on completing the Condition dialog box. 
5. From the new rule’s Action list, select Launch Application. 
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6. Click the Action Properties button. 
The Action Property dialog box opens. Fill it in with the following 
information: 
• Command: c:\program 

files\quicktime\quicktimeplayer.exe

• Arguments: rtsp://[ip address]:554/
x75Streaming

You can leave the Initial Directory field blank. 
7. Click OK to close the Action Properties dialog box. 
8. Close the Object Properties window by clicking the X in the top 

right corner. 
When you enter Control mode, the new button will open a 
QuickTime Player and play streaming video from the X75. 
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Installing Noise Reduction, Auto Audio/Video 
Timing, and Audio Limiter Software Options 

Installing a Software Option
If you have ordered the or X75OPT-ASL, X75OPT-DOLBY-1, 
X75OPT-NR, X75OPT-SNMP, or X75OPT-V2A software options 
separately, you will require a soft keycode. This unlock code, consisting 
of fourteen hexadecimal digits, will be provided when you purchase the 
option. Once you install the option, use a control panel or the web client 
server software to install the code.
Using the control panel or web server application, follow this thread to 
install the unlock code: System Config>Setup>License Key.

Operating the X75OPT-AS-16 /8-L Audio Limiters 
Audio limiters are available on both the 16-channel and 8-channel 
versions of the X75OPT-AS-16 /8 audio synchronizers. The audio 
limiters have the following available options:
• Soft Limit Level
• Slope
• Attack Time
• Decay Time
• Noise Gate Level
• Noise Gate Time
Table C-4 describes the various options of the audio limiter.
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Table C-4. Audio Limiter Options

Option Description
Soft Limit Level • Sets the threshold level for the input audio signal, measured in dB (decibels), 

where the audio signal limiter's attack and decaying function will be based
• When a signal exceeds this level, compression will be applied

Slope • The amount a signal is reduced by the compressor 
• When the slope is set to 0.25, the audio input signal exceeding the soft limit 

threshold level will be reduced by a factor of 4 at the output

Attack Time • Limiter will be activated only after the input audio level remains over the Soft 
Limit Level for the duration specified in the Attack Time option

• Audio that exceeds the specified Soft Limit Level for less than the specified 
Attack time will not activate the limiter

• Attack Time indicates how long it takes for the compressor to act after a signal 
has exceeded the threshold level

Decay Time • Once the input audio signal has exceeded the Soft Limit Level and the limiter 
has been activated, the limiter remains active until the audio signal has returned 
below the Soft Limit Level for the duration specified in the Decay Time option

• If the input audio signal returns below the Soft Limit Level for less than the 
specified Decay Time, the limiter remains active

Noise Gate Level • Sets the noise gate threshold level, measured in dB (decibels)
• When an input signal has fallen below this level, the noise gate will be applied

Noise Gate Time Indicates how long it takes for the noise gate to start or stop acting after the input 
signal has fallen below or risen above the threshold level
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Figure C-23 shows the transfer function of the Audio Limiter:

Figure C-23. Audio Limiter Transfer Function

Input (dB)

Output (dB)

Threshold

Slope = 1.0

Slope = 0.5

Slope = 0.0

Slope = 0.75

Slope = 0.25
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Installing a Dolby Decoder Module
If you have ordered a Dolby decoder module (X75OPT-DOLBY-1) 
separately to add to your X75HD/X75SD system, you must first remove 
the existing audio submodule from the main board. There are two levels 
of installation for the Dolby decoder module: hardware and softkey. 
To install the Dolby decoder module, follow these steps:

Hardware Installation
1. Remove the screws along the back edge and each side of the 

frame’s chassis cover (see Figure C-2 on page 261), and then slide 
the cover off.
Retain the screws for later use.

2. Remove the three rear connector screws that secure the audio 
submodule to the frame. 
See Figure C-9 on page 267 to locate these screws.

3. Remove the three screws that secure the audio submodule to the 
main board.
See Figure C-8 on page 267 to locate these screws.

4. Gently lift the audio submodule off of the main board. 
Be sure to lift the module off evenly to prevent the stacker 
connector pins from bending or breaking. 

5. Inspect the connectors on the module and main board to ensure that 
all pins are straight. 

6. Install the Dolby decoder module in the socket. (See Figure C-24 
on page 289.)

7. Press down the edges slowly until you hear the metal clips click.
8. Reinstall the audio module gently and install all screws.
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Figure C-24. Dolby Decoder Module Installation

Softkey Installation
The Dolby decoder requires a softkey code to operate. The softkey can 
be entered using the control panel or the Web Server software 
application. Follow these instructions to enable the softkey option:
1. Go to the System Config>Setup menu and select the License Key 

parameter.
2. Enter the fourteen license key characters and then press Enter.
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Replacing a Power Supply
This section describes the replacement of a failed X75OPT-PS Power 
Supply. To install an additional, redundant power supply, see page 293. 
Follow these steps to remove and replace an original power supply:
1. Remove all power from the frame, and then remove the chassis 

cover (see “Preparing the X75HD/X75SD for Servicing” on 
page 261 for more information).

2. Locate the failed power supply inside the system, at the front of the 
unit behind the fan board. 
Power supplies are secured to the chassis floor, and connected to 
the main board. See Figure C-25.

Figure C-25. Location of Connected Power Supply

Note
The default power supply 
shipped with every X75HD/
X75SD system is located on the 
left side of the frame (as seen 
from the front). An installed 
redundant power supply is 
located on the right side of the 
frame.

Primary 
power supply

Secondary (redundant) 
power supply

Rear of frame

Front of frame

1 2
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3. Remove the main DC power cable and secondary DC ribbon cable 
that connect the power supply. (See Figure C-26.)

Figure C-26. Removing the DC and Ribbon Cables

4. Disconnect the polarized AC cables from the power supply. 
(See Figure C-27.)

Figure C-27. Removing AC Cable from Power Supply

Remove
main DC
power
cable

Remove secondary 
DC ribbon 
connector

AC cable 
connector
Remove the 
connector 
from power 
the supply.
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5. Unscrew the power supply from the chassis floor. 
Figure C-28 shows the location of the four screws you need to 
remove. Keep these screws for later reuse.

Figure C-28. Removing the Power Supply

6. Remove the power supply from the frame.
7. Replace the old power supply with a new one, following the 

previous steps in reverse.

Screw locations 
Remove these four screws to 
unfasten the power supply from 
the chassis floor.

Note
If you are removing a redundant 
power supply, replace the power 
supply prior to operation or 
install a cover plate over the AC 
inlet hole to maintain proper 
ventilation and avoid 
overheating.
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Installing a Redundant Power Supply
Follow this procedure to install a new, redundant power supply when 
there is only one power supply currently in the frame:
1. Remove all power from the frame, and then remove the chassis 

cover. (See “Preparing the X75HD/X75SD for Servicing” on 
page 261).
A redundant power supply is installed on the right side of the frame 
(labelled 2, below), as seen from the front. (See Figure C-29.)

Figure C-29. Where to Install a Redundant Power Supply

2. Install the power supply onto the four standoffs on the chassis floor, 
and then screw into place. (See Figure C-28 on page 292.)
The two-pin AC cable connector faces the front of the chassis, 
while the six-pin DC cable connectors face the rear.

3. Connect one end of the main DC power cable and the secondary 
DC ribbon cable to the main board, and the other end of each cable 
to the power supply. (See Figure C-30.)

Primary 
power supply

Secondary (redundant) 
power supply

Rear of frame

Front of frame

1 2

Note
If the HD submodule is 
installed, you may need to 
remove it first before 
connecting the DC cables.
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Figure C-30. Connecting DC and Ribbon Cables

4. Plug the end of the AC cable assembly with a two-pin connector 
into the power supply.
The two-pin connector has polarized live and neutral wires feeding 
into it, color-coded as follows:
• Black/Brown: Live wire
• White/Blue: Neutral wire
For primary and secondary power supplies, ensure that the neutral 
wire is on the left side and the live wire is on the right, as seen from 
the front. (See Figure C-31 on page 295).

Secondary (redundant) 
power supply

Primary power 
supply

Main board

Main 
DC cable

Main 
DC cable

Secondary 
DC cable

Secondary 
DC cable
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Figure C-31. Connecting AC Cables to Power Supply

5. Secure the AC cabling to the chassis. (See Figure C-32 on 
page 296.)
To do this, follow these steps:
a. Attach the self-stick tie holders to chassis floor (two places for 

each power supply’s AC cabling).
b. Feed the tie wraps through the holders.
c. Wrap the tie wraps around the AC cabling. 
d. Clip any extra tie length.

AC cable assembly
Neutral wire (left)
Live wire (right)
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Figure C-32. Attaching Tie Wraps to AC Cabling

6. Take off the AC inlet cover plate by removing the inlet cover screw 
on the chassis side, and then install the new AC inlet into the slot. 
(See Figure C-33 on page 297.)
Ensure the following during installation:
• The ground plug on the inlet faces the outside chassis wall.
• The AC inlet snaps securely into place.

Tie holder locations

Self-stick tie holder
Attach to chassis floor.

Tie wrap
Feed the tie wrap 
through tie holder, and 
then wrap it around the 
AC cabling.

Rear of frame
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Figure C-33. Removing Cover Plate and Installing AC Inlet

7. Securely plug the AC wires into the appropriate AC inlet blade 
terminals.
There are three wires: Live (black/brown), Neutral (white/blue), 
and Ground (green/yellow). The Live wire plugs on top of the 
Neutral wire, while the Ground wire always plugs into the single 
row slot that is closest to the chassis wall. (See Figure C-34.)

Figure C-34. Connecting AC Cables to Inlet

AC inlet cover plate location
Remove this screw in order to take off the cover plate.

AC inlet 
Install inlet into the 
uncovered slot.

Live wire

Neutral wire

Ground wire
(with ring terminal 
attached)



298 X75HD/X75SD Installation and Operation Manual

 
Appendix C: Servicing

8. Place the attached ring terminal on the end of the ground wire over 
the stud on the chassis floor, and then secure it into place with the 
supplied nut to ground the unit.

Figure C-35. Grounding AC Inlet

9. Replace the cover on the frame, and then return power to the unit. 
See “Preparing the X75HD/X75SD for Servicing” on page 261 for 
more information on replacing the cover.

Grounding screw location
Using the provided ring terminal and nut, attach the end of the 
grounding wire to the chassis floor to ground the unit.
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Installing Fans
To replace a fan, or individual fans within the assembly, follow these 
steps:
1. Remove the four front mounting-ear screws, and then pull the 

frame out a few inches from the rack.
Retain the screws.

2. Remove the screws along the top and bottom of the front panel that 
hold it to the frame. (See Figure C-36.)
Retain the screws.

Figure C-36. Freeing the Front Panel from the Frame

Front of panel 
(upside down in this illustration)

Front panel securing screws (bottom)
Remove screws to free the front panel from 
the frame (seven on top, seven on bottom)
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3. Pull the front panel away from the frame. (See Figure C-37.)
Although a frame-mounted local control panel is shown below, this 
procedure also applies to blank front panels.

Figure C-37. Removing the Front Panel

4. Identify the fan you are replacing on the back side of the front 
panel, and then remove the corresponding header wires from the 
fan assembly connector. (See Figure C-38.)

Figure C-38. Removing Header Wires from Fan Assembly 
Connector 

5. Unscrew the fan, and then pull it away from the assembly to 
remove it.

Pull out the front panel 
Once the top and bottom front panel screws are 
removed, pull the panel out from the frame.

Fan connectorHeader wires Fan removal screws
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6. Fasten a new fan into place on the assembly with the supplied 
screws. (See Figure C-39.)

Figure C-39. Replacing a Fan within the Assembly

7. Connect the new fan’s header wires to the corresponding fan 
assembly connector.

8. Secure the front panel to the X75HD/X75SD frame using the 
original screws from step 2.

9. Close the front panel, re-establish any connections, and then 
reapply power to the frame.

Screw fan into place

Insert header wire
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Overview
This appendix provides information about upgrading the software used 
in X75HD/X75SD units. The following topics are covered:
• “Upgrading Module Firmware” on page 304
• “Configuring SNMP Support” on page 311
• “Monitoring and Control Using Leitch MIBs” on page 317
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Upgrading Module Firmware
Firmware upgrading is a routine procedure that you must perform to 
install newer versions of software on the X75HD/X75SD. Pilot, 
Co-Pilot, or Navigator software applications are required for this 
procedure. You can use either the Discovery or the drag-and-drop 
method. When performing the upgrading procedure, check the 
appropriate readme file to confirm which files are needed. Use care to 
ensure that you upload the correct files to the intended module.
If for some reason the upgrade fails, the module may not respond to 
controls and will appear to be non-functional. In that event, follow the 
steps described in “Correcting a Failed Upgrade Procedure” on 
page 310.

Upgrading the Firmware
Follow these steps to upgrade the firmware:
1. Download the most recent appropriate upgrade package from the 

Leitch Web site or from your CD-ROM.
2. If the affected module has not been discovered, perform the 

Discovery operation, as described in your CCS software application 
manual or online help.

3. From the Tools menu, select Software Upgrade. 
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The Software Upgrade window opens or is brought to the 
foreground.

Figure D-1. Software Upgrade Tool’s New Transfer Tab

4. On the New Transfer tab, click Add.
The Device Selection dialog opens.

5. Select one or more X75s, and then click OK to close the Add 
Device dialog box.
The selected devices appear in the table on the New Transfer tab of 
the Software Upgrade window. This table lists devices that are to 
receive the same upgrade package. 
For each device in this table, you can highlight its position in the 
Navigation Window by clicking Find Device. You can check the 
software revision numbers, etc., by clicking Version Info.

Click here to access options 
for entering Telnet and FTP 
user name and password 
and creating automatic 
backups.

Package Info includes a list 
of the components 
contained in the ZIP file. 
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6. For each X75, click Options.

Figure D-2. Software Upgrade Options Box

7. If they are not already entered, fill out the Telnet Username, Telnet 
Password, FTP Username, and FTP Password fields.

8. Place a check beside Automatic Backup.
This creates a backup of the current software installed on the X75. 
The backup is saved to the file name and location stated unless you 
click Browse to change it.

9. Click OK to close the Software Upgrade Device Options window.
10. On the Software Upgrade window’s New Transfer tab, press 

Browse... to select the software upgrade package (ZIP file).
A standard Windows File Selection dialog opens. 

11. Choose the upgrade ZIP file on a local or network drive. 
The selected file’s path name is displayed in the edit box to the left 
of the Browse… button.
The extraction process on the ZIP file is handled as part of the 
upgrade process. You do not need to extract the files yourself. 

Note
Closing the Software Upgrade 
window does not effect any of 
the transfer processes that may 
be running in the background.
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12. Press Submit Transfer... 
A dialog box opens, requesting confirmation that you want to 
proceed with the request. If you have multiple devices selected, 
multiple transfer tasks are submitted—one per device.
The transfer now progresses. You may close the Software Upgrade 
window, or continue with other tasks. 
Or you can switch to the Progress tab to view the status of the 
transfers. 

13. Click on the Log tab and look at the Progress column to ensure that 
all files have correctly updated. 
The module is automatically rebooted following an upgrade 
procedure. 

Stopping a Transfer Task
To stop a transfer task, select the task from the grid, and then click Stop. 
If the selected task is currently executing, it is placed into a an Aborted 
state. If the task has not yet started, it is placed into a “Waiting to 
Resume” state. A confirmation window appears to confirm that you 
want to stop as aborting the task will put the module into an inconsistent 
state the next time it is rebooted.

Note
If you try to log off or exit the 
CCS software while a transfer is 
underway, a notification 
window will alert you that 
processes are still active and 
will ask if you want to terminate 
these processes.

Note
The Resume button is not 
available in this release. Its 
functionality will be 
implemented in a future release. 
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Using the Software Upgrade Progress Tab
Use the Progress tab to monitor the status of all the transfer requests in 
the queue. The grid displays the status of each transfer task, with each 
row in the grid representing a single device-package combination 
(transfer task).

Figure D-3. Progress Tab of the Software Upgrade Window

Table 1-2 below describes the five buttons on the Progress tab.

Note
The Resume button is always 
unavailable in this release. Its 
functionality will be 
implemented in a future release. 

Table D-1. Progress Tab Buttons

Button Description 
Stop Aborts a selected transfer task

Clear Removes a selected transfer task from the grid; the task must 
be in a Waiting to Resume, Aborted, Failed, or Completed 
state in order for this button to be enabled

Stop All Aborts all tasks in the queue; you will be asked to confirm

Clear All Removes all stopped tasks from the queue; these tasks must 
be either Waiting to Resume, Aborted, Failed, or Completed

Resume Restarts a task that is in the “Waiting to Resume” state
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Using the Log Tab
The Log tab displays a running log of all the transfer operations 
completed since application startup. It contains information such as the 
package filename, versions being transferred, start times, errors during 
transfer, and so on. The log text is selectable, allowing you to copy and 
paste log information to another application.

Software Upgrade Options
Right click in the Software Upgrade window to open an Options 
window. 

Figure D-4. Software Upgrade Options Window

Table D-2. Software Upgrade Options

Option Result
Warn if upgrade package does 
not have an XML script

File transfer is not supported without an 
XML script, so this will warn you before 
aborting.

Transfer files even if file 
version is same or older than 
the version on the server

When this is checked, you can potentially 
upgrade the software to an older revision. 
However, this may be useful for returning 
to your backed up version. 

Number of devices to 
simultaneously upgrade

Limits the number of files that can be 
added to the table on the New Transfer tab 
to the number in the window, which you 
can change.
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Correcting a Failed Upgrade Procedure
A firmware upgrade may fail in the event of a network interruption or 
power failure. If one of these events occurs, you will be able to ping the 
device, but Multiple Path Converters and Frame Synchronizers will not 
be able to discover it. 
See the documentation for the specific CCS device whose upgrade has 
failed for information on fail-safe mode, and if there are instructions for 
putting the device into fail-safe mode, follow them. 
After a failed upgrade, some CCS devices will automatically go into a 
fail-safe mode where new software can be loaded but other functions 
are not enabled. If an upgrade fails, remove and then reapply power to 
the CCS device. You can then try the upgrade procedure again. 
When you are performing the fail-safe upgrading procedure, check the 
readme file to confirm which files are needed. Use care to ensure that 
you transfer the correct files to the intended device.
1. Ensure that the CCS device is in fail-safe mode. 
2. Change the network addresses on your Multiple Path Converters 

and Frame Synchronizers PC to match the default network 
addresses. 

3. In Multiple Path Converters and Frame Synchronizers’s Build 
mode, drag or copy and paste the device’s icon from the Catalog 
folder to the Network or Discovery folder. 

4. Right click on the device icon and then select Properties. 
5. On the Device tab of the Navigation Properties box, press the Set 

Default button, and then click Yes. 
6. Follow the software upgrade procedure for the device as described 

in “Upgrading Module Firmware” on page 304.
7. Return the upgraded device to its normal operating mode, including 

returning the fail-safe and Default IP switches to their up position. 
For information on doing this, please refer to the device’s 
installation and operation manual.

8. Return the PC network settings to their original states. See 
“Changing the PC Network Settings” on page 92.

Note
Do not make changes in the 
third field (located above and to 
the right of the Set Default 
button).
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Configuring SNMP Support
With SNMP support, you can use a standard MIB browser to monitor 
parameters and alarms. 
You must set SNMP options using Pilot, CoPilot or Navigator. Before 
you can configure SNMP support, you must discover the X75HD/
X75SD. For instructions on discovering this module, see the CCS Pilot/
Navigator online help.

Activating Your SNMP License Key
A license key may have been included in your purchase of an 
SNMP-enabled system. Contact Leitch customer service to purchase 
one at a later date.
1. While your CCS Software is in Build mode, right click on the 

discovered X75HD/X75SD and choose Configuration. 
The Configuration window opens. 

2. Click on the Device tab. 
3. Enter your device key in the License Key field, and then click 

Write and Reboot.
4. Close the Configuration window. 

Setting SNMP Options
Devices that support SNMP will have an SNMP tab in the 
Configuration window. To configure an X75HD/X75SD that supports 
SNMP, follow these instructions. 
1. While your CCS Software is in Build mode, right click on the 

X75HD/X75SD and choose Configuration. 
The Configuration window opens. 
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2. Click the SNMP tab, and then click the Read button. 
The CCS network polls the module and retrieves its current 
settings. It fills in all the fields on the SNMP tab of the 
Configuration window with the settings that are on the device. 

Figure D-5. SNMP Tab on device Configuration Window 

If the Read function fails, your license key may not be entered 
correctly. See “Activating Your SNMP License Key” on page 311. 



X75HD/X75SD Installation and Operation Manual 313

Appendix D: Software

 

In the top left portion of the window are SNMP Agent settings.  

Below the SNMP Agent settings are System settings. The 
information in these fields describes the device that is currently 
selected in the Navigation window. This is user-defined 
information that, once provided by an administrator, is available on 
the device when it is retrieved by a MIB browser. 

The Trap Destination IP Addresses field contains a list of IP 
addresses that will receive SNMP traps. It is in the format IP 
Address:Port Address:SNMP version. 

Table D-3. SNMP Agent Fields of SNMP Tab

Field Function
Port Number (Can be from 0 to 65535) The network port used by 

the SNMP agent; port 161 is the default for 
X75HD/X75SD

Read Community Has to match the “read community” setting in your 
MIB browser

Write Community Has to match the “write community” setting in your 
MIB browser

Enable 
Authentication 
Traps

When checked, authentication traps are sent if the 
read or write community doesn’t match between the 
SNMP agent and MIB browser

Enable SNMP 
Agent

When checked, SNMP support is available; if not 
checked, SNMP support is disabled

Table D-4. System Fields of SNMP Tab - MIB-2 System 
Information

Field Explanation
Description The default is “Leitch SNMP Agent”

Location The physical location of the device

Contact The contact person for this device

Name Name of the device
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3. To add new Trap Destination IP Addresses, see “Adding New 
Addresses for SNMP Traps” on page 314. To modify them, see 
“Modifying an SNMP Trap Destination” on page 315.

4. (Optional) If you wish the device to reboot automatically when you 
send the new configuration to it, place a check beside Reboot 
device after performing transfer. 

5. Click Write to send the new configuration to the device. 
6. If you did not place a check beside Reboot device after 

performing transfer in step 6, click Reboot now and your changes 
to the configuration will take effect. 

Adding New Addresses for SNMP Traps
To add a new SNMP trap destination, follow this procedure:
1. Click Add beneath the Trap Destination IP Addresses field. The 

Add Trap Destination window opens. 

Figure D-6. Add Trap Destination Window

2. Choose the SNMP version that you would like to use for traps. 
3. Choose the IP address of that trap destination. 
4. Choose the port number. The default is 162, but an administrator 

can set this to any number between 0 and 65535. 
5. Click Apply. A new line is added in the Trap Destination IP 

Addresses field. 
6. Repeat steps 2 through 5 to add more rows to the window. 
7. Click OK to return to the SNMP tab of the Configuration window. 

Note
The device must be rebooted 
before changes will take effect. 
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Modifying an SNMP Trap Destination
To modify a trap destination, follow this procedure:
1. In the Trap Destinations IP Addresses list, click on the item you 

would like to modify.
2. Click the Modify button. The Modify Trap Destination window 

opens. 

Figure D-7. Modify Trap Destination Window

3. Choose the SNMP version of the traps using the radio buttons at the 
top of the window. 

4. Enter the IP address of that trap destination in the IP Address field.
5. Enter the port number in the Port Number field. 

The default value is 162.
6. Click Apply. The selected entry in the Trap Destination IP 

Addresses field is updated. 
7. Repeat steps 2 through 6 to further update the row. 
8. Click OK to close the Modify Trap Destination window. 

Configuring Third-Party SNMP Software Control 
SNMP is an industry-standard protocol that allows other (non Leitch) 
control software to remotely monitor and control the X75HD/X75SD.
Leitch provides MIB files that can be downloaded from the Leitch Web 
site. Two general Leitch MIB files (leitch.mib and ccsAlarm.mib) set 
up the structure to define parameters and alarms. Once these two MIBs 
are installed, you will want to install a MIB for each distinct module for 
which you wish to set up third-party software control.
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You can use any standard MIB browsing software with your X75HD/
X75SD. 
1. Make the required network connections between the X75HD/

X75SD unit(s) and your PC with installed SNMP browser/control 
software.
The SNMP configuration process for the X75HD/X75SD directs 
the SNMP agent where to send alarms (SNMP traps). This file must 
be modified before it is loaded back to the X75HD/X75SD. For 
information on configuring SNMP, see page 311.

2. Load the leitch.mib file into your SNMP browser/control software.
This MIB sets up the basic structure for product specific Leitch 
MIBs. It can be found under the Private > Enterprise branch, and 
sets up the leitchProducts and leitchCommon sub-branches. 
The leitchCommon branch is initially empty. The leitchProducts 
branch contains folders for different families of Leitch devices—for 
example, LeitchX75, NEO and fam6800plus.

3. Load the ccsAlarm.mib file into your SNMP browser/control 
software.
This MIB adds a ccsAlarms sub-branch to the leitchCommon 
folder. When it is installed, you will be able to receive traps with 
proper information as to where the alarms are triggered from.

4. Load product-specific X75HD/X75SD Leitch MIB files into your 
SNMP browser/control software.
A product-specific MIB provides a clear path to the parameters and 
alarms on the device. Leitch MIBs can be downloaded from the 
Leitch Web site at www.leitch.com.
X75HD/X75SD MIBs will appear in the X75 folder under the 
leitchProducts folder. See Figure D-8 on page 317.

5. Configure your MIB browser to connect to the X75HD/X75SD by 
entering the IP address, Port (if you have changed the Port from its 
default in the configuration), and other standard configuration 
settings. 

Your browser should now be able to connect to the SNMP agent 
running on the X75HD/X75SD unit. If you wish to receive traps, start 
up the trap receiver in your MIB browser software. 
For SNMP troubleshooting information, see page 224.

Note
To verify that your 
configurations are correct, you 
can walk MIB2. 
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Monitoring and Control Using Leitch MIBs
Each X75HD/X75SD unit’s MIB can be fully expanded. When you 
expand an X75 MIB node in the tree view, there are three sub-folders 
(see Table D-5). 

To view a complete list of the parameter settings on the X75, walk the 
MIB for that X75, walk the X75 at an IP address, or walk the X75 type.

Figure D-8. Typical MIB Loaded into NuDesign MIB Browser

Table D-5. MIB Sub-Folders

Tree View Item Contents
Objects Lists the parameters for the device; all configurable and read-only parameters appear 

here (see Figure D-8)

Identities Lists the alarms information for the device which is used by the MIB browser to make 
trap messages more meaningful (see Figure D-9 on page 318.)

Conformities A group of standard MIB information that guarantees that the MIB conforms to standard 
SNMP format
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Navigating Parameters in a Leitch MIB
Leitch product MIBs contain functionality so that you can view a 
parameter’s range, walk a device or a frame, or receive alarm traps for a 
device. See Figure D-9 for an example of alarms shown in a MIB 
browser.
How you can access these standard features will depend on the MIB 
Browsing software you use. See the documentation that accompanies 
your third-party control software for more details.

Figure D-9. Alarms in MIB Browser

Parameters that have a limited list of options have two listings under the 
Entry branch of the tree. Parameters that have a range (as in a slider) of 
options have four listings under the Entry branch of the tree.
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The sub-branches described in Table D-6 are shown inFigure D-8 on 
page 317.

For information on the parameters for each individual device, see that 
device’s documentation. Leitch device manuals are available on the 
Leitch Web site at www.leitch.com. In addition, some Leitch products 
have HTML forms that display their parameters. These HTML forms 
are available on the Leitch Web site as well.

Table D-6. Sub-Branches Under a Parameter in a Leitch MIB

Sub-Branch Contains
Slot ID  (Does not apply to the X75.)

Value The current setting of this parameter

High Range 
(slider ranges only)

The top value of this parameter

Low Range (slider ranges only) The bottom value of this parameter
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Alarms

Overview
This appendix lists the alarms as they are shown in the Configure 
Alarms menu. Alarms on X75HD/X75SD units are divided into Major 
and Minor categories, and this list shows the default category. You can 
change the priority of the individual alarms by assigning them a number 
between 1 and 10. Minor alarms are those between 1 and 5; Major 
alarms are between 6 and 10.
The Configure Alarms menu includes the following items:
• Trigger Time
• Clear Time
• Priority
• Alarms Disabled
• Alarm Mute
• Acknowledged
More information about these menu items and the alarms themselves is 
provided in the following pages.
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Configure Alarms Options
Table E-1 lists the options available in the Configure Alarms menu 
and their meanings. To reach the individual alarms, press the Option 
button, and then select Configure Alarms.

Table E-1. Configure Alarms Menu

Menu Item Description
Trigger Time A filter that sets the duration (in seconds) between the time an alarm is detected, and the 

time an alarm is reported to the Web Server, CCS application, or Alarms LED

Clear Time A filter that sets the length of time the alarm continues to be reported after the alarm 
condition is no longer detected (default values are set at 0 seconds)

Priority The numerical value given to the priority of the alarm 
(1 = low priority and 10 = high priority; any alarm above 5 is designated Major)

Alarms Disabled An option that silences the alarm, even though the alarm condition may continue to exist
(If the alarm is re-enabled and the condition is not corrected, the alarm is reactivated 
immediately.)

Alarm Mute An option that suppresses alarm messages when the state of the alarm changes (The 
control panel is affected when the mute is enabled. However, the Web Server application 
will display the alarm message in its next polling cycle, or when the user refreshes the 
screen. The Alarm Mute is not displayed in CCS applications.)

Acknowledged A “flag” that indicates someone is attempting to correct the source of the alarm
(In X75 control panels, an asterisk appears beside the alarm in the Active Alarms List.)
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Alarms List

Table E-2. X75HD/X75SD Alarms List

Alarm Name Priority
Trigger Time 
Default 
Setting 
(seconds)

Clear Time 
Default 
Setting 
(seconds)

AV I/P video missing  Major    0 0

AV I/P burst missing  Major    0 0

AV I/P not locked  Major    0 0

AV I/P frozen  Minor    5 0

AV I/P video low  Major    5 0

AV I/P luma peaked  Major    5 0

AV I/P chroma peaked  Major    5 0

SD1 I/P missing  Major 0 0

SD1 I/P not locked  Major    0 0

SD1 I/P frozen  Minor    5 0

SD1 I/P video low  Major    5 0

SD1 I/P luma peaked  Major    5 0

SD1 I/P chroma peaked  Major    5 0

SD2 I/P missing  Major    0 0

SD2 I/P not locked  Major    0 0

SD2 I/P frozen  Minor    5 0

SD2 I/P video low  Major    5 0

SD2 I/P luma peaked  Major    5 0

SD2 I/P chroma peaked  Major    5 0

HD I/P missing  Major    0 0

HDFS I/P frozen  Minor    0 0

HD I/P video low  Major    0 0

HD I/P luma peaked  Major    0 0

HD I/P chroma peaked  Major    0 0
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Ref video missing  Major    0 0

Ref burst missing  Major    0 0

Ref not locked  Major    0 0

Ref SC/H error  Major    0 0

AA1 peaked  Major    3 0

AA1 silent  Minor    30.0 0

AA2 peaked  Major    0 0

AA2 silent  Minor    30.0 0

AA3 peaked  Major    0 0

AA3 silent  Minor    30.0 0

AA4 peaked  Major    0 0

AA4 silent  Minor    30.0 0

DV audio missing  Major    0 0

DV_a audio peaked  Major    0 0

DV_a audio silent  Minor    30.0 0

DV_b audio peaked  Major    0 0

DV_b audio silent  Minor    30.0 0

AES1 In missing  Major    0 0

AES1a peaked  Major    0 0

AES1a silent  Minor    30.0 0

AES1b peaked  Major    0 0

AES1b silent  Minor    30.0 0

AES2 In missing  Major    0 0

AES2a peaked  Major    0

AES2a silent  Minor    30.0 0

AES2b peaked  Major    0

Table E-2. X75HD/X75SD Alarms List

Alarm Name Priority
Trigger Time 
Default 
Setting 
(seconds)

Clear Time 
Default 
Setting 
(seconds)
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AES2b silent  Minor    30.0 0

HDX Ch1/2 missing  Major    0

HDX Ch1 peaked  Major    0

HDX Ch1 silent  Minor    30.0 0

HDX Ch2 peaked  Major    0

HDX Ch2 silent  Minor    30.0 0

HDX Ch3/4 missing  Major    0

HDX Ch3 peaked  Major    0

HDX Ch3 silent  Minor    30.0 0

HDX Ch4 peaked  Major    0

HDX Ch4 silent  Minor    30.0 0

HDX Ch5/6 missing  Major    0

HDX Ch5 peaked  Major    0

HDX Ch5 silent  Minor    30.0 0

HDX Ch6 peaked  Major    0

HDX Ch6 silent  Minor    30.0 0

HDX Ch7/8 missing  Major    0

HDX Ch7 peaked  Major    0

HDX Ch7 silent  Minor    30.0 0

HDX Ch8 peaked  Major    0

HDX Ch8 silent  Minor    30.0 0

HDX Ch9/10 missing  Major    0

HDX Ch9 peaked  Major    0

HDX Ch9 silent  Minor    30.0 0

HDX Ch10 peaked  Major    0

HDX Ch10 silent  Minor    30.0 0

Table E-2. X75HD/X75SD Alarms List

Alarm Name Priority
Trigger Time 
Default 
Setting 
(seconds)

Clear Time 
Default 
Setting 
(seconds)
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HDX Ch11/12 missing  Major    0

HDX Ch11 peaked  Major    0

HDX Ch11 silent  Minor    30.0 0

HDX Ch12 peaked  Major    0

HDX Ch12 silent  Minor    30.0 0

HDX Ch13/14 missing  Major    0

HDX Ch13 peaked  Major    0

HDX Ch13 silent  Minor    30.0 0

HDX Ch14 peaked  Major    0

HDX Ch14 silent  Minor    30.0 0

HDX Ch15/16 missing  Major    0

HDX Ch15 peaked  Major    0

HDX Ch15 silent  Minor    30.0 0

HDX Ch16 peaked  Major    0

HDX Ch16 silent  Minor    30.0 0

SDX Ch1/2 missing  Major    0

SDX Ch1 peaked  Major    0

SDX Ch1 silent  Minor    30.0 0

SDX Ch2 peaked  Major    0

SDX Ch2 silent  Minor    30.0 0

SDX Ch3/4 missing  Major    0

SDX Ch3 peaked  Major    0

SDX Ch3 silent  Minor    30.0 0

SDX Ch4 peaked  Major    0

SDX Ch4 silent  Minor    30.0 0

SDX Ch5/6 missing  Major    0

Table E-2. X75HD/X75SD Alarms List

Alarm Name Priority
Trigger Time 
Default 
Setting 
(seconds)

Clear Time 
Default 
Setting 
(seconds)
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SDX Ch5 peaked  Major    0

SDX Ch5 silent  Minor    30.0 0

SDX Ch6 peaked  Major    0

SDX Ch6 silent  Minor    30.0 0

SDX Ch7/8 missing  Major    0

SDX Ch7 peaked  Major    0

SDX Ch7 silent  Minor    30.0 0

SDX Ch8 peaked  Major    0

SDX Ch8 silent  Minor    30.0 0

SDX Ch9/10 missing  Major    0

SDX Ch9 peaked  Major    0

SDX Ch9 silent  Minor    30.0 0

SDX Ch10 peaked  Major    0

SDX Ch10 silent  Minor    30.0 0

SDX Ch11/12 missing  Major    0

SDX Ch11 peaked  Major    0

SDX Ch11 silent  Minor    30.0 0

SDX Ch12 peaked  Major    0

SDX Ch12 silent  Minor    30.0 0

SDX Ch13/14 missing  Major    0

SDX Ch13 peaked  Major    0

SDX Ch13 silent  Minor    30.0 0

SDX Ch14 peaked  Major    0

SDX Ch14 silent  Minor    30.0 0

SDX Ch15/16 missing  Major    0

SDX Ch15 peaked  Major    0

Table E-2. X75HD/X75SD Alarms List

Alarm Name Priority
Trigger Time 
Default 
Setting 
(seconds)

Clear Time 
Default 
Setting 
(seconds)
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SDX Ch15 silent  Minor    30.0 0

SDX Ch16 peaked  Major    0

SDX Ch16 silent  Minor    30.0 0

Power Supply failed  Major    0

Fan failed  Major    0

Frozen Video Detected  Minor    0

Dolby Decoder Ch1/2 
missing

 Major    0

Dolby Decoder Ch1 peaked  Major    0

Dolby Decoder Ch1 silent  Minor    30.0 0

Dolby Decoder Ch2 peaked  Major    0

Dolby Decoder Ch2 silent  Minor    30.0 0

Dolby Decoder Ch3/4 
missing

 Major    0

Dolby Decoder Ch3 peaked  Major    0

Dolby Decoder Ch3 silent  Minor    30.0 0

Dolby Decoder Ch4 peaked  Major    0

Dolby Decoder Ch4 silent  Minor    30.0 0

Dolby Decoder Ch5/6 
missing

 Major    0

Dolby Decoder Ch5 peaked  Major    0

Dolby Decoder Ch5 silent  Minor    30.0 0

Dolby Decoder Ch6 peaked  Major    0

Dolby Decoder Ch6 silent  Minor    30.0 0

Dolby Decoder Ch7/8 
missing

 Major    0

Dolby Decoder Ch7 peaked  Major    0

Table E-2. X75HD/X75SD Alarms List

Alarm Name Priority
Trigger Time 
Default 
Setting 
(seconds)

Clear Time 
Default 
Setting 
(seconds)
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Dolby Decoder Ch7 silent  Minor    30.0 0

Dolby Decoder Ch8 peaked  Major    0

Dolby Decoder Ch8 silent  Minor    30.0 0

Dolby Decoder Aux missing  Major    0

Dolby Decoder AuxL 
peaked 

 Major    0

Dolby Decoder AuxL silent  Minor    30.0 0

Dolby Decoder AuxR 
peaked 

 Major   0

Dolby Decoder AuxR silent  Minor 30.0 0

Table E-2. X75HD/X75SD Alarms List

Alarm Name Priority
Trigger Time 
Default 
Setting 
(seconds)

Clear Time 
Default 
Setting 
(seconds)
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Specifications

Overview
This chapter describes all X75HD/X75SD video, audio, and other 
miscellaneous performance and hardware specifications.

The following specifications are included:
• “Video Specifications” on page 332
• “Audio Specifications” on page 340
• “I/O Specifications” on page 343
• “Communication Specifications” on page 344
• “Hardware Specifications” on page 345
• “Power Consumption” on page 346
• “HD Conversion Capabilities” on page 349
• “Video Propagation Delay” on page 349
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Video Specifications

Input

Table F-1. HD-SDI Video Input Specifications

Item Specification
Standard SMPTE292M

(See “HD Conversion Capabilities” on 
page 349 for more information.)

Connector BNC (IEC169-8)

Impedance 75Ω

Return loss >18 dB, typical, from 5 MHz to 1485 MHz

Equalization Adaptive cable equalization for up to—
• 328 ft (100 m), typical, of Belden 8281 

co-axial cable 
or

• 492 ft (150 m), typical, of Belden 
1694A co-axial cable

Table F-2. HDTV Fiber Video Input

Item Specification
Standard SMPTE 292M, Mode B Operation

(See “HD Conversion Capabilities” on 
page 349 for more information.)

Number of inputs 1

Connector Single mode fiber, SC connector standard 
(FC or ST type optional)

Input wavelength 1200 to 1600 nm

Max. input power 0 dBm, typical

Sensitivity Better than -20 dBm
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Table F-3. SD-SDI Video Input Specifications

Item Specification
Standard SMPTE259M-C, 270 Mbps, 525/625 

component

Connector BNC (IEC169-8)

Impedance 75Ω

Return loss >18 dB from 5 MHz to 270 MHz

Equalization >23 dB Belden 8281 cable

Table F-4. S-Video Input Specifications

Item Specification
Standard • NTSC

• PAL-M
• PAL-B

Connector 4-pin DIN

Table F-5. X75OPT-A3D and X75OPT-PQM Analog Composite 
Video Input Specifications 

Item Specification
Standard • NTSC (SMPTE170M)

• PAL-B (ITU624-2)
• SECAM
• PAL-M

Connector BNC (IEC 169-8)

Quantization Normal mode, non-TBC:
• 12 bits (NTSC, PAL-B, PAL-M)
• 8 bits (SECAM)
TBC mode
• 8 bits (all standards)
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Input level 1.0 V pk-to-pk

Impedance 75Ω

Return loss >40 dB, 0.1 MHz to 6 MHz

Common mode range 5.0 V

CMRR 60 dB @ 50/60 Hz, 5 V pk-to-pk

Setup level range ±7.5 IRE

Frequency response ±0.1 dB, 0.1 MHz to 6 MHz

SNR 62 dB, typical (X75OPT-A3D); 
58 dB, typical (X75OPT-PQM)

Y/C gain error <0.1 dB

Y/C delay error <10 ns

Table F-6. Component Input Specifications 

Item Specification
Format Betacam

Connector BNC (IEC169-8)

Input level 1.0 V pk-to-pk

Quantization Normal mode, non-TBC mode CAV
• Y: 12 bits
• Cb: 10 bits
• Cr: 10 bits
Normal mode, non-TBC mode S-Video
• Luma: 12 bits
• Chroma: 10 bits

TBC mode
• CAV: Not supported
• S-Video: 8 bits all

Impedance 75Ω

Table F-5. X75OPT-A3D and X75OPT-PQM Analog Composite 
Video Input Specifications (Continued)

Item Specification
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Return loss >40 dB, 1 kHz to 6 MHz

Frequency response • Y: ±0.15 dB to 5.5 MHz
• Pb/Pr: ±0.10 dB to 3.0 MHz

SNR >60 dB

Table F-7. Genlock Input Specifications

Item Specification
Connector BNC (IEC169-8)

Impedance 75Ω

Return loss >40 dB, 0.1 MHz to 6 MHz

Input level • 1 V pk-to-pk, -5.0 dB to +6.0 dB for 
NTSC/PAL-B

• 1 Vpk-to-pk, -3.5 dB to +6.0 dB for 
Tri-level sync (1080i/720p)

Signal type NTSC/PAL-B analog composite
±300 mV Tri-level sync (1080i/720p)

Table F-6. Component Input Specifications (Continued)

Item Specification
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Output
Table F-8. HD-SDI Video Output Specifications

Item Specification
Standard SMPTE292M

(See “HD Conversion Capabilities” on 
page 349 for more information.)

Connector BNC (IEC169-8)

Impedance 75 Ω

Return loss >18 dB, typical, from 5 MHz to 1485 MHz

Signal level 800 mV ± 10%

DC offset 0.0 V ± 0.5 V

Rise/fall time <270 ps

Overshoot <10% of amplitude

Jitter <135 ps pk-to-pk

Table F-9. HDTV Fiber Video Output Specifications 

Item Specification
Standard SMPTE 292M, Mode B Operation

(See “HD Conversion Capabilities” on 
page 349 for more information.)

Number of outputs 1

Connector Single mode fiber, SC-type standard; FC- 
or ST-type optional

Output wavelength 1310 ± 40 nm

Output power -7 dBm

Rise/fall time <270 ps

Jitter <135 ps pk-to-pk

Laser safety level Class 1
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Table F-10. SD-SDI Video Output Specifications

Item Specification
Standard SMPTE259M-C, 270 Mbps, 525/625 

component

Quantization 10 bits

Connector BNC (IEC169-8)

Impedance 75Ω

Return loss >18 dB from 5 MHz to 270 MHz

Signal level 800 mV ± 10%

DC offset 0.0 ± 0.5 V

Rise/fall time 400 ps to 1500 ps (20% to 80%)

Overshoot <10%

Jitter <0.2 UI (pk-to-pk)

Table F-11. Composite Video Output Specifications

Item Specification
Standard • NTSC

• PAL-B
• PAL-M

Connector BNC (IEC169-8)

Quantization 12 bits

Impedance 75Ω

Return loss >40 dB (0.1 MHz to 6 MHz)

Frequency response ±0.1 dB (0.1 MHz to 6 MHz)

DC offset <0.0 ± 0.005 V

Differential gain <0.5%

Differential phase <0.5°

Y/C delay <10 ns

Transient response <0.5% K Factor

SNR >63 dB (0.1 MHz to 6 MHz)
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Table F-12. Component Output Specifications 

Item Specification
Format Betacam

Connector BNC (IEC169-8)

Quantization • Y: 12 bits
• Cb: 10 bits
• Cr: 10 bits

Impedance 75Ω

Return loss >40 dB (1 kHz to 6 MHz)

Frequency response • Y: ±0.1 dB to 5.5 MHz
• Pb/Pr: ±0.10 dB to 3.0 MHz

DC offset <0.0 ± 5 mV

Relative delay <±10 ns

SNR >63 dB

Table F-13. Streaming Output Specifications 

Item Specification
Video compression type MPEG4

Profile Simple Profile

Modes Fixed Bit Rate Mode, VBR (Variable Bit 
Rate) Mode

Bit rate range control User-settable 200 Kb/s - 1 Mb/s

Frame rate (VBR) 30 fps / 25 fps

Frame rate (fixed) As bit rate is lowered, frame rate is 
lowered

Audio compression type AAC (Advanced Audio Coding) format

Profile LC (Low Complexity)

Sample rate 48 K

Stereo bit rate (two channels) 64 Kbps
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Table F-14. DVI Output Specifications

Item Specification
Standard • 1080i/59.94

• 1080i/50
• 720p/59.94
• 720p/50

Connector DVI-D

Rise/fall times 75 ps to 0.4 UI (20% to 80%)

Level 1.0 V ± 0.2 V (differential, pk-to-pk)

Jitter 0.25 UI
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Audio Specifications

Input
Table F-15. AES/DARS Input Specifications

Item Specification
Balanced

Standard AES3

Type Balanced, transformer coupled

Connector 2 female DB-26/DB-44 connector with 
breakout cable

Sensitivity <200 mV

Impedance 110Ω  ± 20% (0.1 MHz to 6 MHz)

Common mode rejection 0 V to 7 V (0 kHz to 20 kHz)

Input audio rate 32 kHz to 108 kHz

Unbalanced

Standard AES3, SMPTE276M

Type Unbalanced, AC coupled

Connector BNC (IEC169-8)

Sensitivity <100 mV

Impedance 75Ω

Return loss >25 dB, 0.1MHz to 6 MHz

Input audio rate 32 kHz to 108 kHz
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Output

Table F-16. Analog Audio Input Specifications 

Item Specification
Connector Removable barrier strip

Input impedance Jumper selectable with J5~J8
• Pin 2-3: 100 kΩ

• Pin 1-2: 600 Ω

Input analog level 28 dBu to 16 dBu (adjustable by 2 dB 
increments)

CMRR >80 dB @ 60 Hz, typical

Linearity <±0.5 dB (to -100 dBFS)

Frequency response <±0.05 dB (20 Hz to 20 kHz), typical

THD >100 dB (@ -1 dBFS, 20 Hz to 20 KHz)

SNR >100 dB

Table F-17. AES Output Specifications 

Item Specification
Balanced

Standard AES3

Type Balanced, transformer coupled

Connector 2 female DB-26/DB-44 connector with 
breakout cable

Signal level 4.0 V (pk-to-pk)

Impedance 110Ω  ± 20% (0.1 MHz to 6 MHz)

Jitter <± 4 ns, peak value

DC offset 0.0 ± 50 mV

Rise/fall time 5 ns to 30 ns (10% to 90%)

Unbalanced

Standard AES3, SMPTE276M

Type Unbalanced, AC coupled
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Connector BNC (IEC169-8)

Signal level 1.0 V ± 10% (pk-to-pk)

Impedance 75Ω

Return loss >25 dB, 0.1 MHz to 6 MHz

Jitter <± 4 ns, peak value

DC offset 0.0 ± 50 mV

Rise/fall time 30 ns to 44 ns (10% to 90%)

Table F-18. Analog Audio Output Specifications

Item Specification
Connector Removable barrier strip

Output impedance Jumper selectable with J1~J4, J9~J12
• Pin 2-3: 66Ω 
• Pin 1-2: 600Ω

Output analog level 28 dBu to 16 dBu (adjustable by 2 dB 
increments)

Linearity <±0.5 dB (to -100 dBFS)

Frequency response <±0.1dB (20 Hz to 20 kHz)

THD <-87dB typical (@ -1 dBFS, 20 Hz to 20 
KHz)

SNR >100 dB

Table F-17. AES Output Specifications (Continued)

Item Specification
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I/O Specifications

Table F-19. Multi-I/O Specifications

Item Specification
Composite output • NTSC

• PAL-B
• SECAM
• Sync

Component output GBR

Quantization 8 bits all

Time code Input

GPI inputs • Number: 2
• Internally pulled HIGH
• External contact closure to ground to 

trigger

GPI outputs • Number: 2
• TTL-compatible 
• 75Ω impedance
• Sink 64 mA, source 32 mA

Connector DB-26

Table F-20. DV I/O Specifications (Future Use)

Item Specification
Standard IEEE-1394

Connector IEEE-1394, 6 pin molex connector
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Communication Specifications

Table F-21. Thumbnail Streaming Specifications

Item Specification
Connector RJ-45

Protocols • CCS
• SNMP
• HTTP

Table F-22. V2A Specifications

Item Specification
Measurement window ± 1.2 seconds between video and audio

Time to provide measurement 5 seconds

Measurement resolution ±2 video lines

Note
The measurement result has 
1.64 - 1.66ms delay for HD de- 
embedded audio and 1.28 - 
1.3ms for SD de-embedded 
audio.

Table F-23. RS-232/RS-422 Specifications

Item Specification
Standard Electrical specification EIA-232C

Connector • DB-9
• 232/422 switchable
• 422 termination can be selected from 

the menu
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Hardware Specifications
Table F-24. Weight and Dimension Measurements

Item Specification
Weight • Fully loaded unit, no power cords: 

11 lbs (4.9 kg)
• Breakout cables (each): 2.5 lbs (1.1 kg)

Height 1RU, 1.75 in. (4.5 cm)

Width 19 in. (48.3 cm)

Depth (includes extruding 
knobs and BNCs)

21.5 in. (54.6 cm)
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Power Consumption

Table F-25. Power Consumption by Individual Component

Component Description Power Consumption @ 115V AC
1 X75HD/X75SD frame with mainboard 17.19 W

2 Local control panel 6.96 W

3 Blank front panel 5.25 W

4 HDTV submodule 28.35 W

5 8- or 16-channel audio submodule 19.69 W

6 Analog video in submodule (A3D or PQM) 7.88 W

7 Streaming submodule (future use) 3.95 W

8 Second power supply Adds extra 5% to single power supply 
system configuration

Table F-26. Power Consumption of Complete Packages

Systems 
Configuration

Individual 
Components Description

Power 
Consumption
@115VAC

X75HD Models

X75HD 1+2+4 X75HD frame with mainboard, local control 
panel, and HDTV submodule

53 W

X75HD-2PS 1+2+4+8 X75HD frame with mainboard, local control 
panel, HDTV submodule, and second power 
supply

55 W

X75HD-AV 1+2+4+5 X75HD frame with mainboard, local control 
panel, HDTV submodule, and 16-channel 
audio submodule

72 W

X75HD-AV-2PS 1+2+4+5+8 X75HD frame with mainboard, local control 
panel, HDTV submodule, 16-channel audio 
submodule, and second power supply

76 W

X75HD-LC 1+3+4 X75HD frame with mainboard, blank front 
panel, and HDTV submodule

51 W



X75HD/X75SD Installation and Operation Manual 347

Appendix F: Specifications

 

X75HD-LC-2PS 1+3+4+8 X75HD frame with mainboard, blank front 
panel, HDTV submodule, and second power 
supply

53 W

X75HD-LCAV 1+3+4+5 X75HD frame with mainboard, blank front 
panel, HDTV submodule and 16-channel 
audio submodule

70 W

X75HD-LCAV-2PS 1+3+4+5+8 X75HD frame with mainboard, blank front 
panel, HDTV submodule, 16-channel audio 
submodule, and second power supply

74 W

X75SD Models

X75SD 1+2 X75SD frame with mainboard, local control 
panel

24 W

X75SD-2PS 1+2+8 X75SD frame with mainboard, local control 
panel and second power supply

25 W

X75SD-AV 1+2+5 X75SD frame with mainboard, local control 
panel and 8-channel audio submodule

44 W

X75SD-AV-2PS 1+2+5+8 X75SD frame with mainboard, local control 
panel, 8-channel audio submodule and second 
power supply

46 W

X75SD-LC 1+3 X75SD frame with mainboard, blank front 
panel

22 W

X75SD-LC-2PS 1+3+8 X75SD frame with mainboard, blank front 
panel and second power supply

24 W

X75SD-LCAV 1+3+5 X75SD frame with mainboard, blank front 
panel and 8-channel audio submodule

42 W

X75SD-LCAV-2PS 1+3+5+8 X75SD frame with mainboard, blank front 
panel, 8-channel audio submodule and second 
power supply

44 W

X75-DPS-575 Models

X75-DPS-575 1+2+6 X75SD equivalent frame to DPS-575 with 
mainboard, local control panel and PQM 
analog video in submodule.

32 W

Table F-26. Power Consumption of Complete Packages

Systems 
Configuration

Individual 
Components Description

Power 
Consumption
@115VAC



348 X75HD/X75SD Installation and Operation Manual

 
Appendix F: Specifications

X75-DPS-575AV 1+2+5+6 X75SD equivalent frame to DPS-575AV with 
mainboard, local control panel, PQM analog 
video in and 8-channel audio submodule.

52 W

X75-DPS-575LC 1+3+6 X75SD equivalent frame to DPS-575LC with 
mainboard, blank front panel, and PQM analog 
video in submodule.

30 W

X75-DPS-575LCAV 1+3+5+6 X75SD equivalent frame to DPS-575LCAV 
with mainboard, blank front panel, PQM 
analog video in and 8-channel audio 
submodule.

50 W

Table F-26. Power Consumption of Complete Packages

Systems 
Configuration

Individual 
Components Description

Power 
Consumption
@115VAC
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HD Conversion Capabilities
The X75HD model can convert any of the input signals and formats 
listed in Table F-27 to any of the specified output signals and formats.

Video Propagation Delay
Table F-28 on page 350 shows the video propagation delays 
encountered in the X75HD/X75SD when processing CVBS, S-Video/
CAV; SD1/SD2/DV, 1080i/59.94, and 720p/59.94 signals.
Table F-29 on page 352 shows the video propagation delays 
encountered in the X75HD/X75SD when processing 1080i/50, 1080p/
25, and 720p/50 signals.
See “Video Path” on page 352 for important information about the 
propagation delays.

Note
“Y” indicates that this format 
conversion is supported.

Table F-27. X75HD Supported Conversion Formats

Outputs
486i/ 
59.94

720p/ 
59.94

1080i/ 
59.94

1080p/ 
23.98* 576i/ 50 720p/ 50 1080i/ 

50
1080p/ 
25

In
pu

t

486i/59.94 Y Y Y Y2

720p/59.94 Y Y Y Y2

1080i/59.94 Y Y Y Y2

1080p/23.98 Y1 Y1 Y1 Y

1080psf/23.98 Y1 Y1 Y1 Y

576i/50 Y Y Y Y

720p/50 Y Y Y Y

1080i/50 Y Y Y Y

1080p/25 Y Y Y Y

Y1 indicates that 2:3 cadence is used; Y2 indicates material with 3:2 cadence converted with no motion artifacts
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Table F-28. Propagation Delay For CVBS, S-Video/CAV;SD1/SD2/DV, 1080i/59.94, and 720p/59.94

Input

Decoding FrameSync HD User 
Video Delay Up/Dn/Cross SD NR SD User Video 

Delay

CVBS 1 line 0~1 I-frame N/A N/A 1 line ~ 1 I-field 0 ~ 4 I-frames

CVBS 1 line 0~1 I-frame N/A N/A 1 line ~ 1 I-field 0 ~ 4 I-frames

CVBS 1 line 0~1 I-frame N/A Up: 1 I-field to 3 
I-fields. By default 1 
I-frame

1 line ~ 1 I-field 0 ~ 4 I-frames

S-Video/CAV;SD1/
SD2/DV

N/A 0~1 I-frame N/A N/A 1 line ~ 1 I-field 0 ~ 4 I-frames

S-Video/CAV;SD1/
SD2/DV

N/A 0~1 I-frame N/A N/A 1 line ~ 1 I-field 0 ~ 4 I-frames

S-Video/CAV;SD1/
SD2/DV

N/A 0~1 I-frame N/A Up: 1 I-field to 3 
I-fields. By default 1 
I-frame

1 line ~ 1 I-field 0 ~ 4 I-frames

1080i/59.94 N/A 0~1 I-frame 0~7 I-frames Dn: 1 I-field to 3 
I-fields. By default 1 
I-frame

1 line ~ 1 I-field 0 ~ 4 I-frames

1080i/59.94 N/A 0~1 I-frame 0~7 I-frames Dn: 1 I-field to 3 
I-fields. By default 1 
I-frame

1 line ~ 1 I-field 0 ~ 4 I-frames

1080i/59.94 N/A 0~1 I-frame 0~7 I-frames 1 I-field to 3 
I-fields. By default 1 
I-frame

N/A N/A

1080i/59.94 N/A 0~1 I-frame 0~7 I-frames Cross: 1 I-field to 3 
I-fields. By default 1 
I-frame

N/A N/A

720p/59.94 N/A 0~1 P-frame 0~15 P-frames Dn: several lines to 
2 P-frames. By 
default 1 P-frame

1 line ~ 1 I-field 0 ~ 4 I-frames

720p/59.94 N/A 0~1 P-frame 0~15 P-frames Dn: several lines to 
2 P-frames. By 
default 1 P-frame

1 line ~ 1 I-field 0 ~ 4 I-frames

720p/59.94 N/A 0~1 P-frame 0~15 P-frames Cross: several lines 
to 2 P-frames. By 
default 1 P-frame

N/A N/A

720p/59.94 N/A 0~1 P-frame 0~15 P-frames several lines to 1 
P-frame. By default 
1 P-frame

N/A N/A
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Output Minimum/Maximum Delays

SD ARC Encoding Min. Total 
Delay

Min. Total 
Delay (ms)

Max. Total 
Delay Max. Total Delay (ms)

1 ~ 3 I-field 6.28uS CVBS, CAV, 
S-Vid

< 3 lines <0.192 (PAL), 
<0.191(NTSC)

Up to: 7 I-frames <280 (PAL), <234(NTSC)

1 ~ 3 I-field N/A SD-SDI < 3 lines <0.192 (PAL), 
<0.191(NTSC)

Up to: 7 I-frames <280 (PAL), <234(NTSC)

N/A N/A HD-SDI 1 I-field <20(PAL), 
<16.7(NTSC)

Up to: 6 I-frames <240 (PAL), <200(NTSC)

1 ~ 3 I-field 6.28uS CVBS, CAV, 
S-Vid

< 2 lines <0.128 (PAL), 
<0.127(NTSC)

Up to: 7 I-frames <280 (PAL), <234(NTSC)

1 ~ 3 I-field N/A SD-SDI < 2 lines <0.128 (PAL), 
<0.127(NTSC)

Up to: 7 I-frames <280 (PAL), <234(NTSC)

N/A N/A HD-SDI 1 I-field <20(PAL), 
<16.7(NTSC)

Up to: 6 I-frames <240 (PAL), <200(NTSC)

N/A 6.28uS CVBS, CAV, 
S-Vid

1 I-field <16.7 Up to: 14 I-frames <467

N/A N/A SD-SDI 1 I-field <16.7 Up to: 14 I-frames <467

N/A N/A 1080i/59.94 1 I-field <16.7 Up to: 9.5 I-frames <317

N/A N/A 720p/59.94 1 I-field <16.7 Up to: 9.5 I-frames <317

N/A 6.28uS CVBS, CAV, 
S-Vid

< 50 lines <1.11 Up to: 18 P-frames 
+ 4.5 I-frames

<450

N/A N/A SD-SDI < 50 lines <1.11 Up to: 18 P-frames 
+ 4.5 I-frames

<450

N/A N/A 1080i/59.94 < 50 lines <1.11 Up to: 18 P-frames <300

N/A N/A 720p/59.94 < 50 lines <1.11 Up to: 17 P-frames <284
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Video Path
When a block is inserted, the FS phase or SD-ARC will be compensated to 
maintain output, and the H/V phases won't change. If the SDNR is inserted, 
the propagation delay may not change or may add one extra I-frame, 
depending upon the FS phasing. The total FS+SDNR delay will be less than 
1.5 I-frames.
If the SD-ARC is inserted, the propagation delay will add an extra 0.5 to 1.5 
I-frames, depending upon FS phases and SD-ARC/HD-Dn phase settings.
If the strobe is inserted, the propagation delay most likely will not change; if a 
delay-line is inserted, the propagation delay will add an extra 0 to 4 I-frames, 
depending upon the delay line settings.
If a keyer is inserted, the propagation delay most likely will not change.

Table F-29. Propagation Delay For 1080i/50, 1080p/25, and 720p/50

Input

Decod-
ing

Frame 
Sync

HD User 
Video 
Delay

Up/Dn/Cross SD NR
SD User 
Video 
Delay

1080i/50 N/A 0~1 I-frame 0~7 I-frames Dn: 1 I-field to 3 I-fields. By default 1 I-frame 1 line ~ 1 I-field 0 ~ 4 I-frames

1080i/50 N/A 0~1 I-frame 0~7 I-frames Dn: 1 I-field to 3 I-fields. By default 1 I-frame 1 line ~ 1 I-field 0 ~ 4 I-frames

1080i/50 N/A 0~1 I-frame 0~7 I-frames 1 I-field to 3 I-fields. By default 1 I-frame N/A N/A

1080i/50 N/A 0~1 I-frame 0~7 I-frames Cross: 1 I-field to 3 I-fields. By default 1 I-frame N/A N/A

1080i/50 N/A 0~1 I-frame 0~7 I-frames Cross: 1 I-field to 3 I-fields. By default 1 I-frame N/A N/A

1080p/25 N/A 0~1 P-frame 0~7 P-frames Dn: 0.5 P-frame to 1 P-frame. By default 1 P-frame 1 line ~ 1 I-field 0 ~ 4 I-frames

1080p/25 N/A 0~1 P-frame 0~7 P-frames Dn: 0.5 P-frame to 1 P-frame. By default 1 P-frame 1 line ~ 1 I-field 0 ~ 4 I-frames

1080p/25 N/A 0~1 P-frame 0~7 P-frames Cross: 0.5 P-frame to 1 P-frame. By default 1 P-frame N/A N/A

1080p/25 N/A 0~1 P-frame 0~7 P-frames 0.8 P-frame to 1.8 P-frame. By default 1 P-frame N/A N/A

1080p/25 N/A 0~1 P-frame 0~7 P-frames Cross: 0.5 1080P-frame to 1 1080P-frame. By default: 
1 P-frame

N/A N/A

720p/50 N/A 0~1 P-frame 0~15 P-frames Dn: several lines to 2 P-frames. By default 1 P-frame 1 line ~ 1 I-field 0 ~ 4 I-frames

720p/50 N/A 0~1 P-frame 0~15 P-frames Dn: several lines to 2 P-frames. By default 1 P-frame 1 line ~ 1 I-field 0 ~ 4 I-frames

720p/50 N/A 0~1 P-frame 0~15 P-frames Cross: several lines to 2 P-frames. By default 1 
P-frame

N/A N/A

720p/50 N/A 0~1 P-frame 0~15 P-frames Cross: several lines to 3 720P-frames. By default 2 
720P-frame

N/A N/A

720p/50 N/A 0~1 P-frame 0~15 P-frames several lines to 1 P-frame. By default 1 P-frame N/A N/A
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Based on the current software (version 1.5), the SD video path could be as 
shown in Figure F-1. 

Figure F-1. SD Video Path

Output Minimum/Maximum Delays

SD ARC Encoding
Min. 
Total 
Delay

Min. Total 
Delay (ms) Max. Total Delay Max. Total 

Delay (ms)

N/A 6.28uS CVBS, CAV, S-Vid 1 I-field <20 Up to: 14 I-frames <560

N/A N/A SD-SDI 1 I-field <20 Up to: 14 I-frames <560

N/A N/A 1080i/50 1 I-field <20 Up to: 9.5 I-frames <380

N/A N/A 1080p/25 1 I-field <20 Up to: 9.5 I-frames <380

N/A N/A 720p/50 1 I-field <20 Up to: 9.5 I-frames <380

N/A 6.28uS CVBS, CAV, S-Vid 0.5 P-frame <20 Up to: 9 P-frames + 4.5 I-frames <540

N/A N/A SD-SDI 0.5 P-frame <20 Up to: 9 P-frames + 4.5 I-frames <540

N/A N/A 1080i/50 0.5 P-frame <20 Up to: 9 P-frames <360

N/A N/A 1080p/25 0.8 P-frame <32 Up to: 10 P-frames <400

N/A N/A 720p/50 0.5 P-frame <20 Up to: 9 P-frames <360

N/A 6.28uS CVBS, CAV, S-Vid < 50 lines <1.33 Up to: 18 P-frames + 4.5 I-frames <540

N/A N/A SD-SDI < 50 lines <1.33 Up to: 18 P-frames + 4.5 I-frames <540

N/A N/A 1080i/50 < 50 lines <1.33 Up to: 18 P-frames <360

N/A N/A 1080p/25 < 50 lines <1.33 Up to: 19 P-frames <380

N/A N/A 720p/50 < 50 lines <1.33 Up to: 17 P-frames <340

A3D (PQM) FS

SD1 FS

SD2 FS

SDNR SD
keyerSD-ARC Strobe/

delay
Output
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Symbols
1 Click Fav parameter 176–177, 192
10/100Base-T cable length 23

A
A. Proc button 107, 156–157
Acknowledgement of alarms 322
Active Alarms parameter 188
Adjusting

audio levels 107, 155
video levels 106, 146

Advanced audio inputs and outputs 160–161
AES

DARS input specifications 340
inputs 168
output specifications 341

AFV (Audio Follows Video) mode 158–159
Alarm

LEDs 125
list 323–329
monitoring via software 138–140
options 322

Alarms Log parameter 189
AllOutSelect parameter 101–103, 145
Alternate color decoder algorithms 61–62, 109
Analog audio

connections 202
input 167, 341
LED 171

output specifications 342
terminal blocks 202

Analog Video LED 166
ARC

button 184
function 184–187

Attack Time parameter 286
Audio

(AES) inputs 168
(SD-SDI) demuxed 168
and video conversion 47–48
Channel LEDs 156
compression and processing 43
configuration 107, 151–161
connections 55, 81–82, 202
delaying 157
embedded 160–161
HD demuxed 169
input 156–160
LEDs 155
level controls 107, 155, 157
limiter 56–57
limiter installation and operation 285
limiter transfer function 287
multiple input source configurations 169–170
proc amp status LEDs and controls 167–171
processing 5
receptacles (X75OPT-AS-16) 55
Setup submenu 52, 56, 118
source groupings 153–154
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specifications 340–342
synchronizer module 264–268
tracking 157

Audio Channel LEDs 170
Audio Delay parameter 124
Audio Follows Video mode 158–159
Audio In button 107, 126, 152–157
Audio In Src Select parameter 152
Audio Input LEDs 126, 156, 171
Audio Mode LED 156
Audio proc amp 167–171
Audio Proc LEDs 156–169, 171
Audio Setup menu 156
Auto Detect video mode 26, 102, 105, 145
Autotrack status LED 124
AVFS & Timing submenu 188

B
Backlight parameter 192
Black button 166
Bracket and relief bar installation 72–74
Breakout cable connections 76–77
Bridging router switchers 49
Buttons

A. Proc 107, 156–157
ARC 184
Audio In 107, 126, 152–157
Black 166
Bypass 178
Chroma 166
Ctrl 107
Default 121
FAV1 and FAV2 176–177, 192
Frz Mode 165
Hue 166
Luma 166
mapped audio 167–169, 171
Memory 172–175
Mo/St (Mono/Stereo) 152, 178
multi-function 118
NR 178

Option 116, 117, 188–191
Remote 91, 96–97
Take 165
Timing 188
TSG 180
V Proc 166
Video In 27, 105, 126, 144–146

C
Cable options 19, 195–220
Cables

CAB-X75HD-COAX 208–209
X75OPTCAB-16-C (set) 208–209
X75OPTCAB-16-X 218–220
X75OPTCAB-16-XC 213–215
X75OPTCAB-8-C 206–207
X75OPTCAB-8-X 216–217
X75OPTCAB-8-XC 210–212
X75OPTCAB-DVI 205
X75OPTCAB-MULTI 203–204

CAB-X75HD-COAX cable 208–209
Caution notes 256
CCS Navigator 282–284
Ch1-AFV-SD1 parameter 158
Changing parameters 120–121
Chassis cover 261
Chroma button 166
Cleaning optical fibers 259
Closed captioning 104
Common replacement part numbers 262
Communication specifications 344
Component

input specifications 334
output specifications 338

Composite video output specifications 337
Configure Alarms parameter 189, 322
Configuring

audio 107
exceptions 103
for HTTP (web browser) 98
for SNMP and third-party software 100
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GPI inputs 108
multiple source audio 169–170
network settings 88–91
single source audio 167–169
video 105–106
X75OPT-A3D-1 module 109
X75OPT-AS-16 module 53

Connections
audio 55, 81–82, 202
cable and system 75–83
control and streaming video 65
video 78–80

Control
considerations

X75-HD 64
X75OPT-A3D 59
X75OPT-AS-16 56
X75OPTPQM 61

knob operation 117–121
mode status LED 127
of audio proc amp 167–171
of video proc amp 166
panel, installing 263
streaming I/O specifications 344

Control software, third-party 315
Conversion capability specifications 349
Ctrl button 107
Ctrl/Strm connector 65
Ctrl/Strm Ethernet port 138

D
Decay Time parameter 286
Def IP DIP switch 222
Default

button 121
mode 26
parameter 134

Default Gateway 305–306
Delaying audio 157
Description of front panel 116
Device IP parameter 89

Digital audio LEDs 171
DIP switch 222
Discrete options 120
Display Intensity parameter 191
Display screen Setup parameters 191–192
Distribution amplifier 37
Documentation 22
Dolby

audio decompression 41–45
decoder module installation 288

Don’t Wrap parameter 191
Downloadable MIB files 315
DPS Equivalents 15–16
DPS-575 9
DUOCON software key 12
DV I/O specifications 343
DVI output specifications 339

E
EDH status LED 123
Electrical requirements 70
Embedded audio 160–161
Enable Streaming parameter 138
Environmental requirements 70–71
ESD caution 256
Ethernet ports 65, 82, 138
Exceptions to configurations 103

F
Failed upgrade procedure 310
Failure of X75OPT-PS power supply 290
Fans, removing and replacing 72, 299–301
FAV1 and FAV2 buttons 176–177, 192
Favorite 1 and Favorite 2 parameters 189
Fiber optics

basic principles 257
cleaning 259, 260
handling and connecting 258
HD module 63–64
specifications 332, 336
transmitting and receiving 257
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Firmware upgrading 304–310
Frame-mounted local control panel, installing 263
Freeze control 165
Front panels 9, 116
Frz Mode button 165
Functional block diagram, video 25

G
Gateway parameter 86, 90
Generator, test signal 180–183
Genlock input specifications 335
Genlock status LED 122
Global Audio Config parameter 178
Global Frame Rate parameter 118
GPI parameter 108
Groupings of audio sources 153–154

H
Handling and connecting fibers 258
Hardware specifications 345
HD

conversion capabilities specifications 349
demuxed audio selections 169
fiber

input specifications 332
output specifications 336

module installation and removal 269–273
Operating Standard parameter 118
Out V-Phase parameter 188
SDI audio LEDs 171
SDI video input specifications 332
SDI video output specifications 336
Video LEDs 166

HDDUOCON software key 12, 262
Help page 141
History parameter 188
Home page of Web server software 130
HTTP control 98
Hue button 166

I
Impulse Noise Level control 179
Ingest video processing 42
Initial power-up and control 86–87
Input

video and audio processing 44–46
video modes 102–104
video processing 36–42

Inputs
analog audio 167
selected audio 170
video and audio 4

Installing
audio limiter and noise reducer 285–287
audio receptacles (X75OPT-AS-16) 55
audio synchronizer module 264–268
brackets and relief bar 72–74
Dolby decoder (X75OPT-DOLBY-1) 288
fans 299–301
frame-mounted local control panel 263
hardware and software options 72
noise reducer and audio limiter 285
preparation for 70–71
redundant power supply 293–298
software options 285–287
X75OPT-A3D or X75OPT-PQM 274–278

Integrator router 49
INT-EX6X1 video distribution amplifier 37
IP Address 86, 89–91, 92, 130, 222, 305–306
Ipconfig command 93

J
Jumper settings, X75OPT-AS-16/8 53

K
Keycode 12, 242, 262
Keyer/TSG Insert parameter 180
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L
Laser caution 256
Launching Web server software 130
LEDs 122–127

Alarm 125
Analog Audio 171
Analog Video 166
Audio 155
Audio Channel 156, 170
Audio Input 126, 156, 171
Audio Mode 156
Audio Proc 156–169, 171
Autotrack status 124
control mode 127
digital audio 171
EDH status 123
Genlock status 122
HD Video 166
HD-SDI audio 171
Major and Minor Alarm 125
Memory Active 125
M-Path status 124
SD Video 166
SD-SDI audio 171
Simulcast Status 124
TBC status 123
video input 126
Video Proc Amp 166

Leitch Web site xiv
License key 12, 242, 262
Limitations

of AllOutSelect 103
of SD-ARC 104

List Favorites parameter 176–177
Local control panel, installing 263
Lock Panel parameter 190
Luma button 166

M
Machine name 86
Main Menu 118, 131–133
Major and Minor Alarm status LED 125
Manual information xiii
Manuals, X75 22
Mapped

audio buttons 167–169
buttons 171
parameters 169, 171

Memory Active status LED 125
Memory button 172–175
Menu Navigation Tree 137
Menus

Audio Setup 156
AVFS & Timing 188
Processing 188
Routing Setup 133
Video In Precedence 133

MIB file 315
Minimum Delay parameter 179
Mo/St (Mono/Stereo) button 152, 178
Modes, Default, M-Path, and Simulcast 26
Modules

Dolby Digital 41–45
X75HD 63–64
X75HD-AV 38, 40, 43, 44, 47, 50
X75OPT-A3 37
X75OPT-A3D 38, 40, 58–59
X75OPT-A3D-1 109
X75OPT-AS-16/8 52–56
X75OPT-HDUPG 63–64, 258
X75OPT-PQM 60–61
X75OPT-STR 65–66

Monitoring alarms 138–140
M-Path

(User) mode 102, 145
audio processing 29–30
configuration 101
input video mode 102, 145
processing of all inputs 5
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status LED 124
video processing 25–29

MS-DOS command prompt 93
Multi-

function buttons 118
I/O cable 203–204
I/O specifications 343
purpose breakout cable connections 76–77

Multiple audio input source configurations 169–170
Mute In Freeze parameter 165
MuteKeepAlive parameter 189
Mutually exclusive inputs 103

N
Navigating through menus 118–119
Network settings 88–91, 305–306
News production 40
Noise Gate Level and Time parameters 286
Noise reducer and audio limiter installation 285–287
Noise reduction/enhancement 178–179
Noise/Artifact Level control 179
Non-Leitch control software 315
Notch filter, A3D module 109
NR button 178
Numeric values 121

O
One Click Fav parameter 176–177, 192
Online help 141
Operating modes 5, 25–33
Optical fiber

cleaning 259
transmitter and receiver 258

Option button 116, 117, 188–191
Options

and upgrades 68
as systems 17–19
cable 19, 195–220
installing 72
processing modules 17

software 21
X75OPT-V2A 21, 147–150

Output
groups, video 101
video processing 42–43

P
Packing

information xv
list 68–69

Panacea router 49
Panel IP address 191
Parameters

1 Click Fav 176–177, 192
Active Alarms 188
Alarms Log 189
AllOutSelect 101–103, 145
Attack Time 286
Audio Delay 124
Audio In Src Select 152
Backlight 192
Ch1-AFV-SD 158
Configure Alarms 189, 322
Decay Time 286
Default 134
Device IP 89
Display Intensity 191
display screen Setup 191–192
Enable Streaming 138
Favorite 1 and Favorite 2 189
Gateway 86, 90
Global Audio Config 178
Global Frame Rate 118
GPI Function 108
HD Out V-Phase 188
History 188
Keyer/TSG Insert 180
List Favorites 176–177
Lock Panel 190
mapped 169, 171
Minimum Delay 179
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Mute In Freeze 165
MuteKeepAlive 189
Noise Gate Level and Noise Gate Time 286
One Click Fav 176–177, 192
Option 188–191
Path 190
Preset 172–175, 189
Reference Setup 118
Rename Preset 175
Screen Saver Select 192
Screen Saver Timeout 191
Scroll Mode 191
SD Operating Standard 118
SD Out Sel 158
SD-ARC Insert 184
SDNR Insert 178, 179
SelPar Adjust Mode 191
Setup 116, 117, 190–192
Shaft Direction 117, 192
Simulcast Enable 102
Slope 286
Soft Limit Level 286
Subnet Mask 86, 90
System Config 118
Video Setup 118
Wrap 191

Part numbers 262
Path parameter 190
Pinouts 203–220
Ports, remote control 82
Power consumption specifications 346–348
Power supply

redundancy 293–298
replacement 290–292
requirements 70–71

PQM, alternate algorithm 61–62
Precautions, fiber optic 64
Precedence levels 102, 145
Preparing

for installation 70–71
for servicing 261

Preset parameters 172–175, 189

Proc Amp controls 166–171
Processing menu 188
Processing modes 101–104
Product packages 12

Q
QuickTime Player 282–284

R
Rear panel description 12
Rear view of frame 11
Rebooting shortcut 190
Receptacles, audio 55
Redundant power supplies 70, 293–298
Reference Setup parameter 118
Relief bar and support bracket installation 72–74
Remote

button 91, 96–97
monitoring 315

Remote control
ports 82
software 315
via control panel 95–97
via HTTP (web browser) 98
via SNMP and third-party software 100

Removing and replacing fans 72
Rename Preset parameter 175
Replaceable parts kit 21, 69
Replacement

of fans 299–301
of power supply 290–292
part numbers 262
parts kit 262

Revision history xiii
Routing Setup menu 133
Routing switchers 49
RS-232/RS-422 specifications 344
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S
Safety

precautions 256
terms and symbols xvi

Sample rate converter 157
Satellite and microwave reception 38
Screen Saver Select parameter 192
Screen Saver Timeout parameter 191
Scroll knob operation 117–121
Scroll Mode parameter 191
SD card 172–175
SD NR/Enhancement feature 179
SD Operating Standard parameter 118
SD Out Sel parameter 158
SD Video LED 166
SD-ARC Insert parameter 184
SD-ARC limitation 104
SDNR Insert parameter 178, 179
SD-SDI

audio LEDs 171
demuxed audio 168
video input specifications 333
video output specifications 337

Selecting
a video source 105–106, 144–146
an audio input 156–160, 170
an audio source 107, 153–154

SelPar Adjust Mode parameter 191
Servicing information 255–301
Setting

a selected value in Web server software 134
a single unit IP address 89–90
discrete options 120
multiple unit IP addresses 90–91
numeric values, setting 121

Setup parameter 116, 117, 190–192
Shaft Direction parameter 117, 192
Shipping information xv
Shortcut for rebooting 190
Signal control and monitoring 5

Simulcast
operation 5, 32–33
status LED 124
switching 50

Simulcast Enable parameter 102
Single source

audio configuration 167–169
video processing 106

Siting requirements 70
Slope parameter 286
SMART alarms 4
SNMP 100, 315
Soft Limit Level parameter 286
Soften/Sharpen control 179
Softkey options 12, 242, 262
Software

key 12, 242, 262
module upgrading 304–310
options 21, 285–287
third party 315
upgrades 21

Spare parts 21, 262
Special control considerations

X75-HD 64
X75OPT-A3D 59
X75OPT-AS-16 56
X75OPT-PQM 61

Specifications
AES output 341
AES/DARS input 340
analog audio input 341
analog audio output 342
audio 340–342
communication 344
component input 334
component output 338
composite video output 337
control/streaming I/O 344
conversion capability 349
DV I/O 343
DVI output 339
genlock input 335



X75HD/X75SD Installation and Operation Manual 363

Index

 

hardware 345
HD conversion capabilities 349
HD-SDI video input 332
HD-SDI video output 336
HDTV fiber video input 332
HDTV fiber video output 336
multi-I/O 343
power consumption 346–348
RS-232/RS-422 344
SD-SDI video input 333
SD-SDI video output 337
S-Video input 333
V2A timing tool 344
video input 332–335
weight and dimension 345

Split Screen feature 179
Status LEDs

Autotrack 124
control mode 127
EDH 123
front panel 122–127
Genlock 122
Major and Minor Alarm 125
Memory Active 125
M-Path 124
Simulcast 124
TBC 123

Streaming video 65–66, 138, 279–284
Strobe or film mode 104
Style Issues 304
Submenu, Audio Setup 52, 56
Subnet Mask 86, 90, 305–306
Support bracket and relief bar installation 72–74
S-Video input specifications 333
Switching, simulcast 50
System

options 17–19
packages 12

System Config parameter 118

T
Take button 165
Tape transport wrap-around 47
TBC status LED 123
Temperature range 70
Test signal generator 180–183
Third-party software control 100, 315
Thumbnail streaming 138
Timing button 188
Tracking audio 157
Trigger time, clear time, priority, of alarms 322
Troubleshooting 221–253
TSG button 180
Typical control configurations 23–24

U
Unique IP address recall 222
Unpacking information xv
Upgrading software 21, 304–310
User Select mode 102, 145

V
V Proc button 166
V2A timing tool 147–150
V2A video/audio timing tool 344
Version history xiii
Video

and audio conversion 47–48
and audio processing, input 44
configuration 143–146
connections 78–80
functional block diagram 25
input LED 126
input specifications 332–335
level adjusting 106, 146
proc amp controls 166
processing 4
processing, input 36–41
processing, output 43
source selection 144–146
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Video In button 27, 105, 126, 144–146
Video In Precedence menu page 133
Video M-Path 101
Video output groups 101
Video Proc Amp status LEDs 166
Video Setup parameter 118
video/audio timing tool 147–150
Visual feedback 122–127

W
Warranty information ii
Web

browser control 98
server software control 129–141
server software launch 130

Weight and dimension specifications 345
Working with fiber optics 257–260
Wrap parameter 191
Writing conventions xiv
www.leitch.com xiv

X
X75HD

modules and systems 12–14, 63–64
X75HD-AV module 38, 40, 43, 44, 47, 50
X75OPT-A3D module 37, 38, 40, 58–59

installation and removal 274–278
X75OPT-A3D-1 module 109
X75OPT-AS-16/8 module 52–56

installation and removal 264–268
X75OPT-AS-16/8-L audio limiters 56–57
X75OPT-ASL 285–287
X75OPTCAB-16-C cable set 208–209
X75OPTCAB-16-X cable 218–220
X75OPTCAB-16-XC cable 213–215
X75OPTCAB-8-C cable 206–207
X75OPTCAB-8-X cable 216–217
X75OPTCAB-8-XC cable 210–212
X75OPTCAB-DVI cable 205
X75OPTCAB-MULTI cable 203–204

X75OPT-DOLBY-1 software option 285–287, 288
X75OPT-HDDUOCON software key 12
X75OPT-HDUPG module 63–64, 258
X75OPT-NR software option 285–287
X75OPT-PQM module 60–61

installation and removal 274–278
X75OPT-PS replacement 290–292
X75OPT-SNMP software option 285–287
X75OPT-STR module 65–66
X75OPT-V2A video/audio timing software 
option 21, 147–150

X75SD available modules and systems 14–15
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